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HOPEX REPORT STUDIO INTRODUCTION

HOPEX Report Studio desktop is available with HOPEX Power Studio technical module.

HOPEX Report Studio is part of HOPEX Studio. 

Creation of definitions (Report DataSet Definition, GraphSet Definition, TreeSet Definition,
and Report Template) is available to users with HOPEX Customizer or HOPEX Customizer
Publisher profile.

Creation and use of Report DataSets, GraphSets, TreeSets, and reports are available to all users in
HOPEX Solutions.

 HOPEX Report Studio Desktop
 Report DataSet Definition
 GraphSet Definition
 TreeSet Definition
 Report Template Definition
 Report Template: How To
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INTRODUCTION

Prerequisite for any Customization 
Customizations must be performed in a development environment.

Before starting any customization, you must first install the HOPEX Application
Server customization module.

 For detailed information, see MODULES > Managing the 
Customization Lifecycle documentation.

HOPEX Studio vs Java report
HOPEX Studio enables to quickly generate simple reports but does not provide as
many possibilities as the reports written in Java do. You first need to identify which
of the two techniques best suits your needs.

Java Reports provide more extensive possibilities but require development skills, as
it is required to implement a macro in Java.

 See Writing Java Report Chapters Technical Article.
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HOPEX Report Studio Introduction
Accessing HOPEX Report Studio Desktop

ACCESSING HOPEX REPORT STUDIO DESKTOP

Customization Dedicated Profiles
You can access HOPEX Report Studio desktop with the following profiles:

• HOPEX Customizer Publisher
The HOPEX Customizer Publisher profile is dedicated to document
customization. 
It enables to create Report Templates without any coding.

 Should you need to modify or create macros (e.g.: to create a 
MetaTest), you need to use HOPEX Customizer profile.

• HOPEX Customizer
HOPEX Customizer profile gives access to all customization features.
It enables to customize:
• Metamodel
• User Interfaces
• Documents: you should use HOPEX Customizer Publisher profile 

when working on Report Studio features only

For example, when creating Definitions (Report DataSet Definitions, TreeSet
Definitions, GraphSet Definitions) you might need to create your own queries:

• HOPEX Customizer Publisher profile prevents you from getting, in the 
IntelliSense feature, all administration attributes and links, which are not 
of interest in that case. Only business related attributes are proposed 
and thus you do not get a crowded list.

• with HOPEX Customizer profile, you can still hide administration 
attributes and links: in Options > Repository > Metamodel, clear 
Display repository administration properties and links option.

 See Advanced Search Options.
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Logging in to HOPEX Report Studio Desktop
To log in to HOPEX Report Studio desktop:

 See Accessing HOPEX and select HOPEX Customizer Publisher profile.
Once connected the HOPEX Report Studio desktop appears and a
session is opened.
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HOPEX REPORT STUDIO DESKTOP

The HOPEX Report Studio desktop includes the standard menus and tools of
HOPEX desktops.

 For information regarding HOPEX desktops, see HOPEX Desktop.

HOPEX Report Studio Navigation Menus
The HOPEX Report Studio desktop includes the following navigation menus:

• Reports: to access and create reports from Report Templates
 For information regarding report creation, management and 
customization, see Generating Documentation.

• Report Definitions: includes all you need to create and customize 
Report Templates.

• Favorites: for a quick access to your favorites and shared favorites
• History: for a quick access to all of the objects you have accessed (e.g.: 

display of their property pages) or modified
 For information regarding use of standard navigation menus, see 
Common features > The HOPEX Web Front-End desktop.
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Report Definitions Menus
From the Report Definitions navigation menu you can especially access, create
and customize the Report Studio related definitions:

• Report Templates
• Report templates
• Report Data Views
• Report Display Contexts
• Report Styles

 See Report Template Definition.

• Data Source Definitions including:
• Report DataSet Definitions 

 See Report DataSet Definition.

• TreeSet Definitions
 See TreeSet Definition.

• GraphSet Definitions 
 See GraphSet Definition.

• Data Sources
• Report DataSets: to access and create Report DataSets from Report 

DataSet Definitions
 See Report DataSet Creation.

• Queries: to generate gauge reports and create gauge Report 
templates

 See Creating a gauge-type Report Template from a query.
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From these definitions you and other users can create and customize:
• Reports
• Report DataSets
• GraphSets
• TreeSets

 For information regarding report, Report DataSet, GraphSet, and 
TreeSet creation, management and customization, see Common 
features > Generating Documentation.
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HOPEX Report Studio Homepage
In the HOPEX Report Studio desktop homepage My Scope part displays
indicators useful for direct access to:

• your work
My Work indicators give direct access to your work:
• My Report Templates
• My Report DataSet Definitions
• My TreeSet Definitions
• My GraphSet Definition

• customizations
Customizations indicators give direct access to custom work:
• Custom Report Templates
• Custom Report DataSet Definitions
• Custom TreeSet Definitions
• Custom GraphSet Definition
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The Quick Access part also gives quick access to:
• recently viewed objects
• favorites
• actions: create a report
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REPORT DATASET DEFINITION

The following points are covered here:

 Introduction to Report DataSet Definition
 Report DataSet Definition Creation
 Customizing the Report DataSet
 How To
 Use Cases
 Report DataSet Creation
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INTRODUCTION TO REPORT DATASET DEFINITION

Report DataSet Definition and Report DataSet Principles
 Report DataSet Definition is only available with HOPEX Power 
Studio technical module.

A Report DataSet enables to extract HOPEX raw data and show it in tabular form.
With this data the end-user can create reports that use tabular data (e.g.: pie-chart,
set of gauges, table, bar-chart, matrix) without needed to enter any code.

Report DataSet Definition creation is performed in both HOPEX Windows Front-
End and Web Front-End for users with HOPEX Customizer or HOPEX Customizer
Publisher profile.

Once a Report DataSet Definition is created, any user of a Solution can use it to
query HOPEX repository and create a Report DataSet. Data first shown in tabular
form can then be handled and shown in graphical format using Instant Report
feature.
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Report DataSet Definition
The Report DataSet Definition defines how to build a tabular set of data (Report
DataSet). The Report DataSet Definition can be used as a Report DataSource
in a Report Template.

A Report DataSet Definition is MetaClass-specific. 

The Report DataSet Definition is based either on:
• a collection parameter (an occurrence or a set of occurrences of the 

root MetaClass) 
At creation you need to define the root MetaClass (concrete or abstract) 

• a query (a set of occurrences)
At creation you need to define the root MetaClass (concrete or abstract)
and the query that collects the entry points.
If the query includes parameters, these parameters will result in Property
Parameters in the definition.
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Once this root Report DataSet Collection  is defined, you can add it as many
items as needed:

• Report DataSet Properties 
• Report DataSet Collections  

Example: 
The "Application Technologies" Report DataSet Definition is 
based on the "Application" root Report DataSet Collection 

 to which the following items are added:
- Report DataSet Properties : 
"Rating", "Number of users", and "Cost" MetaAttributes 
belonging to the Application MetaClass.
- Report DataSet Collections :
"Technologies", which is a MetaAssociationEnd of the 
Application MetaClass
"Vendor", which is a MetaAssociationEnd of the "Technology 
used" MetaClass.

 See Defining the Data that Feeds the Report DataSet.

Report DataSet
The Report DataSet is a set of data defined by a Report DataSet Definition. The
Report DataSet is used as a tabular source of data in a report.
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Creating and Defining a Report DataSet Definition: the Big Picture

To create and define a Report DataSet Definition:
1. Define the Report DataSet source data: a MetaClass.

This MetaClass is the root of the tree that represents the set of data
collected from the repository.

 See Creating a Report DataSet Definition.
2. Define which data type feeds the data collection:

Define the data you want to be displayed in the Report DataSet.
 See Defining the Data that Feeds the Report DataSet.

3. (if needed) Define input parameters:
• Property parameters, which can be used in queries to populate a 

Report DataSet collection.
 See Adding Property parameters.

• Collection parameters, which can be used directly to populate a 
Report DataSet collection.

 See Adding Collection parameters.
The user is asked to enter these parameters at Report DataSet creation.

4. Customize the Report DataSet.
 See Customizing the Report DataSet.

5. Preview the Report DataSet.
 See Previewing the Report DataSet.

The Report DataSet Definition is available for any user to create a Report
DataSet.

 See Creating a Report DataSet.

For examples of Report DataSet Definitions see:
• Collecting a Set of Objects, Linked Objects and some of their Properties
• Collecting a Set of Objects Using a Query and Adding a Computed 

Property
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Report DataSet Definition Best Practices
When you create a Report DataSet Definition you should follow the best
practices.

Defining the Report DataSet Definition
Define a Report DataSet Definition to create focused Report DataSets, i.e.:

• The Report DataSet should answer a single issue.

For examples: a report, an export of specific data.
• Do not build Report DataSets with huge amount of data that you would 

use for different purposes.

Optimizing the Report DataSet Definition for better performance

Retrieving the data

When you create a Report DataSet Definition, use the most efficient way to
retrieve data.

 See Defining the Data that Feeds the Report DataSet.

Time monitoring

To identify the column that may introduce performance issues, use the debug log to
find out how long it takes to get each column. 

To get the time monitoring tool:
1. Access the megasite.ini file (in the HAS console: Modules > Module 

Settings > MegasiteSettings).
2. Add:

[Debug]
ReportDataSetGenerationTimeMonitor=1

Keep the last generated Report DataSet

The Keep last generated result option is selected by default, so that at next
session, the first Report DataSet display time is shorten.

 See Speeding up the Report DataSet Display.

Checking the Report DataSet row count
The Report DataSet size is limited to: 

• 100 000 rows
• 50 columns

 These limits are defined in the following Options (Options > 
Tools > Documentation > Reports):
Fix the limit for Report DataSet rows
Fix the limit for Report DataSet columns
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As this maximum size can be reached quickly, check that the Report DataSet
includes all the expected rows, so that it does not miss any data.

 For information regarding Report DataSet related supervision 
events (e.g.: "Report DataSet Generate" informative event), see the 
HOPEX Administration > Managing Events > Events to be monitored 
(Production server).

Rows are produced by multiplication of the object count of each
MetaAssociationEnd.

Advice:

If your Report DataSet Definition does not include more than four levels of
MetaAssociationEnds or queries the Report DataSet should include all the data.

 See Defining the Data that Feeds the Report DataSet.

Supervising Report DataSet events
Alerts are generated when a Report DataSet exceeds the limited size.

• Lines count indicates the number of rows (hidden or not) of the Report 
DataSet

• Columns count indicates the number of Report DataSet items on the 
Report DataSet collector.

In the HOPEX Supervision console, you can check the Report DataSet events.

For detailed information regarding Report DataSet related supervision events, see
HOPEX Administration > Technical Articles > Supervision Event Description
> ReportDataSet, TreeSet, and GraphSet.
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REPORT DATASET DEFINITION CREATION

The Report DataSet Definition creation includes:
• Accessing the Report DataSet Definitions
• Creating a Report DataSet Definition
• Adding Parameters to Filter Data Extraction
• Defining the Data that Feeds the Report DataSet
• Previewing the Report DataSet

 To customize the Report DataSet Definition, see Customizing the 
Report DataSet.

Accessing the Report DataSet Definitions
You can access:

• all Report DataSet Definitions (provided and custom)
 They are displayed as a tree.

You can display all the Report DataSet Definitions in:
• the Edit area, especially to work with a specific Report DataSet 

Definition
• the Browse area, so as to keep a global view of all the Report 

DataSet Definitions in the Browse area while displaying the properties 
of one of them in the Edit area.

• custom Report DataSet Definitions only
 They are displayed as a list.

Custom Report DataSet Definitions are the Report DataSet Definitions not
provided with HOPEX.

Accessing all the Report DataSet Definitions 
To access the Report DataSet Definitions:

1. Connect to HOPEX Report Studio desktop.
 See Logging in to HOPEX Report Studio Desktop.
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2. From the navigation menus, click Report Definitions > Data Source 
Definitions.

 Click Report Definitions > Data Source Definitions  to 
display the tree in the Browse area.

The tree displays:
• HOPEX folder, which includes the Report DataSet Definitions 

provided with HOPEX and sorted in topic folders.
• all the custom Report DataSet Definitions

3. (If needed) Use the Search field to access a specific Report DataSet 
Definition.

 Click the Report DataSet Definition, to display its properties.

Accessing the custom Report DataSet Definitions 
Custom Report DataSet Definitions are the Report DataSet Definitions not provided
with HOPEX.

You can access the list of:
• all the custom Report DataSet Definitions 
• only your custom Report DataSet Definitions

 Note that when you customize a Report DataSet Definition provided 
with HOPEX, it becomes a Custom Report DataSet Definition, see How 
to Modify a Report DataSet Definition Provided with HOPEX.

To access the custom Report DataSet Definitions:
1. Connect to HOPEX Report Studio desktop.

 See Logging in to HOPEX Report Studio Desktop.
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2. In the homepage, My Scope part, to display:
• your custom Report DataSet Definitions only: in My Work, click My 

Report DataSet Definitions indicator 
• all custom Report DataSet Definitions: in Customizations, click 

Custom Report DataSet Definitions indicator 
The corresponding list of custom Report DataSet Definitions displays.

3. (If needed) Use the list filtering tool to access a specific custom Report 
DataSet Definition.

 You can sort or filter by Source MetaClass or by User in Charge 
(for all custom Report DataSet Definitions).
 Click the custom Report DataSet Definition, to display its 
properties.

Creating a Report DataSet Definition
You can create a Report DataSet Definition populated by:

• occurrences
• a query

 See Report DataSet Definition.

Defining a Report DataSet populated by occurrences
 For a detailed use case, see Collecting a Set of Objects, Linked 
Objects and some of their Properties.

To define a Report DataSet populated by occurrences:
1. Access the Report DataSet Definitions.

 See Accessing the Report DataSet Definitions.
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2. In the list menu bar, click New .

 In the tree, click New  or hover the cursor over the folder 
concerned and click .

The Creation of Report DataSet Definition window appears
3. In the Name field, enter your Report DataSet Definition name.

 By default, the Report DataSet Definition name is: Report DataSet 
Definition-x (x is a number).

4. Define the Root section:
• in the Collection is populated by field keep "Collection Parameter".
• in the MetaClass field, use the drop-down menu to select the 

MetaClass you want to define as the root MetaClass of your Report 
DataSet Definition.

 In the field, enter the first letters of the MetaClass for a quick 
access.

Example: Application.

5. Click OK.
Your Report DataSet Definition is created and added to My Report
DataSet Definition as well as both Custom Report DataSet Definition
list and Report DataSet Definition tree.
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6. Click your Report DataSet Definition.
Its Characteristics page displays and shows:
• the Root MetaClass

Example: Application
• Keep last generated result is selected by default so that at next 

session, the first Report DataSet display time is shorten.
• the Collection Parameter characteristics. 

For example, with "Application" as root MetaClass, the 
Collection parameter characteristics are:
- Type: "Application" MetaClass
- Multiplicity: "N", as several applications need to be 
collected.
- Mandatory: "Yes" by default.
- Populated RDS Collection: "Application", i.e. this 
Collection parameter populates the root node of "My Report 
DataSet Definition" Report DataSet Definition.
- _GUIName: "Application List", this parameter is displayed 
in the Report DataSet Definition Preview page.
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7. (If needed) In the Collection Parameters section, in the _GUIName 
field, modify the GUI name for the Collection Parameter. 
This string is displayed at Report DataSet creation. You can preview it in
the Report DataSet Definition Preview page.

E.g.: "Applications to retrieve:”

 See Previewing the Report DataSet.
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8. In your Report DataSet Definition properties, display its Definition 
page.
• The left pane displays the root Collection of the Report DataSet 

Definition structure.
Example: "My Report DataSet Definition" Report DataSet 
Structure includes the "Application" Report DataSet root 
Collection .

• The right pane displays the properties of the root Collection 
(Identification and Collection Provider).

9. Define your Report DataSet Definition structure.
 See Defining the Data that Feeds the Report DataSet

10. (Optional) You can add parameters to filter the data extraction.
 See Adding Parameters to Filter Data Extraction.

11. Display the Report DataSet Definition Preview page.
 See Previewing the Report DataSet.

Defining a Report DataSet populated by a query
 For a detailed use case, see Collecting a Set of Objects Using a 
Query and Adding a Computed Property.
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To define a Report DataSet populated by a query:
1. Access the Report DataSet Definitions.

 See Accessing the Report DataSet Definitions.

2. In the list menu bar, click New .

 In the tree, click New  or hover the cursor over the folder 
concerned and click .

The Creation of Report DataSet Definition window appears
3. In the Name field, enter your Report DataSet Definition name.

 By default the Report DataSet Definition name is: Report DataSet 
Definition-x (x is a number).

4. Define the Root section:
• in the Collection is populated by field select "Query".
• In the MetaClass field, use the drop-down menu to select the 

MetaClass you want to define as the root MetaClass of your Report 
DataSet Definition.

 In the field, enter the first letters of the MetaClass for a quick 
access.

E.g: Software Technology.
• In the Populating Query field, use the drop-down menu to select the 

query used to retrieve the input data.
 The queries listed are related to the MetaClass chosen as root 
MetaClass.

E.g: "APM-Get Technologies from Application".
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5. Click OK.
Your Report DataSet Definition is created and added to My Report
DataSet Definition as well as both Custom Report DataSet Definition
list and Report DataSet Definition tree.
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6. Click your Report DataSet Definition.
Its Characteristics page displays. It shows:
• the Root MetaClass

Example: Software Technology
• the Root Populating Query selected to retrieve the objects:

- Name: "APM-Get Technologies From Application" query 
retrieves the Software Technologies used in an application
- Query Parameter Name: "Application"

 You can open the query in a new tab  to display its code.

• the Property Parameter (automatically created). 

For example, the "APM-Get Technologies From Application" 
query uses the "Application" Query Parameter to retrieve 
the Software Technologies:
- Local Name: "Application"
- Type: "Object" MetaClass
- Referenced MetaClass: "Physical Business Software" 
- Query Parameter Name: "Application", this parameter is 
the exact name used in the query.
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7. In your Report DataSet Definition properties, display its Definition 
page.
• The left pane displays the root Collection of the Report DataSet 

Definition and its query.
Example: "Techno from App" Report DataSet Structure 
includes the "Software Technology" Report DataSet root 
Collection .

• The right pane details the characteristics of the root Collection 
(Identification and Collection Provider).

8. Define your Report DataSet Definition structure.
 See Defining the Data that Feeds the Report DataSet

9. (Optional) You can add parameters to filter the data extraction.
 See Adding Parameters to Filter Data Extraction.

10. Display the Report DataSet Definition Preview page.
 See Previewing the Report DataSet.
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Adding Parameters to Filter Data Extraction
In the Report DataSet Definition you can define the parameters that are used to
filter data at Report DataSet data collection. 

If needed, you can add either Property parameters or Collection parameters or
both, see:

• Adding Property parameters
• Adding Collection parameters

Adding parameters in the Report DataSet Definition properties (Characteristics),
is useful for Report DataSet Definition re-usability.

Adding Property parameters
You can limit the collection of data set rows extracted from the Root MetaClass
collection. For this purpose, you can use Property parameters in your Report
DataSet Definition.

At Report DataSet creation the user is asked to enter the Property parameter
values, which are taken into account (Property Parameters can be used in queries)
to build the Report DataSet. 
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If no property parameters is specified the Report DataSet operates on the entire
repository occurrences. 

 See also Adding a computed-type Property to the Report DataSet 
structure.

To add Property parameter in the Report DataSet Definition:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Characteristics.
3. In the Property Parameter section, click New . 

 You can add as many parameters as needed.
4. In the Property Parameter list:

• enter your Property Parameter Local Name (value shown in the 
Report DataSet)
Example: Begin date

• (if needed) modify the default values for the MetaAttribute type, 
Format, and Length.
Example: MetaAttribute Type: "DateTime".

• (if needed) in the Referenced MetaClass, connect a MetaClass
• enter the Query Parameter Name (value used in the query you add 

in the Definition tab, see Defining the Data that Feeds the Report 
DataSet)
Example: BeginDate

Example: 
When you add "Begin Date" and "End Date" Property 
Parameters, at Report DataSet creation the user is asked to 
enter both dates, which filter the Report DataSet results.

Adding Collection parameters
You can limit the collection of data set rows extracted from the Root MetaClass
collection. For this purpose, you can use Collection Parameters in your Report
DataSet Definition.

At Report DataSet creation the user is asked to enter the Collection parameter
values, which are taken into account to build the Report DataSet.

By default once you selected the Root MetaClass, a Collection parameter is added
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in the Collection Parameters list. When defined, this Collection parameter is used
to fill the root collection for data extraction.

 See Collecting a Set of Objects, Linked Objects and some of their 
Properties.

To feed the Report DataSet Definition input collection according to a collection:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Characteristics.
3. In the Collection Parameters section, click New .

 You can add as many parameters as needed.
4. From the Collection Parameter list, in the Local Name field, enter the 

name of the collection parameter.
5. In the collection Type field, click the arrow and select Connect 

MetaClass.
6. Use the connecting tool to select the MetaClass and click Connect.
7. In the _GUIName field, enter a name for your Collection parameter. 

This name is displayed in the Report DataSet Definition Preview page, 
Parameters section.
The Collection parameters are defined as your Report DataSet Definition
input collections.

Example:
You can add the "Applications to extract" Collection 
Parameter of "Application" collection Type, so that at 
Report DataSet creation the user is asked to select the 
applications to feed the Report DataSet with this 
collection.

Defining the Data that Feeds the Report DataSet

The Report DataSet Structure includes a root Report DataSet Collection  to
which you can add as many items as needed:

• Report DataSet Properties 
• Report DataSet Collections  

 See Once this root Report DataSet Collection is defined, you can 
add it as many items as needed:.
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How to add items to the Report DataSet Definition

To add an item to the Report DataSet Definition, you add it from a Report DataSet
Collection of the Definition.

E.g: from the Application Report DataSet Collection, add 
the "Application Code" MetaAttribute
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The item is added to the structure under its parent Report DataSet Collection.
E.g.: the "Application Code" Report DataSet Property is 
added to the Report DataSet structure under the 
"Application" Report DataSet Collection. 

How to proceed: the big picture

To define the data that feeds the Report DataSet you can add:
• Report DataSet Collections:

• directly from a Report DataSet Collection of the structure
 See Adding a Report DataSet Collection.

• Report DataSet Properties:
• value-type Properties

 See Adding a value-type Property to the Report DataSet structure.

• parameter-type Properties
 See Adding a parameter-type Property to the Report DataSet 
structure.

• computed-type Properties
 See Adding a computed-type Property to the Report DataSet 
structure.

• collection count-type Properties
 See Adding a collection count-type Property to the Report DataSet 
structure.

Adding a Report DataSet Collection
From the Report DataSet structure, you can add a Report DataSet Collection to a
Report DataSet Collection (the root one or another one).

To add a Report DataSet Collection to the Report DataSet structure:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Display its Definition page.

The left pane displays the Report DataSet structure.
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3. Hover the cursor over the Report DataSet Collection, click  and 
select Report DataSet Collection:

4. In the Collection Provider section:
in the Collection is populated by drop-down list, select how to populate
the Report DataSet Collection:
• MetaAssociationEnd and in the Target MetaClass select the 

MetaClass corresponding to the Collection you want to add and in the 
Populating MetaAssociationEnd drop-down list, select the 
MetaAssociationEnd.

 The list includes available MetaAssociationEnds only, i.e. the 
MetaAssociationEnds of the parent Report DataSet Collection.

or
• Collection parameter and in the Populating Collection 

Parameter field, select the Collection parameter.
 A Collection parameter is available if in the Report DataSet 
Definition Characteristics tab, you added a Collection Parameter, 
see Adding Collection parameters.

or
• Query and connect or create a query. In the Target MetaClass/

Populating query drop-down lists select a MetaClass and its related 
query or click Connect Query to connect the query (else click New 
query to create a query). 

 The list includes only the queries related to the parent Report 
DataSet Collection.
 If you created a Property parameter in the Report DataSet 
Definition Characteristics tab (see Adding Property parameters ), you 
can use it in the query.

5. Click OK.
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Adding a value-type Property to the Report DataSet structure
You can feed the Report DataSet with value-type properties, based on:

• a MetaAttribute
• a TaggedValue

From the Report DataSet structure, you can add a Property to a Report DataSet
Collection of the structure.

To add a value-type Property to the Report DataSet structure:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Definition.

The left pane displays the Report DataSet structure.
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3. Hover the cursor over the Report DataSet Collection, click  and 
select Report DataSet Property:

• In the Property type field, select "Value".
• In the TaggedValue/MetaAtribute field, select the TaggedValue/

MetaAttribute.
4. Click OK.

Adding a parameter-type Property to the Report DataSet structure
You can feed the Report DataSet with parameter-type Properties.

From the Report DataSet structure, you can add the Property to a Report DataSet
Collection of the structure.

To add a parameter-type Property to the Report DataSet structure:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Definition.

The left pane displays the Report DataSet structure.
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3. Hover the cursor over the Report DataSet Collection, click  and 
select Report DataSet Property:

• In the Property type field, select "Parameter".
• In the MetaParameter field, select the MetaParameter.

 A MetaParameter is available if in the Report DataSet Definition 
Characteristics tab, you added a Property Parameter, see Adding 
Property parameters.

4. Click OK.

Adding a computed-type Property to the Report DataSet structure
You can feed the Report DataSet with a computed-type Property. The Property is
computed locally for the dataset. For this purpose you create a computed Report
DataSet Property  from the Report DataSet Collection  using a macro.

To add a computed-type Property to the Report DataSet structure:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Definition.

The Report DataSet structure displays.
3. Right-click the Report DataSet Collection and select New> Report 

DataSet Property:
• In the Property type field, select "Computed".
• Define the MetaAttribute characteristics (Type, Length, Format)
• In the Implementation field, click the right oriented arrow and select 

Create Macro.
 For an example, see Collecting a Set of Objects Using a Query and 
Adding a Computed Property.

4. Click OK.
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Adding a collection count-type Property to the Report DataSet structure
You can feed the Report DataSet with a collection count-type Property. 

The Property is collected locally for the dataset, with the count of the collection
retrieved from a query or a MetaAssociationEnd. As collected, the Property cannot
be drag and drop. For this purpose you create a collection count Report DataSet
Property  from the Report DataSet Collection  using a query or a
MetaAssociationEnd. 

To add a collection count-type Property to the Report DataSet structure:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Definition.

The Report DataSet structure displays.
3. Right-click the Report DataSet Collection and select New> Report 

DataSet Property.
4. In the Property type field, select "Collection count".
5. From the Counted Query (or Counted MetaAssociationEnd) field 

connect the query (or the MetaAssociationEnd).

Previewing the Report DataSet
From the Report DataSet Definition properties you can test the Report DataSet.

To preview the Report DataSet:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Display its Preview page.
3. Click Create Preview.
4. In the Parameters section, define the source data:

• if needed enter the parameter value
 See Adding Parameters to Filter Data Extraction.

• if needed, in the source MetaClass, click Connect  and connect 
the MetaClass item(s) required.

5. In the Report DataSet section, click Generate .
The Report DataSet displays:
• date and time of computation
• collected data in tabular form

 Objects from a Data Reading access not accessible to the user are 
not displayed.
 In the Report DataSet section, click a column header to sort the 
result according to this data.
 In the Report DataSet section, using the column filters or the 
column filtering tool perform actions on the Report DataSet display 
only: all the data (displayed or hidden) is still included in the Report 
DataSet.
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6. You can:
• customize the Report DataSet

 See Customizing the Report DataSet.

• generate an Instant Report from the Report DataSet 
 The entire Report DataSet data is taken into account, even the 
hidden data if you used the column filters or the column filtering tool (in 
the Preview page). The customization must be performed in the 
Definition page.

• export the Report DataSet in Excel format
 If you filtered the Report DataSet display, in that case only 
displayed data is exported.
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CUSTOMIZING THE REPORT DATASET

See:
• Modifying the Display Order of the Report DataSet Columns
• Hiding a Column of the Report DataSet
• Removing a Column from a Report DataSet
• Modifying the Name of a Report DataSet Column Header
• Speeding up the Report DataSet Display

Modifying the Display Order of the Report DataSet Columns
Once the Report DataSet Definition tree is defined you can modify the Report
DataSet column display order.

To modify the display order of the Report DataSet:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Definition.

3. In the bottom list tool bar, click Reorganize .
4. Select the items (representing the columns) you want to move and drag 

and drop them where you want.

5. Click OK.
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Hiding a Column of the Report DataSet
To ease the Report DataSet report readability you can hide columns. At Report
DataSet generation, the data is still retrieved and can be displayed if needed.

To hide a column of the Report DataSet:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Definition.
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3. In the bottom list, in the Visible field of the column you want to hide 
select "No (By default)".

Example: for the "Technologies", in its Visible field 
select "No (By default)".

4. At Report DataSet generation, the column is hidden by default, but can 
be displayed (using the filter available on column headers in object lists, 
see Handling Lists).
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Removing a Column from a Report DataSet
At Report DataSet Definition creation, in the Report DataSet structure, you might
need to add elements that are necessary to retrieve other elements. These elements
are available in the structure for this purpose but you might not want them to be
included in the Report DataSet.

You can make them not available in the Report DataSet. In that case, the data is
not retrieved.

For example, with a Report DataSet Definition based on the 
Application MetaClass, you can add:
- the Technologies used for these applications.
- the Vendors of these Technologies: you need to go through 
the Technologies to retrieve the Vendors.
You may be interested in the Vendors of the Technologies but 
not in the Technologies themselves. You can make the 
"Technologies" column not available in the Report DataSet.

To remove a column from a Report DataSet:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Definition.
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3. In the bottom list, in the Visible field of the column you do not want to 
be available in the Report DataSet, select "Never".

For example: for the "Rating", in its Visible field select 
"Never".

4. At Report DataSet generation, the column is not displayed, and cannot 
be added. The data is not retrieved.

Modifying the Name of a Report DataSet Column Header
To modify the name of a Report DataSet column header you have to modify the
Report DataSet item name.

To modify a Report DataSet item name:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Definition and go to the bottom list.
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3. In the bottom list:
• select the row concerned
• click in its Short Name cell and modify its name.

Example: change "Global Expense" in "Cost".

The Report DataSet Definition tree is updated accordingly.

In the bottom list, the Populating Element column keeps track of the
Report DataSet column header names(s) you modified with the
corresponding MetaModel element name(s).

Speeding up the Report DataSet Display
By default, the Keep last generated result option of the Report DataSet Definition
is selected, so that at next session, the first Report DataSet display time is shorten.

To modify the Report DataSet result display:
1. Access the Report DataSet Definition properties.

 See Accessing the Report DataSet Definitions.
2. Select Characteristics.
3. Select/Clear Keep last generated result.
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HOW TO

See:
• How to Add a Column to a Report DataSet
• How to Remove a Column from a Report DataSet
• How to Hide a Column in a Report DataSet
• How to Modify a Report DataSet Definition Provided with HOPEX
• How to Duplicate a Report DataSet Definition
• How to Add a Report DataSet in an Object Property Pages

How to Add a Column to a Report DataSet
Each Report DataSet column corresponds to each data you defined as feeding the
Report DataSet.

To add a column in a Report DataSet you can either:
 In the Report DataSet Definition definition tab, drag and drop object 

from the left pane to the Report DataSet tree structure.
 See Defining the Data that Feeds the Report DataSet.

 In the Report DataSet Definition definition tab, from the Report DataSet 
Collection create a Report DataSet Property.

 See Adding a computed-type Property to the Report DataSet 
structure.

How to Remove a Column from a Report DataSet
Each Report DataSet column corresponds to each data you defined as feeding the
Report DataSet.

You might want some of theses columns not to be available in the Report DataSet,
i.e. you do not want to retrieve this data from the repository.

To remove a column from the Report DataSet, you can customize the Report
DataSet Definition.

 See Removing a Column from a Report DataSet.

How to Hide a Column in a Report DataSet
Any data, displayed or hidden in the Report DataSet is part of the Report DataSet,
and taken into account at Instant report creation.
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You can hide a column from:
• the Report DataSet Definition

Data is extracted from the repository. By default, it is not displayed in the
Report DataSet, but can be displayed. Hidden data remains in the Report
DataSet.

 See Hiding a Column of the Report DataSet.

• the Report DataSet
Data is extracted from the repository but not displayed in the Report
DataSet.

 See Handling the Report DataSet.

How to Modify a Report DataSet Definition Provided with HOPEX
You might want to modify a Report DataSet Definition provided with HOPEX. The
best way to do so is to duplicate the Report DataSet Definition and modify it
according to your needs.

How to Duplicate a Report DataSet Definition
You might need to duplicate a Report DataSet Definition to modify it according to
your needs.

To duplicate a Report DataSet Definition:
1. Access the Report DataSet Definition folder.

 See Accessing the Report DataSet Definitions.
2. Right-click the Report DataSet Definition and select Manage > 

Duplicate.
3. Define the name of the duplicated Report DataSet Definition.
4. Click OK.

How to Add a Report DataSet in an Object Property Pages
You can define a Report DataSet in an object Property pages as a report.

To do so, you must:
• create a macro-based query, which call the Report DataSet and its 

collection parameter.
• create a MetaProperty page on the MetaClass concerned, which call the 

query you created.
For example, in Application MetaClass properties, you can 
add a page that displays all the technologies of the 
application using the Application Technologies Report 
DataSet.



58

2

To define a Report DataSet in an object Property page as a report:
1. Connect to HOPEX (Windows Front-End) with HOPEX Customizer 

profile.
2. Use the Explore tool to create a macro-based query:

• in the Name field enter a name to your query

Example: "Application Technologies Virtual Report DataSet"
• in the Query Implementation field, select "Macro"
• in the Stereotype field, select "Internal Query"

3. Click Finish.
4. Access your query properties.
5. in its Macro page:

• In the MetaClass Target connect the "Report DataSet" MetaClass.
• In the Parameter field create a parameter associated with the source 

MetaClass.
Example: "App"

• In the MetaClass Source connect the source MetaClass.

Example: "Application" MetaClass
• In the Macro field, click the right-oriented arrow and select Create 

Macro (select (VB) script macro and click Next, enter a Name and 
click OK).
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6. Edit the macro, and enter the following code, and replace the following 
text with your object megafields:
• <REPORT DATASET DEFINITION MEGAFIELD>

Example: ~b)pvF8oxKj34[Application Technologies]
• <REPORT DATASET COLLECTION PARAMETER MEGAFIELD>

Example: ~8(pvzTrxKPJ5[Applications to extract]

'MegaContext(Fields,Types)
Option Explicit

'Implement this function if you want to create the resulting 
Collection 
Function GetSelectionCollection(mgobjObject as 
MegaObject,vntSelectorID as Variant) as MegaCollection
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  Dim mgRoot
  Set mgRoot = mgobjObject.GetRoot

  Set GetSelectionCollection = 
mgRoot.getSelection("~)ilXTIGrKPiB[Report DataSet]")
Dim mgobjReportDataSetDefinition
Set mgobjReportDataSetDefinition = 
mgRoot.GetObjectFromId("<REPORT DATASET DEFINITION 
MEGAFIELD>")
If mgobjReportDataSetDefinition.Exists Then
Dim mgobjReportDataSetTemplate
Set mgobjReportDataSetTemplate = 
mgRoot.GetCollection("~)ilXTIGrKPiB[Report 
DataSet]").CreateTemplate
mgobjReportDataSetTemplate.GetCollection("~rLU9sCZtKLx6[Rep
ort DataSet Definition]").Add mgobjReportDataSetDefinition
mgobjReportDataSetTemplate.GetCollection("<REPORT DATASET 
COLLECTION PARAMETER MEGAFIELD>").Add mgobjObject
mgobjReportDataSetTemplate.GetProp("~CjvjWdhJOXuC[Hide 
Valorized Parameters]") = "1"
GetSelectionCollection.Insert mgobjReportDataSetTemplate
End If
End Function
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7. Create a MetaPropertyPage on the MetaClass you want to add the Report 
DataSet:

Example: on the "Application" MetaClass
• In the MetaClass properties, select UserInterface tab
• In the Property Page subtab, create a MetaPropertyPage
• In the Name field enter the name.

Example: "Application Technologies (report)"
• Click Finish.

8. Define the MetaPropertyPage properties, in the Setup tab:
• In the _GUIName field enter the name that you want to be displayed 

in the object property pages.
Example: "Application Technologies (Report DataSet)"

• In the _Parameterization section enter the following code, and 
replace <QUERY MEGAFIELD> with the query megafield you created:

[Template]
rds=Map(<QUERY MEGAFIELD>)
page=Item(~Nx(oYLUvK1cF[Report 
DataSet.DataSet]),From(rds),Control(SubPage)

9. Click OK.
10. Exit HOPEX.



62

2

11. Check that the new page is created.
For example, here the "Application Technologies (report 
DataSet)" page is added to the "AirportMega.com" property 
pages.

Note:

For the property page to be available in a HOPEX Solution, you must define its
Property Page Presentation.

 See Customizing the User Interface > Versatile Desktop > Adding a 
Property page to a Metaclass.
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USE CASES

See:
• Collecting a Set of Objects, Linked Objects and some of their Properties
• Collecting a Set of Objects Using a Query and Adding a Computed 

Property

Collecting a Set of Objects, Linked Objects and some of their 
Properties

Description
A use case of Report DataSet Definition consists in defining the root collection as
input parameter for the Report DataSet.

In this use case, the Report DataSet Definition is based on the Application root
MetaClass and on the Collection Parameter "Application List" (of Collection Type:
Application).

The Report DataSet displays for each Application:
• its Software Technologies used and associated Vendors.
• its Global Expenses

Note:

The Software Technology MetaClass is not directly connected to the Application
MetaClass, but to an abstract MetaClass (Supporting Software Technology
Building Block) of which Software Technology and Software Technology
Stack are sub-types.

So that to add the Software Technology to the Definition, you need add the
Software Technology as target MetaClass and define its Populating
MetaAssociationEnd as Supporting Software Technology.
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Creating the Report DataSet Definition
To create the Report DataSet Definition that displays the applications and their
Technologies and associated Vendors:

1. Create a Collection Parameter - based Report DataSet Definition, which 
is based on the Application root MetaClass.

 See Defining a Report DataSet populated by occurrences.

 See Creating a Report DataSet Definition.

The collection parameter is pre-set or already set with the Application
root MetaClass, the "Application List" Collection Parameter is
automatically added with the "Application" Collection Type value. 
This Collection parameter is used to list all the applications of the
repository.
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2. Define the data you want to display in the Report DataSet, from the 
Report DataSet Definition properties: Definition page:
Hover the cursor over Application Report DataSet Collection and click

New  > Report DataSet Property:
• In Identification section, enter a Local Name: "Global expenses"
• In Configuration section, select "Global Expense" MetaAttribute.
• Click OK.

Hover the cursor over Application Report DataSet Collection and click

New  > Report DataSet Collection:
• In Identification section, enter a Local Name: "Technologies"
• In Collection Provider section, Collection is populated by field 

keep "MetaAssociationEnd"
• In Populating MetaAssociationEnd select "Software Technology" 

Target MetaClass, with:
• Populating MetaAssociationEnd: "Supporting Software 
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Technology".
• Click OK.

Hover the cursor over Technologies Report DataSet Collection and click

New  > Report DataSet Collection:
• In Identification section, enter a Local Name: "Vendor"
• In Collection Provider section, Collection is populated by field 

keep "MetaAssociationEnd" with:
• Target MetaClass: "Org-Unit"
• Populating MetaAssociationEnd: "Org-Unit". 
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 See Defining the Data that Feeds the Report DataSet.
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3. (If you need to change a name) Modify a name.
 See Modifying the Name of a Report DataSet Column Header.

4. Reorganize the Report DataSet column order as follows:
 See Modifying the Display Order of the Report DataSet Columns.
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5. In the Report DataSet Definition properties, select Preview and test 
your Report DataSet Definition.

 See Previewing the Report DataSet.
You can use the filters available on the column headers to refine the
Report DataSet display. This does not modify the Report DataSet content
(only its display).

For example use the "Show non empty values only" for 
Technologies and Vendor columns, and ">0" for Global 
Expense.

You can:
• export the Report DataSet in CSV format 
• generate Instant Reports from the Report DataSet 

 In both cases, the entire Report DataSet data is taken into account, 
even data hidden with the filtering used in the Preview page.
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Collecting a Set of Objects Using a Query and Adding a Computed 
Property

Description of the Report DataSet Definition
This use case collects a set of applications of a specific portfolio of a given vendor
asking the user to choose the portfolio and the vendor:

The result displays for each application:
• properties regarding the application (cost, type, rank, used technology) 

and the technology (end life date, vendor) and the vendor (number of 
provided technologies)

• a computed property: the number of Business Processes of the 
application

This Report DataSet Definition is based on the root MetaClass: Application (1). 

To define how to collect the input data, you need to create a Query (2), which
computes the input data using two Property Parameters ("Vendor" and "Portfolio"): 

• Query name
"APM - Get Applications of a Portfolio using Technologies of a given
Vendor"

• Query code
Select [Org-Unit] Into @OrgUnits Where [Name] = &"Vendor"
Select [Software Technology] Into @Technologies Where 
[Vendor] in @OrgUnits
Select [Application] Where ([Supporting Software 
technology]:[Software Technology] in @Technologies)
           And [Initiative].[Owner Portfolio] = &"Portfolio" 
Or  [Deployed Object]:[Software 
Installation].[Initiative].[Owner Portfolio] = &"Portfolio"

Where the Property Parameters:
• "Vendor" defines from who the end user wants to collect the 

applications
• "Portfolio" defines from which portfolio the end user wants to collect 

the applications

Both "Vendor" and "Portfolio" Property parameters (3) are automatically created
once the query is selected.

 Note that the Query Parameter Name value in the query code 
and in the Property Parameters ("Vendor" and "Portfolio") are exactly 
the same, ans that they are case sensitive.
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To define (4) the data you want to display in the Report DataSet, you can:
• add Report DataSet Collections (a)
• add Report DataSet properties (b), 

 Note that the Software Technology MetaClass is not directly 
connected to the Application MetaClass, but to an abstract MetaClass 
(Supporting Software Technology Building Block) of which 
Software Technology and Software Technology Stack are sub-
types.
So that to add the Software Technology to the Definition, you need to 
go through the Supporting Software Technology 
MetaAssociationEnd and define the Software Technology 
MetaAssociationEnd as target.

• create a computed property (c):
• a Report DataSet Property, which displays the number of Process 

Categories of each application
Report DataSet Property: "Number of processes".

• the Macro, which computes the "Number of processes" 

Macro: "Application Process.Implementation".
Sub GetAttributeValue(Object as MegaObject,AttributeID as 
Variant,Value as String)
  Dim mgApp
  Set mgApp = 
Object.GetRoot.GetCollection("Application").Item("~" & 
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Object.GetProp("<Field of the Report DataSet Collection 
"Application">"))
  If mgApp.Exists Then
    Value = mgApp.GetCollection("~h4n)MzlZpK00[Process 
Category]").count
  Else
    Value = 0
  End If
End Sub

Creating the Report DataSet Definition
To create the Report DataSet Definition that collects applications of a specific
portfolio of a given vendor: 

1. Create a query-based Report DataSet Definition based on the 
Application root MetaClass.

e.g.: Report DataSet Definition Name: Applications of Portfolio.
 See Defining a Report DataSet populated by a query.
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2. In the Populating Query field, create the query that defines how to 
collect the input data, with the following characteristics:
• Name: "APM - Get Applications of a Portfolio using Technologies of a 

given Vendor"
• Query Implementation: "Select"
• Stereotype: "Internal Query"
• Query Code:

Select [Org-Unit] Into @OrgUnits Where [Name] = &"Vendor"
Select [Software Technology] Into @Technologies Where 
[Vendor] in @OrgUnits
Select [Application] Where ([Used Technology] in 
@Technologies)
           And [Initiative].[Owner Portfolio] = &"Portfolio" 
Or  [Deployed Object]:[Software 
Installation].[Initiative].[Owner Portfolio] = &"Portfolio"
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3. Note that both "Portfolio" and "Vendor" Property parameters are 
automatically created:
• Type: "Object"
• Format: "MegaIdentifier"
• Referenced MetaClass: Portfolio/Org-Unit MetaClass
• Query Parameter Name: "Portfolio"/"Vendor"

 If needed you can rename its Local Name. Only the Query 
Parameter Name value must have the exact same name as in the 
Query Code (be careful as it is case sensitive).
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4. Define the data you want to display in the Report DataSet, from the 
Report DataSet properties: Definition:

 You can feed the Definition in any order.

Add Report DataSet Collections and Report DataSet Properties
 See Adding a Report DataSet Collection.

Hover the cursor over Application and click New  > Report
DataSet Property:
• Local Name: enter "Application Type" (/"Cost"/"Rank")
• Property type: "Value" (by default)
• MetaAttribute: "Application Type" (/"Cost"/"Rank\APM")
• Click OK

Hover the cursor over Application and click New  > Report
DataSet Collection:
• Local Name:enter "Used Technology"
• Collection is populated by: "MetaAsociationEnd" (by default)
• Target MetaClass: "Software Technology" 
• Populating MetaAssociationEnd: "Supporting Software 

Technology" (automatically filled in)
• Click OK

Hover the cursor over Used Technology, and click New  > Report
DataSet Collection:
• Local Name: enter "Vendor"
• Collection is populated by "MetaAssociationEnd" (by default)
• Target MetaClass: select "Org-Unit"
• Populating MetaAssociationEnd: "Vendor".(automatically filled in)
• Click OK

Hover the cursor over Vendor, and click New  > Report DataSet
Property:
• Local name: enter "Number of provided Technologies"
• Property type: "value" (by default)
• MetaAttribute: "Number of provided Technologies"
• Click OK.

Hover the cursor over Used Technology, and click New  > Report
DataSet Property:
• In the Local name field enter "End life date".
• Keep Property type: "value".
• In the MetaAttribute field select "End life date".
• Click OK. 
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Add a computed Property
 See Adding a computed-type Property to the Report DataSet 
structure.

From the Application Report DataSet Collection, create a computed
parameter "Number of processes":

Hover the cursor over Application and click New  > Report
DataSet Property:
• Local Name: enter "Number of processes"
• Property type: "Computed".
• MetaAttribute Type: "String"
• MetaAttribute Length: 63
• in the Implementation field, select Create macro and create the 

"Application Process.Implementation" macro:
Sub GetAttributeValue(Object as MegaObject,AttributeID as 
Variant,Value as String)
  Dim mgApp
  Set mgApp = 
Object.GetRoot.GetCollection("Application").Item("~" & 
Object.GetProp("~7LVpD6zKezHJ[Application]"))
  If mgApp.Exists Then
    Value = mgApp.GetCollection("~h4n)MzlZpK00[Process 
Category]").count
  Else
    Value = 0
  End If
  ' Value = 4
End Sub
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Where here "~7LVpD6zKezHJ[Application]" is the field of the
"Application" Report DataSet Collection. 
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5. Reorder the Report DataSet columns.
 See Modifying the Display Order of the Report DataSet Columns.

6. Hide the "Application Type" column and rename a Short Name if needed.
 See Hiding a Column of the Report DataSet and Modifying the 
Name of a Report DataSet Column Header.
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7. In the Report DataSet Definition properties, select Preview and test 
your Report DataSet Definition.

For example, use "CRM Transformation" Portfolio and 
"Microsoft" Vendor.

 See Previewing the Report DataSet.

You can:
• export the Report DataSet in CSV format 
• generate Instant Reports from the Report DataSet 

 The entire Report DataSet data is taken into account, even data 
hidden with the list filtering tool (in the Preview page).
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REPORT DATASET CREATION

A Report DataSet Definition is available for any user to create a Report DataSet.

See:
• Accessing Report DataSets
• Creating a Report DataSet
• Handling the Report DataSet
• Creating a Report Template from the Report DataSet

Accessing Report DataSets
In HOPEX Report Studio, Report DataSets are accessible from the Report
Definitions navigation menu.

Report DataSets are displayed in two lists:
• your Report DataSets only (by default)
• all the public Report DataSets

To access the Report DataSets in HOPEX Report Studio:
1. Connect to HOPEX Report Studio desktop.

 See Logging in to HOPEX Report Studio Desktop.
2. From the navigation menus, click Report Definitions > Data Sources: 

Report DataSets.
The list of My Report DataSets displays.

3. To display all the public Report DataSets, click My Report DataSets and 
select Public Report DataSets.

 The Public Report DataSets list is now the default one.

Creating a Report DataSet
To create a Report DataSet:

1. Access the Report DataSet list.
 In a Solution desktop, click the Environment > Common: Report 
DataSets navigation menu (or Report Definitions > Data Sources: 
Report DataSets).

2. In My Report DataSets page, click New .
3. In the Report DataSet Definition drop-down list, select a Report 

DataSet Definition.
E.g.: Application Technologies.

4. (Optional) Modify the Name of your Report DataSet.
By default its name is: <name of its Report DataSet Definition>-x.

E.g.: Application Technologies-1.
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5. (If needed) Expand the Parameters section and enter the requested 
parameters.

E.g.: connect the applications to be extracted.
6. Click OK.

Your Report DataSet is created.
7. Access your Report DataSet properties.
8. Display its Data page.
9. In the Report DataSet section, your Report DataSet is fed with data.

 In the Parameters section you can define or modify the 
parameters, then in the Report DataSet section, click Generate  to 
update your Report DataSet.

Handling the Report DataSet
Once the Report DataSet is created, you can:

• modify the Report DataSet Sharing status.
By default the Report DataSet is public. It is shared with all the users
and accessible from Public Report DataSets by all of them

 To facilitate the access to a Report DataSet you can make it 
private (from the Report DataSet properties > Characteristics page, 
in the Sharing field, select "Private") and define the persons concerned. 
For these persons, the Report DataSet is then available in My Report 
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DataSets. The Report DataSet is no longer available in Public 
Report DataSets for any user.

• create an Instant Report from your Report DataSet: click Instant 
Report .

• refresh the Report DataSet with updated data: in the HOPEX toolbar 

click Refresh .
• update the Report DataSet after its Parameters modification: click 

Generate .

• export the Report DataSet: click CSV .
• hide Report DataSet columns: hover the cursor over a table header and 

click  and select Columns and clear the items you want to hide.
This can be useful to facilitate readability of the Report DataSet. 
Hidden column data remains included in the Report DataSet.
When you launch an instant report, the instant report is
performed on all the Report DataSet data.

 For detailed information on Report DataSet handling see 
Common Features documentation.
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Creating a Report Template from the Report DataSet
From the Data page of the Report DataSet, you can launch an Instant Report, then
save the report as:

• a Report Template
• a Report Data View, to use it in a Report Template

 Note that Save as Report, generates a public report and also a 
private Report Template, which you can access in Private Report 
Template > My Report Templates folder.

To create a Report Template from a Report DataSet:
1. Access the Report DataSet.

 See Accessing Report DataSets.
2. Click the Report DataSet name concerned to display its properties.
3. Display its Data property page.

4. In the Report DataSet section, click Instant Report .
5. Select the required instant report type.

E.g.: Breakdown (pie chart, bar chart, set of gauges, word 
cloud), Matrix (bar chart, radar chart), Quantitative (bar 
chart, line chart, radar chart), Table. 

6. Click OK.
The instant report is displayed in full page, Report section.
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7. In the Report section, click More  > Save As Report Template .

 Note: if you customize the report display, this customization is not 
taken into account in the Report Template.

8. In the Name field, enter your Report Template name.
9. Click OK.

A public Report Template is created, with its public Report Table
View. They both have the same name.
You can directly access the Report Template from your Home page:
in My Work, click My Report Templates indicator.

 See also Accessing the Report Templates and their Constituents.

Creating a Report Data View from the Report DataSet
From the Data page of the Report DataSet, you can launch an Instant Report, then
save the report as:

• a Report Template, to get its Report Template
• a Report Data View, to use it in a Report Template
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From a Report DataSet, you can create a Report Data View:
• a Report Table View

• a Report Matrix View
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To create a Report Data View:
1. Access the Report DataSet properties (from Report Definitions > 

report DataSets).
 See Accessing Report DataSets.

2. Display its Data page.
3. In the Report DataSet section, click Instant Report .
4. Select the required instant report type.

E.g.: Breakdown (pie chart, bar chart, set of gauges, word 
cloud), Matrix (bar chart, radar chart, Quantitative (bar 
chart, line chart, radar chart), Table. 

5. Click OK.
The instant report is displayed in full page, Report section.

6. (Optional) You can customize the report display.
 See Managing Instant Reports.

7. In the Report section, click More  > Save as View .
8. Enter a Name to the view.
9. Click OK.

The Report Data View is created and accessible in the Report Studio >
Report Template Definition > Public Report Data Views folder.
Any HOPEX user can add the View to a Report template:
• use the View to create a Report Template

 See Creating a Report Template using a Report Data View.

• add the View as a report Chapter in a Report Template
 See Adding a Report Chapter to a Report Template.
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GRAPHSET DEFINITION

The following points are covered here:

 Introduction to GraphSet Definition
 GraphSet Definition Creation
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INTRODUCTION TO GRAPHSET DEFINITION

 GraphSet Definition is only available with HOPEX Power Studio technical module.

A GraphSet Definition creation is performed in HOPEX (Web Front-End) for users with HOPEX
Customizer or HOPEX Customizer Publisher profile.

Creation and use of GraphSet are available in HOPEX Solutions for all users.

Once a Report Template is created from a GraphSet Definition, any user of a Solution can use
it to query HOPEX repository and create graph reports.

GraphSet Definition and GraphSet Principle

GraphSet Definition
A GraphSet Definition enables to create GraphSet reports as follows:

• Phase 1: Extraction of a set of HOPEX data.
This extraction consists in defining entry points, from which the repository is browsed to
retrieve a set of HOPEX data that will constitute the GraphSet.

• Phase 2: Display of this set of HOPEX data as a graph.
• Phase 3: Creation of graph reports from this display.

This data extraction constitutes the GraphSet data, with no style specification.

The data extraction is oriented and comply with the rules defined on node and arc definitions. 

GraphSet entry point
A GraphSet entry point is an object or an object collection, which are the entry points of the
GraphSet data extraction. 

The GraphSet is computed and built from these entry points.



91

GraphSet Definition
Introduction to GraphSet Definition

GraphSubSet 
A GraphSubSet defines a logical set of arc (and/or path) and node definitions.

A GraphSubSet can be reused in any GraphSet Definition.

A GraphSet Definition is made up of one or several GraphSubSets. 
Example: 
The "Application’s environment" GraphSet Definition is made up of 
"Application's Software Installations", "Application Functional 
Scope","All Environment Graph", and "Exchange and Content of an 
Application" GraphSubSets.

GraphSet 
A GraphSet is an instance of a GraphSet Definition, defining all parameter values necessary to
generate the graph data structure.

A GraphSet is made up of nodes and arcs that are grouped together in one or several layers
corresponding to the GraphSubSets of its GraphSet Definition.

In the GraphSet Definition properties, the Preview page shows the default display of the
GraphSet content. 
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A GraphSet, whose GraphSet Definition includes several GraphSubSets, shows by default all
data of all its layers. 

Example:
The GraphSet whose GraphSet Definition is "Application’s environment" is 
made up of the following layers (corresponding to each GraphSubSet of the 
GraphSet Definition):
- Application's Software Installations
- Application Functional Scope
- All Environment Graph
- Exchange and Content of an Application

Depending on the amount of nodes and arcs included in the GraphSet, its complete display might
be too crowed. 
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To focus on a specific analysis axis, the end-user can hide/display one or several of the GraphSet
layers.

Example:
For the GraphSet whose GraphSet Definition is "Application’s environment" 
you can display its "Exchange and Content of an Application" layer only.

Node
A node is an HOPEX object based on a MetaClass (concrete or abstract). 

For example:

 nodes are Application MetaClass-based nodes

 nodes are Technology MetaClass-based nodes

The node can be included in several layers but is displayed only once in the GraphSet when all of
the layers are displayed.

A node can carry fields based on MetaAttributes, TaggedValues, LegAttributes from the
corresponding HOPEX object, or computed with a macro.

 See Defining the nodes of the GraphSubSet.



94

2

Arc
An arc links two nodes either based on a MetaAssociationEnd or on a query. 

An arc is defined by rules to discover the links between nodes and discover new nodes.

An arc can carry fields based on MetaAttributes, TaggedValues, LegAttributes from the
corresponding HOPEX Object, or computed with a macro.

 See Defining the arcs of a node.

Path
A path is a kind of arc, which includes nodes. The nodes that are part of the path have two arcs
only, and are named intermediate nodes.

The path enables to collect fields on intermediate nodes and display them on the arc, or display the
details of these intermediate nodes.

If an object is both part of a path and discovered by another arc in the GraphSet, then it is
displayed twice in the graph.

Intermediate node
An intermediate node is a node, which exists within a path. Intermediate nodes are part of a path,
and can be displayed or hidden.
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Creating and Defining a GraphSet Definition: the Big Picture
To create and define a GraphSet Definition:

1. Define the object type, i.e. the GraphSet entry points.
The GraphSet entry point can be:
• an object, 
• an object collection,
• a query

 See Creating a GraphSet Definition.
2. Define the GraphSubSets that constitute the GraphSet.

You can:
• create new GraphSubSets
• reuse GraphSubSets already created

 See Adding a GraphSubSet to a GraphSet Definition.
3. Define each GraphSubSet:

• its nodes
• its arcs and/or paths

 See Defining the Data that Feeds the GraphSubSet.
4. (Optional) Add fields at node and/or arc level.

 See Adding Fields to Nodes/Arcs.

 See Adding Fields to Intermediate Nodes.
5. Preview the GraphSet.

 See Previewing the GraphSet.
6. On the GraphSet, perform a Save as Report to create a GraphSet report.

The GraphSet Definition is available for any user to create a GraphSet.
 See Saving the Graph Report.

7. Customize the GraphSet report.

GraphSet Definition Best Practices
When you create a GraphSet Definition you should follow the best practices.

Define a GraphSet Definition to create focused GraphSets, i.e.:
• The GraphSet should answer a single issue.

For examples: a report, an export of specific data.
• Do not build GraphSets with huge amount of data that you would use for different 

purposes.
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A GraphSet size is limited to:
• 1000 nodes 
• 10 000 arcs

 These limits are defined in the following Options (Options > Tools > 
Documentation > Reports):
Fix the limit for GraphSet Nodes
Fix the limit for GraphSet Arcs

A "GraphSet volume alert" warning is generated when a GraphSet exceeds these recommended
limits.

Supervising GraphSet Events
In the HOPEX Supervision console, you can check the GraphSet-specific events (e.g.: "GraphSet
Generate" informative event):

• Node Count indicates the number of nodes in the GraphSet.
• Internal Node Count Limit indicates the recommended maximum number of nodes in 

the GraphSet.
• Arc Count indicates the number of arcs in the GraphSet.
• Internal Arc Count Limit indicates the recommended maximum number of arcs in the 

GraphSet.

For detailed information regarding GraphSet related supervision events, see HOPEX
Administration > Technical Articles > Supervision Event Description > ReportDataSet,
TreeSet, and GraphSet.
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GRAPHSET DEFINITION CREATION

The GraphSet Definition creation includes:
• Accessing the GraphSet Definitions
• Creating a GraphSet Definition
• Adding GraphSet Definition Entry Points
• Adding a GraphSubSet to a GraphSet Definition
• Defining the Data that Feeds the GraphSubSet
• Adding Fields to Nodes/Arcs
• Adding Fields to Intermediate Nodes
• Previewing the GraphSet
• Saving the Graph Report

 To customize the GraphSet, see Previewing the GraphSet.

Accessing the GraphSet Definitions
You can access:

• all (provided and custom) GraphSet Definitions 
They are displayed as a tree.
You can display them in:
• the Edit area, especially to work with a specific GraphSet Definition
• the Browse area, so as to keep a global view of all the GraphSet Definitions in the 

Browse area while displaying the properties of one of them in the Edit area.
• custom GraphSet Definitions only

They are displayed as a list.
Custom GraphSet Definitions are the GraphSet Definitions not provided with HOPEX.

Accessing all the GraphSet Definitions
You can access the tree of all (provided and custom) GraphSet Definitions.

To access the GraphSet Definitions:
1. Connect to HOPEX Report Studio desktop.

 See Logging in to HOPEX Report Studio Desktop.
2. From the navigation menus, click Report Definitions > Data Source definitions.

 Click Report Definitions > Data Source Definitions  to display the tree in the 
Browse area.
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3. Display the GraphSet Definition page.
The tree displays all the GraphSet Definitions (custom and provided with HOPEX).

4. (If needed) Use the Search field to access a specific GraphSet Definition.
 Click the GraphSet Definition, to display its properties.

Accessing the custom GraphSet Definitions
Custom GraphSet Definitions are the GraphSet Definitions not provided with HOPEX.

You can access the list of:
• all the Custom GraphSet Definitions
• only your Custom GraphSet Definitions

To access custom GraphSet Definitions displayed as a tree, see Accessing all the GraphSet
Definitions.

To access the custom GraphSet Definitions:
1. Connect to HOPEX Report Studio desktop.

 See Logging in to HOPEX Report Studio Desktop.



99

GraphSet Definition
GraphSet Definition Creation

2. In the Home page, My Scope part, to display:
• your custom GraphSet Definitions only: in My Work, click My GraphSet Definitions 

indicator 
• all custom GraphSet Definitions: in Customizations, click Custom GraphSet 

Definitions indicator 
The corresponding list of custom GraphSet Definitions displays.

3. (If needed) Use the list filtering tool to access a specific custom GraphSet Definition.
 Click the custom GraphSet Definition, to display its properties.

Displaying the GraphSet Definition properties
To display the GraphSet Definition properties:

1. Access the GraphSet Definitions.
 See Accessing the GraphSet Definitions.

2. Click the GraphSet Definition name.
The GraphSet Definition properties display.

Displaying the GraphSubSet properties
To display the GraphSubSet properties:

1. Access the GraphSet Definitions displayed as a tree.
 See Accessing all the GraphSet Definitions.
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2. Expand the GraphSet Definition concerned and its GraphSubSet folder.
The GraphSubSet included in the GraphSet Definition available are accessible.

3. Click the GraphSubSet concerned.

 Hover the cursor over the name and click Open in a new tab  to open the 
properties in a new tab.

The GraphSubSet properties are displayed.

Displaying the GraphSet arc/node properties
To display the GraphSet arc/node properties:

1. Access the GraphSubSet concerned displayed as a tree.
 See Displaying the GraphSubSet properties.



101

GraphSet Definition
GraphSet Definition Creation

2. Expand the GraphSet Node Definition folder.

3. Click the node  concerned.
Its properties are displayed.

 Hover the cursor over the node and click Open in a new tab  to open its 
properties in a new tab.
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4. Expand a node with a  to access its arc(s).

5. Click the arc  concerned.
Its properties are displayed.

 Hover the cursor over the arc and click Open in a new tab  to open its properties 
in a new tab.

Creating a GraphSet Definition
A GraphSet Definition is MetaClass-specific. 
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The GraphSet Definition is based either on:
• an object or an object collection (an occurrence or a set of occurrences of the source 

MetaClass) 
The GraphSet Definition creation consists in connecting a source MetaClass (concrete
or abstract) to the GraphSet Definition.

• a query (a set of occurrences)
The GraphSet Definition creation consists in defining the query that collects the entry
points.
If needed, you can create a query parameter for this purpose.

Creating an object collection-based GraphSet Definition
When you create a GraphSet Definition based on an object or an object collection, you need to
define a Source MetaClass. 

In that case the following items are automatically created:
• a Graphset Entry Point Collection (collection type parameter) of the same type as the 

source MetaClass.
• a GraphSubSet with the same name as the GraphSet Definition

The GraphSubSet definition is automatically initialized with a node with the same
MetaClass as the source MetaClass. This node is defined as entry point and its name is
the MetaClass name.

To create a GraphSet Definition based on an object:
1. Access the custom GraphSet Definitions.

 See Accessing the custom GraphSet Definitions.

2. In the list menu bar, click New .

 If you accessed all the GraphSet Definitions displayed as a tree, click New .
The Creation of GraphSet Definition window appears

3. In the Name field, enter your GraphSet Definition name.
 By default the GraphSet Definition name is: GraphSet Definition-x (x is a number).
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4. Define the Root section:
• In the Collection is populated by field keep "Collection Parameter".
• In the MetaClass field, click the arrow and in the drop-down menu select the 

MetaClass you want to define as the source MetaClass of your GraphSet Definition.
 In the field, enter the first letters of the MetaClass for a quick access.

Example: Application.

5. Click OK.
The selected MetaClass is defined as your GraphSet Definition source MetaClass.
Your GraphSet Definition is created and added to the GraphSet Definition list. 

6. In the list, click your GraphSet Definition name.
Its properties display.

7. In the Characteristics page, in the Collection Parameters section a Collection type 
parameter of the same type as the source MetaClass is automatically created with value 
"N" as multiplicity.

Example: with "Application" as source MetaClass, the Collection Type is 
"Application" MetaClass.

If you do not want a collection of objects but a single object only as entry point, in the
Collection Multiplicity field, select "1".
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8. In the _GUIName field, enter a name. 
Example: "List of applications to extract".

This parameter is displayed in the GraphSet Definition Preview page. 
 See Previewing the GraphSet.

You may need to add other entry point collections.
 See Adding an entry point collection to the GraphSet Definition.
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9. In your GraphSet Definition properties, display its Definition page.
The GraphSubSet:
• is automatically created with the same name as your GraphSet Definition
• already includes a Node, defined as entry point 

Example: with "Application" as source MetaClass, the "Application" node 
is created.

10. Define the GraphSubSet (its nodes and arcs and their fields).
 See Defining the Data that Feeds the GraphSubSet.

Creating a query-based GraphSet Definition
When you create a GraphSet Definition based on a query, you need to define:

• its root MetaClass
• its populating query based on the root MetaClass selected
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In the GraphSet Definition you can also define parameters that are used in any query used in the
GraphSet Definition.

 See Defining query parameters.

To create a query-based GraphSet Definition:
1. Access the custom GraphSet Definitions.

 See Accessing the custom GraphSet Definitions.

2. In the list menu bar, click New .

 If you accessed all the GraphSet Definitions displayed as a tree, click New .
The Creation of GraphSet Definition window appears

3. In the Name field, enter your GraphSet Definition name.
Example: "Appli from Portfolio"

 By default the GraphSet Definition name is: GraphSet Definition-x (x is a number).
4. In the Root section:

• In the Collection is populated by field, select "Query".
The Populating Query field appears.
• In the MetaClass field, click the arrow and in the drop-down menu select the 

MetaClass you want to define as the root MetaClass of your GraphSet Definition.
 In the field, enter the first letters of the MetaClass for a quick access.

Example: Application.
• In the Populating Query field, use the drop-down menu to select the query used to 

collect the entry point.
 Only the root MetaClass related queries are available.

Example: "APM - Get Applications of a Portfolio".
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5. Click OK.
You report GraphSet Definition is created and added to the GraphSet Definition list. 
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6. In your GraphSet Definition properties, display its Characteristics page:
• The Root Population Queries section displays the query used to populate the 

GraphSet.
• The Property Parameters section displays the Property Parameter automatically 

created when used in the populating query.
Eg.: here Portfolio.
Macro code: "APM - Get Applications of a Porfolio"
Select Application Where Initiative.Owner Portfolio = &Portfolio Or 
Deployed Object:Software Installation.Initiative.Owner Portfolio = 
&Portfolio
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7. In your GraphSet Definition properties, display its Definition page.
The GraphSubSet:
• is automatically created with the same name as the GraphSet Definition
• already includes a Node, defined as entry point

Example: with "Application" as source MetaClass, the node "Application" 
is created.

8. Define the GraphSubSet (its nodes and arcs and their fields).
 See Defining the Data that Feeds the GraphSubSet.

9. Display the GraphSet Definition Preview page and test the report. 
 See Previewing the GraphSet.
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Adding GraphSet Definition Entry Points
In the GraphSet Definition properties, the Characteristics page enables to:

• define how to collect the GraphSet entry points, via:
• collections
• queries

• create parameters that you can use in any query used in the GraphSet Definition (for 
example in GraphSet Definition entry point queries or in GraphSet Arc Definition 
queries).

Adding an entry point collection to the GraphSet Definition
By default, an entry point collection is made up by a collection of objects (Multiplicity value is "N").
If needed, you can define the entry point collection as a single object (Multiplicity value is "1").

GraphSet Definitions with source MetaClass defined include by default an entry point collection
based on the source MetaClass. 
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You may need to add entry point collection(s) to your GraphSet Definition (whether object-based
or query-based).

At GraphSet creation the user is asked to enter the entry point Collection values, which are taken
into account to build the GraphSet.

To feed the GraphSet Definition with an entry point collection:
1. Access the GraphSet Definition properties.

 See Accessing the GraphSet Definitions.

2. In its Characteristics page > Collection Parameters section, click New .
 You can add as many entry point collections as needed.

The Meta Collection Parameter creation window is displayed. 
3. (Optional) In the Local name field, enter a name for the collection parameter.
4. In Collection Type field, select the entry point type.

Example: Software Technology MetaClass.
5. (If you want to define the entry point as a unique object) In its Collection Multiplicity 

drop-down list, select "1".
6. In the _GUIName field, enter a name. 

Example: Technologies to extract.
This parameter is displayed in the GraphSet Definition Preview page. 

 See Previewing the GraphSet.
7. Click OK.

The entry point collection is added to the Collection Parameters list.

Example:
You can add the "Technologies to extract" Collection Parameter with the 
"Software technology" Collection Type, so that at GraphSet creation the 
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user is asked to select the Technologies to feed the GraphSet with this 
collection.

Adding an entry point query to the GraphSet Definition
Your query is already created. If needed, you can create query parameters.

To connect a query to a GraphSet Definition:
1. Access the GraphSet Definition properties.

 See Accessing the GraphSet Definitions.
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2. In its Characteristics page, Root Populating Queries section click:

• Connect  to connect an existing query.

Example: connect the "ITPM - My applications" query to filter the 
Application collection to the applications owned by the end-user only.

• New  to create a query.

Example: to filter the Technologies whose Support Alert has the value 
"Unsupported Usage"
Select [Software Technology] WHERE [Support Alert] = "U"

 You can add as many queries as needed.

Defining query parameters
In your GraphSet Definition, you can create and define Query Parameters that you can use in any
query used in the GraphSet Definition.

Examples: 
- in GraphSet Definition entry point queries, see Creating a query-based 
GraphSet Definition.
- in GraphSet Arc Definition queries, see Defining the arcs of a node.

At GraphSet creation the user is asked to enter the parameter values, which are taken into account
in the query (for example to retrieve the entry points to build the GraphSet). 

If no query parameters is specified the GraphSet operates on the entire repository occurrences. 

To add query parameter in the GraphSet Definition:
1. Access the GraphSet Definition properties.

 See Displaying the GraphSet Definition properties.
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2. In its Characteristics page, Property Parameter section, click New . 
 You can add as many parameters as needed.

3. In the Meta Property Parameter creation window:
• enter a Local name (name displayed in the GraphSet)

Example: Begin date
• define the values for MetaAttribute Type, MetaAttribute Length and 

MetaAttribute Format, and Parameter Name (name used in the query)
Example: MetaAttribute type "DateTime", MetaAttribute Format "Duration", 
Parameter Name "BeginDate

 For detailed information regarding MetaAttribute characteristics, see HOPEX Studio > 
Customizing the Metamodel : Managing the Metamodel : MetaAttributes : MetaAttribute 
Characteristics documentattion.

4. Click OK.
The property parameter is added in the Property Parameters list.
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Example: 
When you add "Begin Date" and "End Date" Property Parameters, at GraphSet 
creation the user is asked to enter both dates, which filter the GraphSet 
result according to these dates.

Adding a GraphSubSet to a GraphSet Definition
With object-based GraphSet Definitions a GraphSubSet is automatically created (you still need to
define it). You may need to add one or several GraphSubSets to the GraphSet Definition.

A GraphSubSet can be reused in GraphSet Definitions, so that you can:
• reuse an existing GraphSubSet
• add a new GraphSubSet
• remove a GraphSubSet

Reusing a GraphSubSet in a GraphSet Definition
With object-based GraphSet Definitions a GraphSubSet is automatically created. you may need to
add one or several GraphSubSets to the GraphSet Definition.

To add an existing GraphSubSet to your GraphSet Definition:
1. Access the GraphSet Definition properties.

 See Displaying the GraphSet Definition properties.
2. Display its Definition page.

3. In the GraphSubSet field, click the right-oriented arrow and select Connect .
4. Use the Connecting window to select the GraphSubSet. 

 You can select as many GraphSubSets as needed.
5. Click Connect.

The GraphSubSet is added to the GraphSet Definition.

Adding a new GraphSubSet to a GraphSet Definition
To add a new GraphSubSet to a GraphSet Definition:

1. Access the GraphSet Definition properties.
 See Displaying the GraphSet Definition properties.
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2. Display its Definition page.
3. In the GraphSubSet field, click the right-oriented arrow and select New  to create a 

GraphSubSet.
4. Enter a Name to the GraphSubSet.
5. Click OK.

The GraphSubSet is added to the GraphSet Definition.
6. Define the GraphSubSet.

 See Defining the Data that Feeds the GraphSubSet.

Removing a GraphSubSet from a GraphSet Definition
To remove a GraphSubSet from a GraphSet Definition:

1. Access the GraphSet Definitions (displayed as a tree).
 See Accessing all the GraphSet Definitions.

2. Expand the GraphSet Definition concerned.
3. Expand the GraphSubSet folder.
4. Hover the cursor over the GraphSubSet you want to remove from the GraphSet 

Definition and click Remove .
A confirmation dialog box prompts you to confirm your choice to remove the GraphSubSet
from the GraphSet Definition. 

 if you want to delete the GraphSubSet from the HOPEX repository, select Delete and 
confirm your choice in the next dialog box.

5. Click Remove.
The GraphSubSet is removed from the GraphSet Definition, but still available in the
HOPEX repository.

Defining the Data that Feeds the GraphSubSet
The GraphSet Definition is made up of at least one GraphSubSet. You have to define how to
populate each of these GraphSubSets. 

A GraphSubSet is made up of nodes, for each of which you can define arcs and/or paths.
 See GraphSubSet.

According to your needs, you can also add fields on:
• nodes 
• arcs
• nodes of paths (intermediate nodes)

By default, these fields are hidden in the GraphSet, but displayed as tooltips when the end-user
hover the cursor over each of them.

 See Adding Fields to Nodes/Arcs and Adding Fields to Intermediate Nodes.

A GraphSubSet can be reused in any other GraphSet Definition.



118

2

Defining the nodes of the GraphSubSet
The GraphSubSet must include at least one node.

 See the node definition, section Node.

For each of the nodes, you must define:
• its name
• the MetaClass on which it is based
• whether it Can be an entry point or not

A Node that can be an entry point is discovered from parameters or queries. The Can be
an entry point parameter enables to instantiate nodes that are not discovered from
another one.

To define the nodes of the GraphSubSet:
1. Access the GraphSet Definition properties.

 See Displaying the GraphSet Definition properties.
2. Display its Definition page.
3. In the GraphSubSet drop-down list, select the GraphSubSet you want to define.
4. In the Nodes of the GraphSubSet section, click New .
5. In the Local name field, enter a name for the node.

Example: Vendor
6. In the Node MetaClass drop-down list, select the MetaClass (concrete or abstract) on 

which is based the node.
Example: Org-Unit

7. (If you want these nodes to be used as entry points in the GraphSet) Select Can be an 
entry point.

 By default the node is not an entry point.
8. Click OK.
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9. (If needed) Repeat steps 4 to 8 to add other nodes.
For example, the "Application Technologies" GraphSubSet includes:
- the "Application" node based on the Application MetaClass
- the "Technology" node based on the Software Technology MetaClass
- the "Vendor" node based on the Org-Unit MetaClass. 
Only the Application and Technology nodes are defined as entry point.

Defining the arcs of a node
In the GraphSubSet, you must define at least one arc (or path, see Defining the paths) for one of
the nodes, otherwise the GraphSet corresponding layer would display nodes only.

 See the arc definition, section Arc.

An arc links two nodes, which can be from:
• different sources

Example: an arc can link the technologies used by an application.
• similar source

Example: an arc can link the applications that are connected via a 
message flow.

The arc provider can be based on:
• a MetaAssociationEnd, or
• a query
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The arc is defined through the following attributes:
• Behavior to define the propagation behavior:

• Deep (default): the opposite node is added in the graph and the exploration goes on.
• Standard: the opposite node is added in the graph but the exploration stops.
• Link: the arc is added only if the opposite node exists in the graph.
• Computed: the propagation is managed through a macro and can take "Deep", 

"Standard", or "Link" values.
 For information regarding Behavior values, see Propagation.

• Condition enables to consider an arc when it starts from an entry point node only or 
not. 

By defaut: "No condition".
To define the arcs of a node:

1. Access the GraphSet Definition properties.
 See Displaying the GraphSet Definition properties.

2. Display its Definition page.
3. In the GraphSubSet drop-down list, select the GraphSubSet concerned.

 Else directly access the GraphSubSet properties, see Displaying the GraphSubSet 
properties.

4. In the Nodes of the GraphSubSet list, select the row of the node from which you want 
to define the arcs.

5. In the Arcs of the node pane, click New .
6. In the Local Name field, enter a name 

The Node From field is already defined with the node selected.
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7. In the Node To field, use the drop-down list to select the node at the opposite side of 
the arc.

 The drop-down list lists the nodes included in the Nodes of the GraphSubSet 
section.
 Node From and Node to can be of different or similar source.

8. Click Next.
9. (If your arc provider is query-based) Select Query.

By default the arc provider is based on a MetaAssociationEnd. 
10. Depending on the arc provider:

• in the MetaAssociationEnd drop-down list, select the MetaAssociationEnd that 
provides the arc.

• in the Query drop-down list, select the query that provides the arc.
11. Click Next.
12. Define the arc attributes:

• Behavior
By defaut: "Deep".

• Condition
By defaut: "No condition".

13. Click OK.
The defined arc is added in the Arcs of the node section.
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Defining the paths
In the GraphSubSet, you must define at least one path (or arc, see Defining the arcs of a node)
between two nodes, otherwise the GraphSet corresponding layer would display nodes only.

 See the path definition, section Path.

A path links two nodes through arcs and intermediate nodes.

The path definition includes the following phases:
• Phase 1

Definition of its extremity nodes.
• Phase 2

Definition of its intermediate nodes.
• Phase 3

Definition of each arc, which is part of the path, starting from the starting node of the path
to the opposite node of the path.

For example:
1: Definition of Arc 1, starting from Node A to Intermediate Node 1. 
2: Definition of Arc 2, from Intermediate Node 1 to Intermediate Node 2. 
3: Definition of Arc 3, from Intermediate Node 2 to Node B.

Each arc provider can be based on:
• a MetaAssociationEnd, or
• a query

• Phase 4: Definition of the fields on the intermediate nodes of the path.

To define the paths:
1. Access the GraphSet Definition properties.

 See Displaying the GraphSet Definition properties.
2. Display its Paths page.



123

GraphSet Definition
GraphSet Definition Creation

3. In the GraphSubSet drop-down list, select the GraphSubSet concerned.
 Else directly access the GraphSubSet properties, see Displaying the GraphSubSet 
properties.

4. In the Paths list, click Add .
The GraphSet Path creation wizard: Path Definition appears.
• In the Name field, enter the name of your path.

For example: Path_ReceivedFlows.
• In the Path From field, use the drop-down list to select the node from which you 

want to start the path.
 The drop-down list lists the nodes included in the Nodes of the GraphSubSet 
section.

• In the Path To field, use the drop-down list to select the node at the opposite end of 
the path.

 The drop-down list lists the nodes included in the Nodes of the GraphSubSet 
section.
 Path From and Path to can be of different or similar source.

• In the GraphSet Path Intermediate Nodes, click Add Node  as many times as 
you need intermediate nodes in your path.

Intermediate nodes are created with default names.
For example, if you click twice: "InterNode1" and "InternNode2".

• (Optional) In the Name fields, modify the intermediate node default names.
• For each intermediate node, click its Node MetaClass field and use the drop-down 

list to select its object type.

• (If needed) Modify the intermediate node order: click Reorganize  and drag and 
drop the intermediate nodes to get the order required. 

 Else you can use the Alphabetical order.
5. Click Next.

The first arc definition window is displayed, with both of its two nodes already entered
according to the intermediate node order you previously defined.

6. In the Name field, enter the first arc name.
7. (If your arc provider is query-based) Select Query.

By default the arc provider is based on a MetaAssociationEnd. 
8. Depending on the arc provider:

• in the MetaAssociationEnd drop-down list, select the MetaAssociationEnd that 
provides the arc.

• in the Query drop-down list, select the query that provides the arc.
9. Click Next.

The second arc definition window is displayed, with its two nodes.
10. Define the second arc (and the next ones if any) as above:

• its Name
• its arc provider.
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11. Click OK.
The full path is created. In the Paths page, for the selected path:
• the Ordered Intermediate Nodes list displays the intermediate nodes of the path
• the Arcs list details the arcs building the path. 

 Once created you can no longer modify the path (neither ts intermediate 
nodes nor its arcs).

In the GraphSet Definition (Definition page), the path is added in the Arcs of the node
and Is Path attribute is selected.

 If you need to modify the path definition, see Modifying a path definition.
12. According to your needs, add fields on intermediate nodes.

 See Adding Fields to Intermediate Nodes.

Modifying a path definition
Once the path is created, you may want to add an intermediate node or change the node order of
the path. 

To modify the path definition:
1. Access the GraphSet Definition properties.

 See Displaying the GraphSet Definition properties.
2. Display its Paths page.

3. In the Paths list, select the path and click Edit .
4. Use the wizard to modify the path according to your need.

Adding Fields to Nodes/Arcs
A node can carry fields, which are:

• based on values:
• MetaAttributes 
• TaggedValues
• Legattributes

• computed with a macro
• an object

These fields are displayed on the node, but can be hidden.

Field access

By default, the field is provided by the source object (Access section: "Direct").

You may want to provide the field by a MetaAssociationEnd of the source object (Access section:
"MetaAssociationEnd").

Adding value-based fields to a node
To add a value-based field to a node:

1. Access the GraphSet Definition properties.
 See Displaying the GraphSet Definition properties.
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2. Display its Definition page.
3. In the GraphSubSet drop-down list, select the GraphSubSet concerned.

 Else directly access the GraphSubSet properties, see Displaying the GraphSubSet 
properties.

4. In the Nodes of the GraphSubSet list, select the node for which you want to define a 
field.

E.g.: Application.
5. In the Fields of the node list, click New .

The Creation of GraphSet Field Definition windows is displayed.
6. In the Local name field, modify the default name.
7. (For a field from a MetaAssociationEnd) In the Access section:

• in Access type: select "MetaAssociationEnd"
• in MetaAssociationEnd: select the MetaAssociationEnd concerned

8. In the Configuration section, define the value type:
By default the value is based on a MetaAttribute. 
If your value is TaggedValue-based, select taggedValue.

9. Depending on the value type:
• in the MetaAttribute drop-down list, select the MetaAttribute you want to be 

displayed in the field.
• in the TaggedValue field, click the right oriented arrow and connect the TaggedValue 

you want to be displayed in the field.
10. Click OK.

Adding macro-based fields to a node
Prerequisite: 

For each macro-based field you have to create its implementing macro. This macro is based on the
GetAttributeValue function:

GetAttributeValue(Object as MegaOject,AttributeID as Variant,Value As String)

Where:
Object is the object of which the attribute value is requested.
AttributeID is the absolute identifier of the attribute.
Value is the attribute value returned by the function, concerning this object.

 See examples of macro-based field on intermediate nodes: 
Example 1: graph based on the "Flows Between Agents" GraphSet Definition
Example 2: graph based on the "Flows arround Agent" GraphSet Definition
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To add a macro-based field to a node:
1. Access the GraphSet Definition properties.

 See Displaying the GraphSet Definition properties.
2. Display its Definition page.
3. In the GraphSubSet drop-down list, select the GraphSubSet concerned.

 Else directly access the GraphSubSet properties, see Displaying the GraphSubSet 
properties.

4. In the Nodes of the GraphSubSet list, select the node for which you want to define a 
field.

5. In the Fields of the node list, click New .
The Creation of GraphSet Field Definition windows is displayed.

6. In the Local name field, modify the default name.
7. (For a field from a MetaAssociationEnd) In the Access section:

• in Access type: select "MetaAssociationEnd"
• in MetaAssociationEnd: select the MetaAssociationEnd concerned

8. In the Configuration section:
• In Property type field: select "Computed"
• In the Implementation field, click the right-oriented arrow and connect the macro 

that enables to compute the field value.
Define the MetaAttribute characteristics:
• Length
• Type (default value "String)
• Format (default value "Standard)

9. Click OK.

Adding object-based fields to a node
In case of "MetaAssociationEnd" Access type, you might want to add the object itself.

To add an object-based field to a node:
1. Access the GraphSet Definition properties.

 See Displaying the GraphSet Definition properties.
2. Display its Definition page.
3. In the GraphSubSet drop-down list, select the GraphSubSet concerned.

 Else directly access the GraphSubSet properties, see Displaying the GraphSubSet 
properties.

4. In the Nodes of the GraphSubSet list, select the node for which you want to define a 
field.

5. In the Fields of the node list, click New .
The Creation of GraphSet Field Definition windows is displayed.

6. In the Local name field, modify the default name.
7. In the Access section:

• in Access type: select "MetaAssociationEnd"
• in MetaAssociationEnd: select the MetaAssociationEnd concerned

8. In the Configuration section:
• in Object property type: select "Object"
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Adding Fields to Intermediate Nodes
As a node, an intermediate node can also carry fields, which are either:

• based on values from the corresponding HOPEX object:
• MetaAttributes 
• TaggedValues
• Legattributes, or

• computed with a macro

These fields are displayed on the intermediate nodes, but can be hidden.

Adding value-based fields to an intermediate node
To add a value-based field on an intermediate node:

1. Access the GraphSet Definition properties.
 See Displaying the GraphSet Definition properties.

2. Display its Path page.
3. In the GraphSubSet drop-down list, select the GraphSubSet concerned.

 Else directly access the GraphSubSet properties, see Displaying the GraphSubSet 
properties.

4. In the Path list, select the row of the path that includes the intermediate node.
5. In the Ordered Intermediate Nodes list, select the intermediate node for which you 

want to define a field.
6. In the Fields pane, click New .

The Creation of GraphSet Field Definition windows is displayed.
7. In the Local name field, modify the default name.
8. In the Field Definition Type drop-down list, select "Value".
9. Define the value type:

By default the value is based on a MetaAttribute. 
If your value is TaggedValue-based, select taggedValue.

10. Depending on the value type:
• in the MetaAttribute drop-down list, select the MetaAttribute you want to be 

displayed in the field.
• in the TaggedValue field, click the right-oriented arrow and connect the TaggedValue 

you want to be displayed in the field.
11. Click OK.
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Adding macro-based fields to an intermediate node
Prerequisite: 

For each macro-based field you have to create its implementing macro. This macro is based on the
GetAttributeValue function:

GetAttributeValue(Object as MegaOject,AttributeID as Variant,Value As String)

Where:
Object is the object of which the attribute value is requested.
AttributeID is the absolute identifier of the attribute.
Value is the attribute value returned by the function, concerning this object.

Example: the "Calculated - Flow Content.Implementation" macro computes 
the "Content" field for application flows.

See examples: 
• Example 1: graph based on the "Flows Between Agents" GraphSet Definition.
• Example 2: graph based on the "Flows arround Agent" GraphSet Definition.

To add a macro-based field on a node:
1. Display its Path page.
2. In the GraphSubSet drop-down list, select the GraphSubSet concerned.

 Else directly access the GraphSubSet properties, see Displaying the GraphSubSet 
properties.

3. In the Path list, select the row of the path that includes the intermediate node.
4. In the Ordered Intermediate Nodes list, select the intermediate node for which you 

want to define a field.
5. In the Fields listContent, click New .

The Creation of GraphSet Field Definition windows is displayed.
• In the Local name field, modify the default name.
• In the Field Definition Type drop-down list, select "Computed".
• In the Implementation field, click the right-oriented arrow and connect the macro 

that computes the field value.
The implementing macro is based on the GetAttributeValue function.

Example: the "SCalculated - Flow Content.Implementation" macro computes 
the "Content" field for application flows.

6. Define the MetaAttribute characteristics:
• (optional) MetaAttribute Length
• MetaAttribute Type (default value "String)

Example: "MegaIdentifier"
• MetaAttribute Format (default value "Standard)

Example: "Object"
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7. Click OK.
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Example 1: graph based on the "Flows Between Agents" GraphSet Definition

In the "Flow Between Agents" graph, two fields are added to the Flow intermediate node:
• "Content" 
• "Flow Communication System"

The macros used to implement the "Content" and "Communuication System" fields are:
• the "Calculated - Flow Content.Implementation" macro

• the "Computed - Flow Communication System.Implementation" macro

In the corresponding graph, the "Content" and "Scenario" fields can be displayed on each Flow
intermediate node.
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Example 2: graph based on the "Flows arround Agent" GraphSet Definition

In the "Flows around Agent" graph, two fields ("scenario" and "content") are added to intermediate
nodes of both "received flows" and "sent flows" paths between agents:

• The "Scenario Flow - Get Content" macro computes the values for the "Content" fields 
from the "Conveyed Work Product" collection.

With "~ycuIb8buOn)E[Conveyed Work Product]".
• The "Scenario Flow - Get Scenario" macro computes the values for the "scenario" fields 

from the "Flow owner" collection.

With "~ZxFFA75BPHV5[Flow Owner]".
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The graph displays both "Content" and "Scenario" fields for each received/sent flow:

Previewing the GraphSet
From the GraphSet Definition properties you can test the GraphSet.

To preview the GraphSet:
1. Access the GraphSet Definition properties.

 See Accessing the GraphSet Definitions.
2. Display its Preview page.
3. Click Create Preview.

 Once the preview has been generated once, you do not need to click Create 
Preview anymore. The GraphSet is automatically generated and displayed.
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4. (If needed) In the Parameters section, define the parameters:
• (if query parameters are used) enter the parameter values

 See Defining query parameters.

• (if object collection-based GraphSet Definition) in the source MetaClass, click 
Connect  and connect the MetaClass item(s) required.

5. In the Parameters section title, click  to collapse the section.
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6. Click Apply Parameters.
The GraphSet displays the nodes and arcs.

 Objects from a Data Reading access not accessible to the user are not displayed.
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7. You can customize the preview display for a better visibility:
• (GraphSet Definition including several GraphSubSets) Above the graph, click Layers, 

and clear layers to keep a single layer selected.

• Double-click a node to display only this node, its arcs and opposite nodes.
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• Bellow the graph, click Options  to:
- reduce/increase the space between the nodes
- reduce the label length
- hide nodes without links
- ungroup all arcs
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• In the Find an object field, enter characters to greyed all of the other nodes.

For example, enter "air": "Airlines Check-in" and "AirportMega.Com" 
applications are highlighted (all of the other nodes are grayed out)
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• Use the mouse wheel to zoom in (/out) the graph.
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Saving the Graph Report
From the Preview page of the GraphSet Definition, you can save the graph as:

• a Report Template
• a Report Data View, to use it in a Report Template

 Note that Save as Report, generates a public report and also a private Report 
Template, which you can access in Private Report Template > My Report Templates 
folder.

Creating a graph-type Report Template
To create a Report Template from a graph report:

1. Access the GraphSet Definition properties.
 See Accessing the GraphSet Definitions.

2. Display its Preview page.

3. In the graph, click More  > Save As Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

4. In the Name field, enter your Report Template name.
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5. Click OK.
A public Report Template is created, with its public Report Graph View. They both have
the same name.
You can access the Report Template:
• (list view) directly from your Home page, from My Report Templates indicator.

 It is also available via Custom Report Templates indicator.

• (tree view) from My Report Templates folder (Report Definitions > Report 
Templates).

Creating a Report Graph View
To create a Report Graph View:

1. Access the GraphSet Definition properties.
 See Accessing the GraphSet Definitions.

2. Display its Preview page.

3. In the graph, click More  > Save as View .
4. Enter a Name to the view.
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5. Click OK.
The Report Graph View is created and accessible in the Report Definitions > Report
Templates page, Report Data Views > Public Data View > GraphSet Definition
folder.

Any HOPEX user can add the View to a report:
• use the View to create a Report Template

 See Creating a Report Template using a Report Data View.

• add the View as a report Chapter in a Report Template
 See Adding a Report Chapter to a Report Template.
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TREESET DEFINITION

The following points are covered here:

 Introduction to TreeSet Definition
 TreeSet Definition Creation
 Defining the Data that Feeds the TreeSet Definition
 Handling a TreeSet
 How to
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INTRODUCTION TO TREESET DEFINITION

 TreeSet Definition is only available with HOPEX Power Studio technical module.

A TreeSet Definition creation is performed in HOPEX (Web Front-End) for users with HOPEX
Customizer or HOPEX Customizer Publisher profile.

Creation and use of TreeSets are available in HOPEX (Web Front-End) for all users.

Once a Report Template is created from a TreeSet Definition, any user of a Solution can use it
to query HOPEX repository and create tree reports.
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TreeSet Definition and TreeSet Principle

TreeSet Definition
A TreeSet Definition enables to create tree reports as follows:

• Phase 1: Extraction of a set of HOPEX data.
This extraction consists in defining a root node (a single occurrence or a set of
occurrences), from which the repository is browsed to retrieve a set of HOPEX data that
will constitute the TreeSet.

• Phase 2: Display of this set of HOPEX data as a tree (Breakdown, Dendrogram, 
TreeMap, and TreeTable).

• Phase 3: Creation of tree reports from this display.

This data extraction constitutes the TreeSet data, with no style specification.

From this TreeSet you can generate Instant Reports (Breakdown, Dendrogram, TreeMap, and
TreeTable).
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TreeSet Definition structure
The TreeSet Definition defines how to build a hierarchical set of data. 

The hierarchy is built from TreeSet Collections, which define how the repository is browsed.
Additional data can be added to the structure thanks to TreeSet Properties.

The TreeSet Definition structure includes a root node , which holds the root TreeSet
Collection  with as many children as needed:

• TreeSet Properties 
• TreeSet Collections  with:

• TreeSet Properties 
• TreeSet Collections 

Example: 
The "Application" TreeSet Definition structure is based on "5-star Appli-
Root" root TreeSet Collection  with the "Technologies used" TreeSet 
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Collections  child and with "Application Type" and "Cost" ("Global expense" 
MetaAttribute) TreeSet Properties.

The "Technologies used" TreeSet Collections  has four children:
- the "Risks" and "Vendor" TreeSet Collections

 See Adding a TreeSet Collection to a TreeSet Definition.
- the "End of support" and "Techno code" TreeSet Properties

 See Adding TreeSet Properties to a TreeSet Collection.

Root node
The Root node  is a node visible in the tree display only when the structure includes several
entry objects.
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TreeSet Collection 
A TreeSet Collection is MetaClass-specific. It allows to define a collection of child objects computed
from its parent.

The TreeSet Collection children of the root node are the entry points of the structure.

A TreeSet Collection  can carry TreeSet Properties  based on MetaAttributes, TaggedValues,
LegAttributes from the corresponding HOPEX object, or computed with a macro.

TreeSet 
A TreeSet is an instance of a TreeSet Definition, which defines all parameter values necessary to
generate the tree data structure.

A TreeSet is made up of nodes that are linked together as branch of the tree.

In the TreeSet Definition properties, the Preview page shows the TreeSet displayed as a
TreeTable.

 Click Display in full page  for better readability. 
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Instant Reports
From the TreeSet you can launch Instant Reports, customize them and save them to create tree-
type Report templates and Report Tree Views.

You can launch the following Instant Report types:
• Breakdown
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• Dendrogram
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• Treemap
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• TreeTable

Creating and Defining a TreeSet Definition: the Big Picture
To create and define a TreeSet Definition:

1. Define the root TreeSet Collection, i.e. the TreeSet entry points.
The TreeSet entry point can be:
• an object, 
• an object collection,
• a query

 See Creating a TreeSet Definition.
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2. Define the TreeSet Collections that constitute the TreeSet.
 See Adding a TreeSet Collection to a TreeSet Definition.

3. (optional) Add a loop to a TreeSet Collection.
 See Defining a TreeSet Collection.

4. (Optional) Add TreeSet Properties to a TreeSet Collection.
 See Adding TreeSet Properties to a TreeSet Collection.

5. Preview the TreeSet.
 See Previewing the TreeSet.

6. From the TreeSet, generate Instant Reports of type:
• Breakdown
• Dendrogram
• TreeMap
• TreeTable

 See Generating Instant Reports from a TreeSet.
7. Customize the Instant Report and perfom:

• a Save as Report to create a tree report and get its Report Template.
 See Creating a tree-type Report Template.

• a Save as View to create a Report Tree View.
 See Creating a Report Tree View.

8. Customize the tree report.

TreeSet Definition Best Practices
When you create a TreeSet Definition you should follow the best practices.

Define a TreeSet Definition to create focused TreeSets, i.e.:
• The TreeSet should answer a single issue.

For examples: a report, an export of specific data.
• Do not build TreeSets with huge amount of data that you would use for different 

purposes.

A TreeSet size is limited to:
• 50.000 nodes 
• 50 properties

 These limits are defined in the following options (Options > Tools > 
Documentation > Reports):
Fix the limit for TreeSet Nodes
Fix the limit for TreeSet properties

A "TreeSet volume alert" warning is generated when a TreeSet exceeds these recommended limits.
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Supervising TreeSet Events
In the HOPEX Supervision console, you can check the TreeSet-specific events (e.g.: "TreeSet
Generate" informative event):

• Node Count indicates the number of nodes of the TreeSet.
• Internal Node Count Limit indicates the recommended maximum number of nodes in 

the TreeSet.
• Property Count indicates the number of nodes of the TreeSet.
• Internal Node Count Limit indicates the recommended maximum number of nodes in 

the TreeSet.

For detailed information regarding TreeSet related supervision events, see HOPEX Administration
> Technical Articles > Supervision Event Description > ReportDataSet, TreeSet, and
GraphSet.
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TREESET DEFINITION CREATION

The TreeSet Definition creation includes:
• Accessing the TreeSet Definitions
• Creating a TreeSet Definition

Accessing the TreeSet Definitions
You can access:

• all (provided and custom) TreeSet Definitions 
They are displayed as a tree.
You can display them in:
• the Edit area, especially to work with a specific TreeSet Definition
• the Browse area, so as to keep a global view of all the TreeSet Definitions in the 

Browse area while displaying the properties of one of them in the Edit area.
• custom GraphSet Definitions only

They are displayed as a list.
Custom TreeSet Definitions are the TreeSet Definitions not provided with HOPEX.

Accessing all the TreeSet Definitions
You can access the tree of all (provided and custom) TreeSet Definitions.

To access the TreeSet Definitions:
1. Connect to HOPEX Report Studio desktop.

 See Logging in to HOPEX Report Studio Desktop.
2. From the navigation menus, click Report Definitions > Data Source definitions.

 Click Report Definitions > Data Source Definitions  to display the tree in the 
Browse area.
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3. Display the TreeSet Definition page.
The tree displays all the TreeSet Definitions (custom and provided with HOPEX).

4. (If needed) Use the Search field to access a specific TreeSet Definition.
 Click the TreeSet Definition, to display its properties.

Accessing the custom TreeSet Definitions
Custom TreeSet Definitions are the TreeSet Definitions not provided with HOPEX.

You can access the list of:
• all the Custom TreeSet Definitions
• only your Custom TreeSet Definitions

To access custom TreeSet Definitions displayed as a tree, see Accessing all the TreeSet Definitions.



157

TreeSet Definition
TreeSet Definition Creation

To access the custom TreeSet Definitions:
1. Connect to HOPEX Report Studio desktop.

 See Logging in to HOPEX Report Studio Desktop.
2. In the Home page, My Scope part, to display:

• your custom TreeSet Definitions only: in My Work, click My TreeSet Definitions 
indicator 

• all custom TreeSet Definitions: in Customizations, click Custom TreeSet 
Definitions indicator 

The corresponding list of custom TreeSet Definitions displays.

3. (If needed) Use the list filtering tool to access a specific custom TreeSet Definition.
 Click the custom TreeSet Definition, to display its properties.

Displaying the TreeSet Definition properties
To display the TreeSet Definition properties:

1. Access the TreeSet Definitions.
 See Accessing the TreeSet Definitions.
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2. Click the TreeSet Definition name.
The TreeSet Definition properties display.

Creating a TreeSet Definition
A TreeSet Definition is MetaClass-specific. 

The TreeSet Definition is based either on:
• a collection parameter (an occurrence or a set of occurrences of the source MetaClass) 

The TreeSet Definition creation consists in defining the root MetaClass (concrete or
abstract) of the TreeSet Definition.

• a query (a set of occurrences)
The TreeSet Definition creation consists in defining the root MetaClass and a query that
collects the entry points.
In that case, you might need to use Property Parameters.

The TreeSet Definition Structure  includes a root TreeSet Collection  with as many items
as needed:

• TreeSet Properties 
• TreeSet Collections  with:

• TreeSet Properties 
• TreeSet Collections 

Creating a Collection Parameter - based TreeSet Definition
When you create a TreeSet Definition based on a Collection Parameter, you need to define its root
MetaClass. 

To create a TreeSet Definition based on a Collection Parameter:
1. Access the custom TreeSet Definitions list.

 See Accessing the custom TreeSet Definitions.

2. In the list menu bar, click New .

 If you accessed all the TreeSet Definitions displayed as a tree, click New .
The Creation of TreeSet Definition window appears

3. In the Name field, enter your TreeSet Definition name.
 By default the TreeSet Definition name is: TreeSet Definition-x (x is a number).

Example: Org-Unit Organization.
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4. Define the Root section:
• In the Collection is populated by field keep "Collection Parameter".
• In the MetaClass field, click the arrow and in the drop-down menu select the 

MetaClass you want to define as the root MetaClass of your TreeSet Definition.
 In the field, enter the first letters of the MetaClass for a quick access.

Example: Org-Unit.

5. Click OK.
The selected MetaClass is defined as your TreeSet Definition root MetaClass.
Your TreeSet Definition is created and added to the customTreeSet Definition list. 

6. In the list, click your TreeSet Definition name.
Its properties display.
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7. Its Characteristics page shows:
• the Root MetaClass
• the Collection Parameter characteristics. 

For example, with "Org-Unit" as root MetaClass, the Collection parameter 
characteristics are:
- Type: "Org-Unit" MetaClass
- Multiplicity: "1" (default), i.e. the root TreeSet Collection is 
populated by a single object
- MetaCollectionParameter Populating collection: "Org-Unit 
Organisation_root", i.e. this Collection parameter populates the root 
node of the "Org-Unit Organization" TreeSet Definition.



161

TreeSet Definition
TreeSet Definition Creation

8. (If needed) In the _GUIName field, enter a GUI name for the Collection Parameter. 
This parameter is displayed in the TreeSet Definition Preview page. 
If you do not define a GUI name, the local name is used.

 See Previewing the TreeSet.
Example: _GUIName: Org-Unit.

9. (If you want to collect several objects) In the Multiplicity field, select "N".
In that case, at TreeSet creation the user can enter several objects (Entry Point Collection
values), which are taken into account to build the TreeSet.

Example: _GUIName: Org-Units, and Multiplicity: N.

 For an example, see How to Add Several Objects to the Root Collection.
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10. In your TreeSet Definition properties, display its Definition page.
• the left pane displays the TreeSet Definition structure with its root TreeSetCollection
• the right pane displays the properties of the element selected in the left pane

Example: The "Org-Unit Organization" TreeSet Definition is created and 
includes its root node.
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11. Define the TreeSet Definition structure:
• you can add TreeSet Collections  

Example: you can add the "Org-Unit Component" TreeSet Collection
In the Collection Provider section: 
Collection is populated by: "MetaAssociationEnd" 
Target MetaClass: "Org-Unit"
Populating MetaAssociationEnd: "Component".

 See Adding a TreeSet Collection to a TreeSet Definition.
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• you can add a grouping criterion on a TreeSet Collection

Example: you can add a grouping criterion on the "Org-Unit Component" 
TreeSet Collection, in the Grouping Criterion section: 
Group by: "MetaAttribute", Grouping Criterion: "Org-Unit Type"

 See Adding automatic folders to a TreeSet Collection.

• you can add a loop on a TreeSet Collection

Example: you can add a loop on the "Org-Unit Component" TreeSet 
Collection, in the Recursive Definition section: 
TreeSet Collection loop: "Org-Unit Component" with a Maximum loop depth 
of "3".

 See Adding a loop to a TreeSet Collection.

• you can add TreeSet Properties  

Example: you can add two TreeSet Properties to the "Org-Unit Component" 
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TreeSet Collection: two MetaAttribute values of the Org-Unit Component.
 See Adding TreeSet Properties to a TreeSet Collection.

12. Display the TreeSet Definition Preview page and test the report. 
The TreeSet is displayed as a TreeTable. It shows its first three levels expanded, with
objects in rows and corresponding Properties in columns.

 See Previewing the TreeSet.

Creating a query-based TreeSet Definition
When you create a TreeSet Definition based on a query, you need to define:

• its root MetaClass
• its populating query, which is based on the root MetaClass selected

You can use a provided query or create your own query.
For example you can create a query that retrieves all the Applications 
with "5 stars" ranking, get their Software Technologies, and for each 
Technology its Vendor and risks.

To create a query-based TreeSet Definition:
1. Access the custom TreeSet Definition list.

 See Accessing the custom TreeSet Definitions.

2. In the list menu bar, click New .

 If you accessed all the TreeSet Definitions displayed as a tree, click New .
The Creation of TreeSet Definition window appears

3. In the Name field, enter your TreeSet Definition name.
 By default the TreeSet Definition name is: TreeSet Definition-x (x is a number).

Example: 5-star Appli.
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4. In the Root section, in the Collection is populated by field, select "Query".
The Populating Query field appears.

5. In the MetaClass field, use the drop-down list to select the MetaClass you want to 
define as the root MetaClass of your TreeSet Definition.

 In the field, enter the first letters of the MetaClass for a quick access.

Example: Application.
6. In the Populating Query field use the drop-down list to select the query used to collect 

the entry point.
 Only the root MetaClass related queries are available. You can also create your own 
query. 

Example: "Get 5 star Applications".

7. Click OK.
The selected MetaClass is defined as your TreeSet Definition root MetaClass.
Your TreeSet Definition is created and added to the custom TreeSet Definition list. 
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8. In your TreeSet Definition properties, display its Characteristics page.
It displays the Root MetaClass, and how to populate the TreeSet:
The Root Population Queries section displays the query used to populate the TreeSet.
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9. In your TreeSet Definition properties, display its Definition page.
• the left pane displays the TreeSet Definition structure with its root TreeSetCollection
• the right pane displays the properties of the element selected in the left pane

Example: The "5-star Appli" TreeSet Definition is created and includes 
its root node.
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10. Define the TreeSet Definition structure:
• you can add TreeSet Collections  

 See Adding a TreeSet Collection to a TreeSet Definition.
Example: you can add the "Software Technology" TreeSet Collection.
Local Name: Technologies used
In the Collection Provider section: 
Collection is populated by: "MetaAssociationEnd" 
Target MetaClass: "Software Technology"
Populating MetaAssociationEnd: "Supporting Software Technology"

Example: from "Technologies used", you can add the "Risk" and "Vendor" 
TreeSet Collections. 
In the Collection Provider section: 
Collection is populated by: "MetaAssociationEnd" 
Target MetaClass: "Risk" and "Org-Unit"
Populating MetaAssociationEnd: "Risk" and "Vendor"
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• you can add a loop to a TreeSet Collection
 See Adding a loop to a TreeSet Collection.

• you can add TreeSet Properties  
 See Adding TreeSet Properties to a TreeSet Collection.

Example: you can add: 
- one TreeSet Property to the "Technologies used" TreeSet Collection: the 
"End of support" MetaAttribute value of the Technology. 
- two TreeSet Properties to the "5* applications_Root" TreeSet 
Collection: the "Application Type" and "Cost" MetaAttribute values of the 
Application.
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11. Display the TreeSet Definition Preview page and test the report. 
The TreeSet is displayed as a TreeTable. It shows its first three levels expanded, with
objects in rows and corresponding Properties in columns.

 Note that folders (if any) count for levels two. 
Exemple: the TreeSet includes all of the applications with a 5-star 
ranking, and for each application its Software Technologies and their 
corresponding property values. 

 See Previewing the TreeSet.
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12. Click the arrow next to each Object to hide (/display) a level.
Example: Vendors and Risks are hidden.

13. Click Instant Report to create your Tree type report as a:
• Breakdown
• Dendrogram
• TreeMap
• TreeTable
With the same TreeSet, you can create Tree reports of each type.

 See Displaying a Breakdown, a Dendrogram, a TreeMap, or a TreeTable.
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Creating property parameters
In your TreeSet Definition, you can create and define Property Parameters that you can use in
any query used in the TreeSet Definition.

At TreeSet creation the user is asked to enter the parameter values, which are taken into account
in the query. 

To add a property parameter to the TreeSet Definition:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display the Characteristics page.
3. In the Property Parameters list, click New . 

 You can add as many parameters as needed.
4. In the Meta Property Parameter creation window:

• enter a Local Name (name displayed in the TreeSet)

Example: Begin date
• (according to your needs) modify the default values for MetaAttribute type 

("String"), MetaAttribute Length and MetaAttribute Format ("Standard")
 For detailed information regarding MetaAttribute characteristics, see HOPEX Studio > 
Customizing the Metamodel : Managing the Metamodel : MetaAttributes : MetaAttribute 
Characteristics documentattion.
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5. Click OK.
The property parameter is added to the Property Parameters list.

6. In the Query Parameter Name field, enter a name for the parameter. This name is the 
one used in the query.

Example: 
When you add "Begin Date" and "End Date" Query Parameters, at TreeSet 
creation the user is asked to enter both dates, which filter the TreeSet 
result according to the these dates.
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DEFINING THE DATA THAT FEEDS THE TREESET DEFINITION

See:
• Introduction to TreeSet Definition Properties
• Adding a TreeSet Collection to a TreeSet Definition
• Removing a TreeSet Collection from a TreeSet Definition
• Defining a TreeSet Collection
• Adding TreeSet Properties to a TreeSet Collection
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Introduction to TreeSet Definition Properties

Characteristics page
In the TreeSet Definition properties, the Characteristics page sums up the entry points used in the
TreeSet Definition:

• the root MetaClass 

Example: Application
• how data is collected, via:

• a collection, or

Example: Application collection
• a query

• it enables to create property parameters that you can use in queries

Definition page
In the TreeSet Definition properties, the Definition page displays the structure of the TreeSet
Definition.
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At creation it displays:
• the root TreeSet node (folder)
• the root TreeSet Collection



179

TreeSet Definition
Defining the Data that Feeds the TreeSet Definition

It enables to:
• configure the root TreeSet Collection

 See Defining a TreeSet Collection.

• add TreeSet Collections
 See Adding a TreeSet Collection to a TreeSet Definition.

• configure each TreeSet Collection
• add TreeSet properties to the TreeSet Collection
• hide the TreeSet Collection itself
• hide its nodes with no child
• (recursive hierarchy) add a loop on the TreeSet collection 

 See Defining a TreeSet Collection.

• add TreeSet Properties
 See Adding TreeSet Properties to a TreeSet Collection.

Adding a TreeSet Collection to a TreeSet Definition
At creation a TreeSet Definition includes a single TreeSet Collection: the root TreeSet Collection. You
may need to add one or several TreeSet Collections to the TreeSet Definition structure.
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To add a TreeSet Collection you must define:
• where you want to add the TreeSet Collection in the TreeSet Definition structure
• how you want to populate the TreeSet Collection:

• a parameter
• a MetaAssociationEnd
• a query
• a TreeSet Collection reference

Adding a TreeSet Collection populated by a MetaAssociationEnd
To add a TreeSet Collection populated by a MetaAssociationEnd:

1. Access the TreeSet Definition properties.
 See Accessing the TreeSet Definitions.

2. Display its Definition page.
3. In the TreeSet Definition, hover the cursor over the TreeSet Collection (or the root) 

under which you want to add a TreeSet Collection, and click New  > TreeSet 
Collection.

4. Enter a Name to the TreeSet Collection.
5. In the Collection is populated by drop-down list, keep "MetaAssociationEnd".
6. In the Target MetaClass drop-down list, select the MetaClass corresponding to the 

Collection you want to add.
7. In the Populating MetaAssociationEnd drop-down list, select the MetaAssociationEnd.

 The list includes the available MetaAssociationEnds only, i.e. the 
MetaAssociationEnds of the parent TreeSet Collection.

8. Click OK.
The TreeSet Collection is added to the TreeSet Definition under the parent TreeSet
Collection.

9. (If needed) Define the TreeSet Collection.
 See Defining a TreeSet Collection.

Adding a TreeSet Collection populated by a query
You can use a provided query or create your own query.

To add a TreeSet Collection populated by a query:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
3. In the TreeSet Definition, hover the cursor over the TreeSet Collection (or the root) 

under which you want to add a TreeSet Collection, and click New  > TreeSet 
Collection.

4. Enter a a Name to the TreeSet Collection.
5. In the Collection is populated by drop-down list, select "Query".
6. In the Target MetaClass drop-down list, select the MetaClass corresponding to the 

Collection you want to add.
7. In the Populating Query drop-down list, select the query.

 The list includes only the queries related to the parent TreeSet Collection.

 Else click New Query to create a query.
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8. Click OK.
The TreeSet Collection is added to the TreeSet Definition under the parent TreeSet
Collection.

9. (If needed) Define the TreeSet Collection.
 See Defining a TreeSet Collection.

Adding a TreeSet Collection populated by a parameter
To add a TreeSet Collection populated by a parameter:

1. Access the TreeSet Definition properties.
 See Accessing the TreeSet Definitions.

2. Display its Definition page.
3. In the TreeSet Definition, hover the cursor over the TreeSet Collection (or the root) 

under which you want to add a TreeSet Collection, and click New  > TreeSet 
Collection.

4. Enter a Name to the TreeSet Collection.
5. In the Collection is populated by drop-down list, select "Parameter".

The Populating Parameter field is displayed and includes the list of available
parameters only, i.e. the parameters related to the parent TreeSet Collection.

6. In the Populating Parameter drop-down list, select the parameter (which is a 
Collection Parameter).

7. Click OK.
The TreeSet Collection is added to the TreeSet Definition under the parent TreeSet
Collection.

8. (If needed) Define the TreeSet Collection.
 See Defining a TreeSet Collection.

Adding a TreeSet Collection reusing part of the definition
You can add a TreeSet Collection which reuses a TreeSet Collection as a reference. 

This Referenced TreeSet Collection can be either:
• a parent TreeSet Collection, or 
• a same level TreeSet Collection
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When adding a referenced TreeSet Collection:
• it automatically adds the TreeSet Collection and its children (properties and/or TreeSet 

Collections). Thus, you do not need to describe this part of the definition again.

• you can feed it with the same collection provider or overload it.
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To add a TreeSet Collection reference:
1. Access the TreeSet Definition.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
3. In the TreeSet Definition, hover the cursor over the TreeSet Collection (or the root) 

under which you want to add the TreeSet Collection reference, and click New  > 
TreeSet Collection Reference.

4. In the Identification section, Referenced TreeSet Collection field, select the 
referenced TreeSet Collection.

5. In the Collection Provider section, set its settings as described in the above sections 
(collection populated by a parameter, a MetaAssociationEnd, or a query).

6. Click OK.

Removing a TreeSet Collection from a TreeSet Definition
When you remove a TreeSet Collection from a TreeSet Definition, you also remove all its child
TreeSet Collections and TreeSet Properties.

You can choose to remove the TreeSet Collection from the TreeSet Definition only or delete it from
HOPEX repository.
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To remove a TreeSet Collection from a TreeSet Definition:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
3. In the TreeSet Definition structure, hover the cursor over the TreeSet Collection you 

want to remove and click Remove .
A confirmation dialog box prompts you to confirm your choice to remove the TreeSet
Collection from its TreeSet Collection parent only or delete it from HOPEX repository. 

 if you want to delete the TreeSet Collection from the HOPEX repository, select 
Delete and confirm your choice in the next window.

4. Click Remove.
The TreeSet Collection is removed from the TreeSet Definition, but still available in the
HOPEX repository.

Defining a TreeSet Collection
By default a TreeSet Collection is displayed in the tree, and all of its nodes are visible. If needed,
you can hide:

• the entire TreeSet Collection
This is useful for example to define tree items that are used as filters but do not need to
appear in the tree display.

• the nodes of the TreeSet Collection that do not have any child

You can add folders to a TreeSet Collection:
• automatically
• manually

You can define a TreeSet Collection with a loop, which enables to add a recursive definition. 

Hiding a TreeSet Collection
 See example How to Hide a TreeSet Collection.

To hide a TreeSet Collection:
1. Access the TreeSet Definition.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
3. Select the TreeSet Collection you want to hide.
4. In the right pane set Visible parameter to "No. 

Hiding nodes with no child
By default, any node of the collection is displayed, even if a node has no child. You can hide nodes
with no child.

To hide the node with no child of a TreeSet Collection:
1. Access the TreeSet Definition.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
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3. Select the TreeSet Collection for which you want to hide nodes with no child.
4. In the right pane set Must have a child parameter to "Yes". 

Adding automatic folders to a TreeSet Collection
You can add automatic folders to a TreeSet Collection. In that case you cannot change the name of
the folders as when manually adding folders.

These folders are created by adding a grouping criterion on a TreeSet Collection. 

You can group by: 
• Object Type
• a MetaAttribute value
• a MetaAssociationEnd, or
• a Query

To add a folder to a TreeSet Collection:
1. Access the TreeSet Definition.

 See Accessing the TreeSet Definitions.
2. Select the TreeSet Collection concerned by the grouping.
3. In the right pane, in the Grouping Criterion section define the grouping: 

• in Group by, select the grouping type
• if you selected "MetaAttribute", "MetaAssociationEnd" or "Query", select the 

Grouping Criterion

Adding folders to a TreeSet Collection
You can add a folder to a TreeSet Collection. You can add the folder as you create the Definition or
once the Definition is created.

 See example How to Add a Folder to a TreeSet Definition.

To add a folder to a TreeSet Collection:
1. Access the TreeSet Definition.

 See Accessing the TreeSet Definitions.
2. Hover the cursor over the TreeSet Collection under which you want to add a folder and 

click New  > TreeSet Collection.
3. Define the folder.

In its Identification section:
• Name: enter the name of the folder
• Is folder: yes

4. (If needed) Drag and drop the required TreeSet Collection(s) in the folder.

Adding a loop to a TreeSet Collection
With a recursive hierarchy, you can add a collection loop to the TreeSet Collections.

To add a loop to a TreeSet Collection:
1. Access the TreeSet Definition.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
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3. Select the TreeSet Collection for which you want to add a loop.
4. In the right pane, in the Recursive Definition section define the loop:

• in the TreeSet Collection loop field, select the "<TreeSet Collection name>".
• (optional) in the Maximum loop depth enter the number of levels you want to add. 

Adding TreeSet Properties to a TreeSet Collection
According to your needs, you can add TreeSet Properties to TreeSet Collections (even to the root
one).

These properties are displayed in the TreeTable renderer only, and can be hidden if needed.
 Properties are not visible in Breakdown type reports.

The TreeSet Property can be:
• a value

• MetaAttribute value
• abstract property value

• a count
• MetaAssociationEnd
• query

• a computation (with a macro) 
• an object

TreeSet Property access

By default, the TreeSet property is provided by the source object (Access section: "Direct"). 

You may want to provide the property by a MetaAssociationEnd of the source object (Access
section: "MetaAssociationEnd"). 

Adding a value-based property to a TreeSet Collection
You can add value-based properties to a TreeSet Collection.

To add a value-based property to a TreeSet Collection:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
3. Expand the TreeSet Definition structure.

4. Hover the cursor over the TreeSet Collection concerned and click New  > TreeSet 
Property.
The Creation of TreeSet Property windows is displayed.

5. In the Name field, modify the default name.
In the Configuration section, configure the property.

6. In the Property Type drop-down list:
• keep "Value (MetaAttribute)", to base the value on a MetaAttribute, or
• select "Value (Abstract Property)" to base the value on an Abstract Property.
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7. Depending on the value type:
• in the MetaAttribute drop-down list, select the MetaAttribute you want to display in 

the property.
• in the TreeSet Abstract Property field, select the Abstract Property you want to 

display in the property.
 Else click the right oriented arrow and connect the Abstract Property.

8. Click OK.

Adding a count-based property to a TreeSet Collection
You can add count-based properties to a TreeSet Collection. 

The property is collected locally for the TreeSet, with the count retrieved from a query or a
MetaAssociationEnd. 

To add a count-based property to a TreeSet Collection:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
3. Expand the TreeSet Definition structure.

4. Hover the cursor over the TreeSet Collection concerned and click New  > TreeSet 
Property.
The Creation of TreeSet Property windows is displayed.

5. In the Name field, modify the default name.
In the Configuration section, configure the property.

6. In the Property Type drop-down list, select the count type:
• "count (MetaAssociationEnd)", or
• "count (Query)".

7. In the:
• Counted MetaAssociationEnd field, select the MetaAssociationEnd in the list, or
• Counted Query field, select the query in the list.

Adding a macro-based property to a TreeSet Collection
You can add computed properties to a TreeSet Collection. The property is computed locally, with a
macro, for the TreeSet. 

Prerequisite: 

For each macro-based property you have to create its implementing macro. This macro is based on
the GetAttributeValue function:

GetAttributeValue(Object as MegaOject,AttributeID as Variant,Value As String)

Where:
Object is the object of which the attribute value is requested.
AttributeID is the absolute identifier of the attribute.
Value is the attribute value returned by the function, concerning this object.

To add a macro-based property to a TreeSet Collection:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
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2. Display its Definition page.
3. Expand the TreeSet Definition structure.

4. Hover the cursor over the TreeSet Collection concerned and click New  > TreeSet 
Property.
The Creation of TreeSet Property windows is displayed.

5. In the Name field, modify the default name.
In the Configuration section, configure the property.

6. In the Property Type drop-down list, select "Computed".
7. Define the MetaAttribute characteristics:

• MetaAttribute Type (default value "String)
• MetaAttribute Length
• MetaAttribute Format (default value "Standard)

 For detailed information regarding MetaAttribute characteristics, see HOPEX Studio > 
Customizing the Metamodel : Managing the Metamodel : MetaAttributes : MetaAttribute 
Characteristics documentattion.

8. In the Implementation field, click the right-oriented arrow and connect the macro that 
enables to compute the field value.

9. Click OK.

Adding an object-based property to a TreeSet Collection
In case of "MetaAssociationEnd" Access type, you might want to add the object itself.

To add an object-based property to a TreeSet Collection:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
3. Expand the TreeSet Definition structure.
4. Right-click the TreeSet Collection concerned and select New > TreeSet Property.

The Creation of TreeSet Property windows is displayed.
5. In the Local name field, modify the default name.
6. Expand the Access section, and select:

• in Access type: select "MetaAssociationEnd"
• in MetaAssociationEnd: select the MetaAssociationEnd concerned

7. In the Configuration section, select:
• Object property type: Object
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HANDLING A TREESET

See:
• Previewing the TreeSet
• Generating Instant Reports from a TreeSet
• Saving the Tree Report

Previewing the TreeSet
From the TreeSet Definition properties you can test the TreeSet.

For example, you can test the Org-Unit Organization TreeSet Definition.

To preview the TreeSet:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. In its Preview page, click Create Preview.
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3. (If needed) In the Parameters section, define the parameters:
• (if collection parameter-based TreeSet Definition) in the <Collection Parameter 

GUIName> list/field, click Connect and connect the MetaClass items required.
Example: in the Org-Units list, which is the Collection Parameter 
GUIName, connect Org-Units.

• (if property parameters are used) enter the parameter values. 
 See Creating property parameters.

4. (To get more space for the report) In the Parameters section title, click  to collapse 
the section.
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5. Click Apply Parameters.
The TreeSet is displayed as a TreeTable renderer type. 
Three levels of the tree are expanded by default. 
The display is limited to 50 nodes by default (clear Limit the data to 50 nodes to display
more data).

Ex.: this TreeSet is based on the "Finance Department" and 
"Accountability Department” Org-Units and displays for each Org-Unit 
child its Company Standard and Internal/External values.
Org-Unit children are grouped by type in the corresponding Org-Unit Type 
folder.
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6. In the Report TreeSet section, click Instant Report to create instant report of the 
following types:
• Breakdown 
• Dendrogram
• TreeTable
• TreeMap

Generating Instant Reports from a TreeSet
From the Preview page of the TreeSet Definition, you can generate instant reports of the following
renderer types:

• Breakdown 
• Dendrogram
• TreeTable
• TreeMap

Objects from a Data Reading access not accessible to the user are not displayed in the report.

The Instant report is generated with a Configuration pane, which enables to modify the report
configuration.

Breakdown
With the Breakdown type report, properties (when defined) are not displayed.

To generate a breakdown type report:
1. Access the TreeSet Definition.
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2. From its Preview page, click Instant Report and select Breakdown.
By default, at opening, the breakdown map displays:
• a maximum of three levels of Components
• no items

E.g.: this Breakdown map is based on five applications, which all have a 
ranking of 5 stars. For each of them, its Technologies are displayed.
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3. To configure the default display, in the Configuration pane, you can:
• modify the number of displayed levels at opening: in the Nb of levels at opening, 

select the required number.
• display items: select Selected check box for each corresponding item you want to 

display in the breakdown report.
E.g.: select "Risk" and "Vendor".

• Click Apply.
All selected items and corresponding filters are added to the report.
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4. To handle the breakdown map display:
• In the Object Types field, use the drop-down arrow to select the items you want to 

hide/display.
• In the Levels field, select the required displayed level.

• Click Show Filters  and select the columns you want to display (by default all of 
them are displayed)

 For each columns its number of items is indicated (e.g.: "Availability" Application 
includes 11 Software Technologies).

E.g.: select Availability, e-mail Application, and Instant Messaging.

Other columns are automatically hidden.
E.g.: Documentation Repository and Relationship Sailing are hidden.
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5. Save the Breakdown map to create a Report Template or a Tree View.
 See Saving the Tree Report.

Dendrogram
With the Dendrogram type report, properties (when defined) are displayed on object in a pop-up
window.
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To create a Dendrogram type report:
1. Access the TreeSet Definition.

E.g.: this TreeSet Definition is based on an Org-Unit and displays for 
each Org-Unit child its Company Standard and Internal/External values.

2. From its Preview page, click Instant Report and select Dendrogram.
By default, the dendrogram displays three levels.
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3. To view the Properties (if any): hover the cursor over a node.
Example: hover the cursor over "Financial Controler", its "Company 
Standard" and "Internal/External" values are displayed in a pop-up 
window.

4. In the Configuration section, you can modify the display:
• Modify the number of expanded levels at opening: in the Nb of levels at opening, 

select the required number.
• Reorganize the property order in the pop-up window: click Reorganize, and drag and 

drop the properties so as to get another display order, and click OK.
• Click Apply and Refresh  the report.

5. To handle the dendrogram:
• Click a node to hide its daughter branches.

Example: click "Manager" component, its three daughter branches are 
hidden.

• Below the graph, click Options  to:
- reduce/increase the space between the nodes
- reduce the label length
• Use the mouse wheel to zoom in (/out) the graphic.

6. Save the Dendrogram to create a Report Template or a Tree View.
 See Saving the Tree Report.

TreeMap
With the TreeMap type report, properties (when defined) are displayed on object in a pop-up
window.
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To create a TreeMap type report:
1. Access the TreeSet Definition.
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2. From its Preview page, click Instant Report and select TreeMap.
By default, the TreeMap displays only one level at opening.

E.g.: this TreeMap is based on five applications, which all have a 
ranking of 5 stars.

3. To view the Properties (if any): hover the cursor over a box.
Its properties are displayed in a pop-up window.

Example: hover the cursor over "Documentation Repository" Application, 
its "Cost" and "Application Type" values are displayed in a pop-up 
window.
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4. To configure the default display, in the Configuration pane, you can modify:
• the number of levels displayed at opening: in the Nb of levels at opening, select the 

required number.
• the Properties displayed: clear the Selected check box corresponding to the 

property you do not want to display in the TreeMap.
• Click Apply.
Your modifications are directly taken into account.
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5. To handle the TreeTable, above the TreeTable:
• modify the Number of displayed levels
• modify the Display criterion (when available)

For example, display the applications according to their "number of 
components".
- with 1 displayed level (so that Applications are displayed).

- with 2 displayed levels (so that their technologies are displayed).
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- with 3 displayed levels (so that the Vendors are displayed).
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6. Save the TreeMap to create a Report Template or a Tree View.
 See Saving the Tree Report.

TreeTable
With the TreeTable type report, properties (when defined) define the Column headers of the table.
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To create a TreeTable type report:
1. Access the TreeSet Definition.

Ex. 1: this TreeSet Definition is based on an Org-Unit and displays for 
each Org-Unit child its Company Standard and Internal/External values.

Ex. 2: this TreeSet Definition is based on the Applications that have a 
5-star ranking, and displays for each of them its Technologies, and for 
each of its Technologies its Vendor and Risks. 
It also displays Properties: "Application Type" and "Cost" values of each 
application, and "Techno Code" and "End of support" date of each 
technology.
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2. From its Preview page, click Instant Report and select TreeTable.
By default, the TreeTable displays three levels.
It displays the objects in rows and the properties in columns.
E.g. 1: this TreeSet is based on the Finance Department Org-Unit.
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3. To configure the default display, in the Configuration pane, you can modify:
• the number of levels displayed at opening: in the Nb of levels at opening, select the 

required number.
• the Properties displayed: clear the Selected check box corresponding to the 

property you do not want to display in the TreeTable.
• Click Apply.
Your modifications are directly taken into account.

E.g. 2: this TreeSet is based on several applications, which all have a 
ranking of 5 stars. The Nb of displayed level at opening is set to 2 and 
the "Cost" property is hidden.

4. Save the TreeTable to create a Report Template or a Tree View.
 See Saving the Tree Report.

Saving the Tree Report
From the Preview page of the TreeSet Definition, you can save the tree as:

• a Report Template
• a Report Data View, to use it in a Report Template

 Note that Save as Report, generates a public report and also a private Report 
Template, which you can access in Private Report Template > My Report Templates 
folder.
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You can save only one tree report at a time:
• a breakdown
• a dendrogram
• a Treemap
• a TreeTable

Creating a tree-type Report Template
To create a Report Template from a tree report:

1. Access the TreeSet Definition properties.
 See Accessing the TreeSet Definitions.

2. In its Preview page, click Instant Report.
3. Select the renderer type you want to save.

E.g.: Breakdown, Dendrogram, TreeMap, or TreeTable.

4. In the graphic, click More  > Save As Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

5. In the Name field, enter your Report Template name.
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6. Click OK.
A public Report Template is created, with its public Report Tree View. They both have
the same name.
You can access the Report Template:
• directly from your Home page, from Custom Report Templates tile, or
• from My report Templates folder (Report Studio > Report Template Definition 

> Report Templates)
• from the Public Report Template folder (Report Studio > Report Template 

Definition > Report Templates)

Creating a Report Tree View
You can save each renderer type of your TreeSet as a Report Tree View.

To create a Report Tree View:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Preview page.
3. In its Preview page, click Instant Report.
4. Select the renderer type you want to save.

5. In the graphic, click More  > Save as View .
6. Enter a Name to the view.
7. Click OK.

The Report Tree View is created and accessible in the Report Definitions > Report
Templates page: in the Report Data Views > Public Data Views > TreeSet
Definition folder.
Any HOPEX user can add the View to a report:
• use the View to create a Report Template

 See Creating a Report Template using a Report Data View.

• add the View as a report Chapter in a Report Template
 See Adding a Report Chapter to a Report Template.
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HOW TO

See:
• How to Hide a TreeSet Collection
• How to Automatically Add Folders to a TreeSet Definition (grouping)
• How to Add a Folder to a TreeSet Definition
• How to Reorganize Folders or Collections in a TreeSet Definition
• How to Define a Loop in a TreeSet Definition
• How to Define a Loop in a TreeSet Definition without Duplicating the Collection 

Declaration
• How to Add Several Objects to the Root Collection
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How to Hide a TreeSet Collection
You may want to hide a TreeSet Collection from your TreeSet.

Example: 
The TreeSet Definition displays the Technologies used by an application, and for each
Technology it displays its Vendor and its risks (if any).
You want to hide the "Risk" items of the Technologies.

To hide a TreeSet Collection in the TreeSet:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
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3. In the TreeSet Definition structure, select the TreeSet Collection you want to hide.
Example: "Risks"

4. In the right pane, in the Visible field, select "No".
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5. Display the TreeSet Definition Preview page.
Risks are hidden.
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6. From the TreeSet, generate an Instant Report.
Ex: Dendrogram type Instant Report.

The TreeSet Collection concerned is hidden.
Example: "Risk" values of the Technologies are hidden.

 In case your modification was not taken into account, click Refresh .

How to Automatically Add Folders to a TreeSet Definition 
(grouping)
Instead of manually adding folders (see How to Add a Folder to a TreeSet Definition), in some cases
you can add a grouping criterion on a TreeSet Collection. This grouping automatically adds the
folders in the TreeSet.
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Example: Grouping the Org-Units in folders according to their type" 

The TreeSet Definition based on:
• Root MetaClass: Org-Unit
• Root TreeSet Collection: collection populated by the "Org-Unit" parameter
• added TreeSet Collection: "Org-Unit Component"
• added Properties: Company Standard, Internal/External, and Org-Unit Type of the Org-

Units

Instead of showing the Org-Unit Type values in a TreeSet column, you can group the Org-Unit
according to their type. 

To group the Org-Unit according to their type in folders:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
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2. Display its Definition page.

3. In the TreeSet Definition structure, select the "Org-Unit Component" TreeSet Collection. 
4. In its Grouping Criterion section, select:

• Group by "MetaAttribute"
• Grouping Criterion "Org-Unit Type"

5. In this case, you can remove the Org-unit Type property from the Org-Unit Component 
TreeSet Collection: 
in the TreeSet definition structure, right-click Org-unit Type TreeSet Property and select
Remove.
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6. Display the TreeSet Definition Preview page.
Org-Units are now grouped in folders according to their type (e.g.: Structure, Function,
Manager).
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How to Add a Folder to a TreeSet Definition
You can add folders to a TreeSet Definition. A folder is added after a TreeSet Collection.

 Check if you can use the automatic way instead, see How to Automatically Add 
Folders to a TreeSet Definition (grouping)
 See also How to Reorganize Folders or Collections in a TreeSet Definition

Example: Adding "Risks and Vendors" folder after each Technology

The TreeSet Definition based on:
• MetaClass Root: Application
• Root TreeSet Collection: collection populated by the "Application" parameter
• added TreeSet Collections: "Technology" and its "Risk" and "Vendor" 
• added Properties: Creation date and Code of the Technologies, and Cost of the 

Application.

To add after each Technology a folder that includes the its risks and its Vendor:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
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2. Display its Definition page.

3. In the TreeSet Definition structure, right-click the "Technologies" TreeSet Collection. and 
select New > TreeSet Collection.
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4. Define the folder:
• Local name: enter "Risks and Vendor"
• Is folder: "yes"
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5. Drag and drop the "Risks" and "Vendor" TreeSet Collections into the "Risks and Vendor" 
folder.

6. From the Preview page, generate a Dendrogram type Instant Report.
Your folder is added after each Technology and includes its Risks and Vendor.

 With the added folder, you might want to add one more level at opening.

7. (If you want to hide the added folder) In the TreeSet Definition, select the folder and in 
the right pane set Visible to "No".
The folder is hidden.
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How to Reorganize Folders or Collections in a TreeSet Definition
In a TreeSet Definition, you can modify the display order of TreeSet Collections and/or folders, so
as to get another display in the report showing a Dendrogram, TreeMap, Breakdown, or TreeTable. 

Example: Displaying Risks folder above Applications folder in a dendrogram

To reorganize folders or Collections:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
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2. Display its Definition page.

3. In the TreeSet Definition structure, right-click the TreeSet Collection (or folder) 
concerned and select Reorganize.

E.g.: Assessed Process TreeSet Collection.



225

TreeSet Definition
How to

4. Drag and drop the TreeSet Collection (or folder) so as to get another display order, and 
click OK.

How to Define a Loop in a TreeSet Definition
When a hierarchy is recursive, you can define a collection loop on any TreeSet Collection of the
TreeSet Definition.
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Example: Defining a loop on "Org-Unit Component" TreeSet Collection

The TreeSet Definition based on:
• MetaClass Root: Org-Unit
• Root TreeSet Collection: collection populated by the "Org-Unit" parameter
• added TreeSet Collection: "Org-Unit Component" collection populated by the "Org-Unit" 

Target MetaClass, "Component" Populating MetaAssociationEnd
For example, the "Finance Department" Org-Unit has seven children.

You can define a loop on the "Org-Unit Component" TreeSet Collection.

To define a loop on the TreeSet Collection:
1. Access the TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Definition page.
3. In the TreeSet Definition structure, select the "Org-Unit Component" TreeSet Collection.
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4. In the Recursive Definition section, define the loop:
• In the TreeSet Collection loop, select "Org-Unit Component" TreeSet Collection.
• In the Maximum loop depth, enter "3" (the depth represents the number of 

displayed levels)
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5. Display the Preview page, and click Apply Parameters.
Now two levels of Org-Unit components are added to the "Finance 
department".

How to Define a Loop in a TreeSet Definition without Duplicating 
the Collection Declaration
In a TreeSet collection you can use the Recursive Definition section to reference another
collection as a child.

Example: 

In the "ITBPM - Value Stream Definition" TreeSet Definition, the "Referenced Value Stage"
Collection defines how to find a set of  "Value Stream" via the "Called value stream"
MetaAssociationEnd. 
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Each value stream is used as a parent of the "Owned Value Stage" collection.

How to Add Several Objects to the Root Collection
If your TreeSet Definition is based on a Collection Parameter, at TreeSet Definition creation, the root
Collection parameter is made up by a collection of objects with a Multiplicity value set to "1" by
default. This means that at TreeSet creation the user can add a single object only. 

 Be careful in adding too many objects as TreeSet entry points, as the TreeSet might 
be two crowded
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If you still want the user to be able to add several objects as entry points at TreeSet creation:
• set the root Collection parameter multiplicity to "N"
• else create a TreeSet Definition based on a Query Parameter, with a query collecting 

several objects.

Note that, when the TreeSet has several objects as entry points, the Root node  is displayed.

Example: Adding selected objects as root Collection parameter

To add several objects to your root node:
1. Access the Collection Parameter - based TreeSet Definition properties.

 See Accessing the TreeSet Definitions.
2. Display its Characteristics page.
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3. In the Collection Parameters section, in the root Collection parameter row:
• click the Multiplicity cell and select "N" value.
• (Optional) In the _GUIName cell enter a more suitable name.

Example: "Connect Org-Units".

4. Display the TreeSet Definition Preview page.
In the Parameters section the user is now able to connect several objects as entry points
of the TreeSet.

Example: add "Accountability departement", "Finance Department" and 
"Human Resources Department" Org-Units.

5. In the Parameters section title, click  to collapse the section and get more space for 
the report.
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6. Click Apply Parameters.
The TreeSet is displayed with the 3 Org-Units connected to the "Org-Unit 
Organization" root folder.
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7. Generate Instant Reports:
E.g.: Dendrogram, with its root node displayed.

E.g.: Breakdown
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REPORT TEMPLATE DEFINITION

The following points are covered here:

 Report Template Introduction
 Report Template Definition
 Report Template Creation
 Customizing a Report Template
 Report Template Examples
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REPORT TEMPLATE INTRODUCTION

A Report Template describes how to build a report. 
 To build a Report Template you must be in "Expert" MetaModel access (Repository 
options).

Predefined Report Templates are provided with HOPEX. Each Report Template is specific to a
HOPEX Solution (e.g.: Risk analysis). 

With HOPEX Report Studio (and HOPEX Studio) you can create your own Report Templates.

Report Template creation is performed in both HOPEX Windows Front-End and Web Front-End for
users with HOPEX Customizer or HOPEX Customizer Publisher profile.

 Report Template definition is only available with HOPEX Power Studio technical 
module.

Once a Report Template is created, any user can use it to query HOPEX repository and create a
report. Data first shown in list form can then be handled and shown in graphical format using Instant
Report feature.

 For details on the use of reports, see Common Features > Generating documentation 
and more specifically Launching an Instant Report.

Dynamic reports enable to analyze repository data through different focus.

Each report is built from a Report Template, which defines parameters on which is based the report.
Creation and use of reports is available for all users.

Report Template and Report Chapters
A Report Template is made up of at least one Report Chapter. The Report Template defines:

• each Report Chapter
• (if needed) report parameters.
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Report Chapter and Macro or Report Data Views
The Report Chapter creation is based on either:

• a macro, or
• Reports Data View(s)

A single Report Template can include both types of Report Chapters.

Report Chapter and macro
The Report Chapter creation can be based on:

• a macro, which refers to Java code that implement dedicated interfaces
and

• if needed Report Parameters
Parameter definition indicates the input data type the user must enter for the report
calculation (e.g.: Applications).

 To implement a chapter with a Java macro, see Writing Java Report Chapters 
Technical Article.
For examples of Report Templates based on a macro see for example Report Templates 
> HOPEX > MEGA folder.

Report Chapter and Report Data Views
The Report Chapter creation can be based on:

• a Report Data View.
The Report Data View is included in a Report Container. 

• a set of Report Data Views.
Each single Report Data View is included in a single Report Container. 
You can add a set of Report Containers in a Report Chapter. 
By default the Report Containers are displayed in a single column. You can modify the
display of the Report Containers (e.g.: on a same row, in separate tabs) through the
Report Container group.

 See How to Group Report Data Views in a Report Chapter section.
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A Report Chapter may include:
• at least one Report Container including a single Report Data View.

• several Report Containers, which can be grouped in Container Groups, so that the Report 
Data Views are displayed for example on the same row.

Example 1: a Report Chapter with its Report Data Views displayed in a 
single column.

Example 2: a Report Chapter with its first two Report Data Views 
displayed on the same row.
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 See example: Report Template with a Report Chapter Based on Report Data Views.

Report Data View types
The Report Data View types are:

• Table (Report Table View)
A Report Table View is built from a set of columns of a Report DataSet, which defines
the set of columns of the table. 

• Matrix (Report Matrix View)
A Report Matrix View is built from three columns of a Report DataSet:
• two columns to define the matrix axes, 
• a third column to define the cells. 

• Graph (Report Graph View)
A Report Graph View is built from data provided by a Report Data Source of GraphSet
Definition type.

• Tree (Report Tree View)
A Report Tree View is built from data provided by a Report Data Source of TreeSet
Definition type.

• Value (Report Value View)
A Report Value View is built from data provided by a Report Data Source of query type.

Available displays depend on the Data View type.
 See Report Renderer.
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Report Style
You can define the style of the reports generated from a Report Template at Report Template
level with a Report Style. In that case the style applies to all the chapters of the report.

 See How to Customize a Report Template Style section.

You can also apply:
• a general style at Report Data View level.

 See an example in How to Apply a General Style section.

• a conditional style at Report Data View element level.
 See an example in How to Define the Filters Displayed in a Report section.

 See an example in How to apply a Conditional Style to a Graph section.

Report Renderer
The renderer defines how the dataset is displayed in the report. 

Depending on the Report Data View, the following specific renderers are available:
• Report Matrix View:

• matrix and associated bar chart
• matrix and associated radar chart

 See the drawing showing how to create a Report Template Displaying a Matrix-Bar 
Chart or a Matrix-Radar Chart.

• Report Table View:
• radar chart
• line chart
• bar chart
• pie chart 
• gauge
• word cloud
• table

 See the drawing showing how to create a Report Template Displaying a Table, a 
Radar/Line/Bar/Pie Chart, a Set of Gauges, or a Word Cloud.

• Report Graph View:
• graph

 See the drawing showing how to create a Report Template Displaying a Graph.

• Report Tree View:
• Breakdown
• Dendrogram
• TreeMap
• TreeTable

 See the drawing showing how to create a Report Template Displaying a 
Breakdown, a Dendrogram, a TreeMap, or a TreeTable.

• Report Value View:
• gauge

 See the drawing showing how to create a Report Template Displaying a Gauge.
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Report renderer parameters

From the Reports navigation menu, use the "Report Style Parameters" Report Template to create
a report displaying for each renderer type, all its available parameters and where they are used.
Use the filters to narrow down the display.

Example: in the RendererType filter select "Radar chart" to display the 
radar chart renderer information only.
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REPORT TEMPLATE DEFINITION

The following point are detailed:
• Access

• Accessing the Report Templates and their Constituents
• Properties

• Report Template Properties
• Report Chapter Properties
• Report Container Properties
• Report Data View Properties: Matrix and Table
• Report Data View Properties: Graph
• Report Data View Properties: Tree
• Report Data View Properties: Value
• Report Style Condition Properties
• Report Style Properties

• Creation
• Creating a Report Template
• Creating a Report Data View
• Adding a Report Chapter to a Report Template
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Accessing the Report Templates and their Constituents
You can display the Report Templates and their constituents either:

• in the Browse area 
That way you can display the properties of the Report Template and of its constituents in
the Edit area, so as to view the Report Template structure and its properties at the same
time.

• in the Edit area
That way you can display the properties of the Report Template and its constituents in
other tabs of the Edit area.
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Accessing Report Templates and their constituents
To access the Report Templates:

1. Connect to HOPEX Report Studio desktop.
 See Connecting to HOPEX Report Studio Desktop.
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2. In the navigation bar, click Report Definitions > Report Templates .
The Report Templates page displays in the Browse area. 

 Alternative: select Report Definitions > Report Templates to display the Report 
Templates page in the Edit area. 

At any time you can click Browse  to display the same tree view in the Browse 
area.
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In both Browse and Edit areas, the Report Templates tab gives access to:
• the Report Templates classified by their sharing characteristics (Private or Public). 

The HOPEX folder includes standard Report Templates.
 You can add sub-folders for a more precise Report Template classification. 

• the Public Report Data Views classified by their source Definition (Report DataSet 
Definition, TreeSet Definition, GraphSet Definition). These Public Report Data Views 
can be reused in Report Templates 

 A Private Report Data View cannot be reused in another Report Templates, so that it 
is relevant to its Report Template only.

 You can add sub-folders for a more precise Report Data View classification.
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Displaying properties of a Report Template and its contituents
To display the Report Template properties:

1. Access the Report Template in the Browse area.
 See Accessing Report Templates and their constituents.

2. Click the Report Template to display its properties.
 If you displayed the Report Template in the Edit area, hover the cursor over the 

Report Template name and click Open in a new tab  to open its properties in a new 
tab.

3. Expand the Report Template  to access its Report Chapters .
4. (Report Data View-based Report Chapter) Expand a Report Chapter to access its Report 

Data View(s):
For example:
Report Table View 

Report Matrix View 

Report Graph View 

Report Value View 
Hover the cursor over the Report Data View and click Open in a new tab  to display
its Properties in a new tab.

 See Report Template Examples.
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5. Expand each Report Data View to access its constituents.

Click the Report Data View element to display its properties in the Edit area.
 (If you displayed the tree in the Edit area) Hover the cursor over the Report Data 
View element row and click Open in a new tab  to display its Properties in a new 
tab.

Directly accessing custom Report Templates and their properties 
You can directly access the custom Report Template lists: 

• your Report Templates only
• all custom Report Templates

To directly access the Report Template properties:
1. Connect to HOPEX Report Studio desktop.

 See Connecting to HOPEX Report Studio Desktop.
2. In your Home page, in My Scope, click:

• My Report Templates indicator to access your Report Templates only
• Custom Report Templates to access all the custom Report Templates

3. Click a Report Template to display its properties.

 Hover the cursor over the Report Template and click Open in new tab  to keep 
the list of Report Templates displayed.
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Accessing Report Display Contexts
A Report Display Context enables to configure the Reporting page of an object for a specific
profile. The Report Display Context is dedicated to a "MetaClass - Profile" duo.

To access the Report Display Contexts:
1. Connect to HOPEX Report Studio desktop.

 See Connecting to HOPEX Report Studio Desktop.
2. In the navigation bar, select Report Definitions > Report Templates.
3. Click Report Display Contexts.

You can access the Report Display Contexts sorted either by:
• by profile
• by MetaClass

 See How to Customize the Reporting Page of an Object.

Accessing Report Styles
Report styles are used to add styles to Report Templates.

 See How to Apply a General Style, How to Define the Filters Displayed in a Report 
and How to apply a Conditional Style to a Graph.

A MetaTest can be used in Report Style condition properties. 
 See Report Style Condition Properties.

To access the Report Styles:
1. Connect to HOPEX Report Studio desktop.

 See Connecting to HOPEX Report Studio Desktop.
2. In the navigation bar, select Report Definitions > Report Templates.
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3. Click Styles.

The Styles page displays:
• all the Public Report styles and those used in Report Templates

 Report styles are used to add styles to Report Templates, see How to Apply a General 
Style, How to Define the Filters Displayed in a Report and How to apply a Conditional 
Style to a Graph sections.

• all the MetaTests and those classified by MetaClass tested.
 A MetaTest can be used in Report Style condition properties (see Report Style 
Condition Properties) or added to a Report Template (see Adding a condition to report 
availabity (MetaTest on Report Template).

Report Template Properties
 To access the Report Template properties, see Accessing the Report Templates and 
their Constituents.

From the Report Template properties, you can access information regarding:
• its Characteristics 
• its input Parameters 
• its Chapters
• its Permissions
• its Report Template Style
• its Description (in Texts)
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Characteristics
The Illustrations section shows the Renderers used in the report and their corresponding
illustration.

This section:
• is automatically filled for HOPEX Report Studio Report Templates.
• must be set manually for java reports

 See How to Define the Report Template Renderer and Illustration section.

The Subjects & Categories section enables to define the report related information which is used
by the end-user to filter the Reports and Report Templates:

• Categories are domains considered in the report
This field must be set manually.

• Subjects are MetaClasses that are displayed in the report
This field:
• is automatically filled for HOPEX Report Studio Report Templates
• must be set manually for java reports

 See How to Define the Filters: Categories and Subjects section.

In the Identification section:
• the Report Template Sharing parameter defines the Report Template availability:

• "public" (default value)
Allows other users to access the Report Template. 
These users must be connected with one of the Profiles that are allowed to access the
Report Template. The Report Template availability for each profile is defined in
Permissions (see Permissions).
• "private" 
Only the Report Template creator can access the Report Template.

• the Display print button parameter enables to manage the printing availability of the 
reports generated with this Report Template:
• "yes" (default value): the Print button is available on the report 
• "No": the Print button is not available on the report

• the Description pane enables to describe the report
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Parameters
In the Parameters section (for Report Chapters based on macros), you can: 

• add new parameters to the Report Template.
 See How to Define Parameters in a Report Template section.

• configure the parameter to define the values that the end-user can use at report 
creation. The list of values can be computed form another parameter value.

 See Configuring a Report Template parameter.

• customize the parameter to:
• add reports in object property pages.

 See How to Add Reports to Object Property Pages section.

• add reports at the Instant Report creation from an object list.
 See How to Make a Report Creation Available to an Object List

• customize the parameter display.
 See Customizing Parameter Display.

In the Data Source Parameters section (for Report Chapters based on Report Data Views), you
can:

• define the parameters that have to be selected at report creation.
 See Defining parameters in a Report Template based on Data Views.
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Chapters
From the Available Report Chapters list, you can:

• add Report Chapters to the Report Template.
 See Adding a Report Chapter to a Report Template.

• organize the Report Chapters
 See Organizing the Report Chapters.

• manage the report snapshot
 See Managing a Report Snapshot.

Report Template Style
The Report Template Style defines the default style of the reports generated with this Report
Template.

The Report field enables to associate the Report Template with a test report so as to define the
style parameters that are applied to all the reports generated from this Report Template.

 See How to Customize a Report Template Style section.
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Permissions
In Access rights and Availability, the Tool Availability parameter defines for each profile, and
associated Perspective, whether the Report Template is available to the user or not.

 For details on permissions, see Managing Permissions on General UI.

Report Chapter Properties
From the Report Chapter properties you can access information regarding:

• its Characteristics, 
• its Definitions (specific to Report Chapters based on Report Data Views), 
• its Filters Binding (specific to Report Chapters based on Report Data Views). 
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Characteristics
In Characteristics:

• You can define whether the Report Chapter can be exported in:
• Excel format (Is compatible with Excel)
• RTF format (Is compatible with RTF)
When selected, fonts used in the RTF texts of objects (e.g.: comment) are kept in web
site generation. Else, a CSS file should manage the font choice depending on each HTML
tag class.

• _GUIName: you can define the name you want to be displayed for the Report Chapter.
• (for a Report Chapter based on a macro) Implementation section: defines on which 

macro the Report Chapter is based.
• Snapshot section: you can define a snapshot for a fast Report Chapter display. The 

snapshot is also used for export operations.
 See Managing a Report Snapshot.

Definitions (Report Data Views-based Report Chapters)
Definitions shows:

• a global view of the Report Chapter constituents and structure (as a tree view)
• how each of its following constituents are displayed:

• (if any) Container Group: horizontal, tab or vertical.
• Report Data View: table, graphic, or table and graphic.

For example, the "Application Techno Vendors" Report Chapter includes 
four Report Data Views showing three graphics (a set of gauges and two 
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pie charts) and a matrix one above the other (Container Organization of 
the group: "Vertical")
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Filters Binding (Report Data Views-based Report Chapters)
A filter enables to restrict a Report DataSet column values, which are considered in the report. This
Report DataSet column is not necessarily part of the report.

Filters Binding enables to feed a filter content with another filter content. Both filters must be of
the same type.
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To do so you need to create a binding object.

Report Container Properties
A Report Container is a part of a Report Chapter that contains a Report Data View (Table View,
Matrix view).

Characteristics
In Characteristics:

• Show All Filters enables to define the filters displayed in the report:
• when selected (default), all the Data View filters are displayed.
• when cleared, you can select the required Data View filters from the available ones.

• Data Source Instance Identifier: is used only in case the same Report DataSet is 
used in several Data Views of the same Report Template.
You can:
• share the same Report DataSet instance with all the Report Data Views (default 

behavior).
• define which Report DataSet instances are shared with the Report Data Views and 

which ones are distinct. In that case, you define the same numerical identifier to the 
Report Data Views that share the same Report DataSet instance.
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Report Data View Properties: Matrix and Table
The following properties are common to both types of Report Content:

• Report Matrix View
• Report Table View 

Characteristics
Report Matrix Views and Report Table Views show the same Characteristics page, including:

• Sharing: 
• "Public" (default): the Report Data View can be reused in several reports. The Report 

Data view is available at Report Template or Report Chapter creation.
• "Private": the Report Data View cannot be reused.

• General Style, which defines the style to apply to the Report Data View. It defines the 
values for a set of Renderer-type Parameters.

• Display, which defines the display associated with the Report Data View: 
• "Table"
• "Graphic"
• "Graphic and table"

• Chart Type, which defines the graphic display type: 
• "Area Chart"
• "Bar Chart"
• "Line Chart"
• "Radar Chart"
• "Gauge Chart" (for a Report Table View)
• "Set of gauges Chart" (for a Report Table View)
• "Pie Chart" (for a Report Table View)
• "Word Cloud" (for a Report Table View)

Chart
The Chart page is specific to Report Matrix Views and Report Table Views that include a chart. This
page defines which element defines:

• the chart axes
• the chart legend (for Bar, Line, Area, Pie, or Radar charts)

Filter
Report Matrix Views and Report Table Views include the same Filter page, which enables to define
which filters can be displayed in a report for this Report Data View.

A filter enables to restrict a Report DataSet column values, which are considered in the report. This
Report DataSet column is not necessarily part of the report.

 See How to Define the Filters Displayed in a Report section.
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Characteristics

Each filter is defined by the following Characteristics:
• Visibility enables to hide the filter when it is fed by another filter or to display its value 

only.
• Object Edition Mode defines how objects are displayed and whether they are editable 

or not.
I.e.: Menu, In-Place Edit, No Edition.

• Input type defines how the report user can define its condition:
• "Single Value"
• "Multiple Values" when the column includes a restricted number of values.
• "Continuous" to define a range of values.
The condition is also column data type dependent.

• Behavior defines the filter action on the report:
• "Immediate Refresh" (for a report easily calculated): as soon as the user modifies the 

filter the report is updated. 
• "No Refresh": the user needs to click the Refresh button to update the report.

• Filter Choice: defines what can be selected: one or several objects, or contains a value.

I.e.: "Single Choice", "Multiple Choice", "Contains".
• values:

• Initial Value: defines the default value on report opening.
• Contains: defines the values the user can use for a specific filter.
• Shows: defines how to manage empty values in case of condition or not.

I.e.: 
"Add empty values": if no condition: displays empty values only, if a 
condition is defined: displays the elements matching the condition and 
also the empty values, 
"Display only empty values", 
"Display only non empty values", or 
"Consider all values": displays values matching the condition only.

• for numerical values: Less than, Equals to, Greater than
• for character strings: Begins with, Ends with

Text

In Text, _Settings tab enables to define:
• an initial value

An initial value is the default value on report opening.
The user can modify the value.

paragraph [default Value]
• a candidate value

Candidate values are the values the user can use for a specific filter.
paragraph [Candidate]

The paragraph content depends on the filtered data type.
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For a filter of type:
• Occurrence, the values are defined either by:

• an object defined by a conventional variable:
Value = &Current
Example: Value=&CurrentUser

• an object list explicitly defined in field form:
Value = ~object1,~object2,…

• a set of occurrences obtained by applying a condition on the DataSource item 
occurrences
Value="Character string"
All of the occurrences, whose short name includes "character string".

• a set of occurrences retrieved by a query execution
Query = ~Query quoted : the values retrieved by the quoted query. 
If the query does not include a parameter it is executed straight away, 
else the included parameter is valued by the report parameter quoted in 
the Parameter variable.

 Queries including more than one parameter are not exploitable.
Parameter = ~Parameter
Defines the report parameter which enables to value the query parameter.

• Tabulated value attribute, the values are defined either by:
• a list of internal values explicitly quoted

Value=value1, value2, ...
Example: certain values of a multivalued attribute.

• a set of values obtained by applying a condition on the attribute internal values 
(numerical values)
ValueInferiorTo="Numerical value"
ValueSuperiorTo="Numerical value"

• Date, the values are defined either by:
• an object defined by a conventional variable

Value = &CurrentDate
• a list of dates explicitly quoted (Mega internal format for dates)

Value = 2016/15/25,...
• a set of dates obtained by applying a condition on the DataSource item occurrences

ValueInferiorTo="date" : all the dates < to the date.
ValueSuperiorTo="date" : all the dates > to the date.

• Numerical, the values are defined either by:
• a list of explicit values

Value=12,200,3000
• a set of values obtained by applying a condition on the DataSource item occurrences

ValueInferiorTo="Numerical value"
ValueSuperiorTo="Numerical value"
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Matrix (Report Matrix View)
The Matrix page is specific to Report Matrix Views. This page defines the matrix content, i.e. the
data source columns on which is based the matrix:

• the Rows and Column folders:
Each item defines the content of all the rows and columns displayed in the matrix. The
displayed data is provided by a Report Data Source Element.
• Data Source Item attribute defines the Report Data Source Element, which provides 

the data.
• Sort attribute defines which sorting is applied to the row/column.
• Show all values attribute defines if all the column possible values are displayed in 

the report. It is used only when rows or columns match a set a known values.

• the Cells folder:
Each item defines the content of all the cells displayed in the matrix. The displayed data
is provided by a Report Data Source Element.
• Data Source Item attribute defines the Report Data Source Element, which provides 

the data.
• Report Cell Content attribute defines what is displayed in the cell.

I.e.: Value, Check mark, or Details of objects.
• Value computation attribute defines which computation is applied to the set of 

values grouped in the cell. It operates only for cells with numerical values.
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I.e.: Average, Count, List, Maximum, Median, Minimum, or Sum.
• Object Edition Mode attribute defines how objects are displayed and whether they 

are editable or not.
I.e.: Menu, In-Place Edit, No Edition.

This page also enables to Add row, Add column, Add cell, and also to Reorder the cells, columns,
and/or rows in alphabetical order.

Table (Report Table View)
The Table page is specific to Report Table Views. This page defines the table content:

• Columns Displayed defines the data source columns on which are based the table.
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For each selected column item, the following parameters are defined:
• Display order: to define the column appearance order (if not specified, the row order is 

considered).
• Sort and Sort priority: to define the sorting direction and in which order it is applied.
• Group: to merge the pre-sorted set of cells showing the same value.
• Visibility: to define whether the column is visible by default or hidden by default, or 

never visible. When the column is visible by default or hidden by default the end-user 
can hide or display the column for his specific report using the report Edit mode.

• Value Computation: to define a computation when the tab includes a grouping.
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You can add subtotals to grouped rows (Group value is set to "yes"). Each added Report Table
Subtotal defines the sub-total rows that have to be added to the table:

• Title: defines the name displayed in the added row.
• Total by: defines to which grouped rows the row is added.
• Operation Title: to add a subtitle, regarding the column, in the break. Default value is 

"No subtitle".
You can:
• define the title ("Given subtitle") or 
• keep the automatic title ("Automatic subtitle" which is defined from the computation 

function name). 
• Break type: defines where the row appears ("Subtotal only" or "Subtotal and Grand 

total")
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On the row you can display several computation results performed on each column including
numerical values. 

 See How to Add Sub-totals in a Table Break section.
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Report Table Column Properties

Characteristics
• Dataset Item attribute is a part of the Data Source used in the report.
• Column Type attribute shows the data format of the Report table Column.

E.g.: string, long, float.
• Object Edition Mode attribute defines how objects are displayed and whether they are 

editable or not.
E.g.: Menu, In-place edit, No edition.

• Visibility attribute defines if the column is available and/or visible in the displayed table.
For "Visible" and "Hidden by default", the end-user can hide or display the column for his
specific report using the report Edit mode.

• Show all Values attribute defines whether all the possible values for the column are 
displayed in the report or not.

• Display Order attribute defines the position of the column in the table.
• Group attribute defines if identical values of a given column are merged.
• Report Column Group Order attributes defines in which order the columns are used to 

group the table rows.
• Sort attribute defines which sort is applied on the column.
• Sort Priority attribute defines in which order the columns are used to sort the table 

rows.
• Value Computation attribute defines which computation is applied to the set of values 

grouped in the cell.

Style (for conditional style)

The Style page is similar for the data view elements (line, column, and matrix cell) and enables to
define a style when the condition is satisfied.

You can create a set of conditions and associate each of them with styles.

Conditions are considered one after another.

Report Data View Properties: Graph 
A Report Graph View is used to display a graph in a Report Container. The data displayed in the
graph is provided by a Report Data Source of GraphSet Definition type.
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Characteristics
The Characteristics page includes the following properties:

• Sharing: 
• "Public" (default): the Report Graph View can be reused in several reports. The Report 

Graph view is available at Report Template or Report Chapter creation.
• "Private": the Report Graph View cannot be reused.

• Data Source shows the GraphSet Definition on which the Report Graph View is based.
• General Style defines the style to apply to the Graph view (i.e. values for a set of 

renderer type parameters)
For example: node display style.

• 3D illustration defines whether 3D display is available or not
• Default illustration defines the default display when 3D illustration is available
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Graph
The Graph page enables to modify each Report Graph Layer display:

• its Visibility
Values: Visible, Never visible, or Hidden by default.

• its data display:
• the Visibility of its Nodes, and for each node the display of its fields
A field can replace the node object, be displayed in tooltips (by default), or replace the
object name.

 For details on node properties and style, see Report Graph Node properties.

• the Visibility of its Arcs, and for each arc the display of its fields

 For details on arc properties and style, see Report Graph Arc properties.
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Filter
The Filter page enables to define which filters can be displayed in a report for this Report Graph
View.

A filter enables to restrict the nodes or fields that are considered in the report. 
 See How to Define the Filters Displayed in a Report section.

A filter is defined by the following Characteristics:
• Filtering Group Id
• Input type defines how the report user can define its condition:

• "Single Value"
• "Multiple Values"
• "Continuous" to define a range of values.

• Behavior defines the filter action on the report:
• "Immediate Refresh" (for a report easily calculated): as soon as the user modifies the 

filter the report is updated. 
• "No Refresh": the user needs to click the Refresh button to update the report.

• values:
• Contains: defines the values the user can use for a specific filter.
• Shows: defines how to manage empty values.

I.e.: "Add empty values", "Display only empty values", "Display only non 
empty values", or "Consider all values"

• for numerical values: Less than, Equals to, Greater than
• for character strings: Begins with, Ends with

Report Graph Node properties
A node is defined by the following Characteristics:

• Name Display attribute enables to hide the name of node in the Graph.

Values: Show Name (default) or Hide Name.
• Display attribute enables to hide the node in the Graph.

Values: Visible (default) or Not visible.
You can also define a Style (or conditional style) on a node, see Style.
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Report Graph Arc properties
An arc is defined by the following Characteristics:

• Visibility attribute enables to override the visibility of the GraphSet Arc Definition in the 
Graph.

Values: Visible (default) or Not visible.
• Arc Direction attribute enables to override the orientation of the GraphSet Arc 

Definition or to hide the arrow in the Graph.
Values: Default, Reverse, or No arrow.

• Grouping specifications section enables to configure:
• a grouping by object or by field, or grouping all of the arcs
• the detailed list of objects

Values: Node, Object field of a node.
You can also define a Style (or conditional style) on an arc, see Style.

Style
The Style page enables to define values for a set of renderer type parameters of the Report Graph
View at graph element level (node, arc).

The Style page of a node/arc enables to define a style on the node/arc when the condition is
satisfied. 

If no condition is set, the style always applies. You can create a set of conditions and associate each
of them with styles. Conditions are considered one after another.
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The style can apply:
• to all the nodes or arcs, 

 See Report Style Properties.

• on condition to certain nodes or arcs
 See Report Style Condition Properties.

For example, you can define:
- a specific style on arcs. 
- a conditional style on nodes: the nodes "Applications" for which the 
"Cloud" field value is "Saas" are displayed with a blue background.

 See example in How to apply a Conditional Style to a Graph section.

Report Data View Properties: Tree 
A Report Tree view is used to display a tree in a Report Container. The data displayed in the tree
is provided by a Report Data Source of TreeSet Definition type.

Characteristics
The Characteristics page includes the following properties:

• Data Source shows the TreeSet Definition on which the Report Tree View is based.
• Display defines the renderer type to apply to the Tree view.

E.g.: Breakdown, Dendrogram, TreeTable, or Treemap. 
• General Style defines the style to apply to the Tree View (i.e. values for a set of 

renderer type parameters).

Filter
The Filter page enables to define which filters can be displayed in a report for this Report Tree View.

A filter enables to restrict the nodes that are considered in the report. 
 See How to Define the Filters Displayed in a Report section.
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A filter is defined by the following Characteristics:
• Input type defines how the report user can define its condition:

• "Single Value"
• "Multiple Values"
• "Continuous" to define a range of values.

• Behavior defines the filter action on the report:
• "Immediate Refresh" (for a report easily calculated): as soon as the user modifies the 

filter the report is updated. 
• "No Refresh": the user needs to click the Refresh button to update the report.

• values:
• Contains: defines the values the user can use for a specific filter.
• Shows: defines how to manage empty values.

I.e.: "Add empty values", "Display only empty values", "Display only non 
empty values", or "Consider all values"

• for character strings: Begins with, Ends with

Report Data View Properties: Value 
A Report Value view is used to display a gauge in a Report Container. The data displayed in the
gauge is provided by a Report Data Source of query type.

The gauge report shows the query result value against the number of concerned occurrences in the
repository. 

Characteristics
The Characteristics page includes the following properties:

• Sharing: 
• "Public" (default): the Report Value View can be reused in several reports. The Report 

Value view is available at Report Template or Report Chapter creation.
• "Private": the Report Value View cannot be reused.

• Data Source shows the query (without parameters) from which the Report Value View 
is built.

• Display shows the renderer type applied to the Tree view.

Value: Graphic.
• Chart Type shows the chart type.

Value: Gauge Chart.
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Chart
The Chart page defines how the gauge is built and customized:

• Value defines the gauge value, i.e. the (Data Source) query on which the chart is based.
• Value Computation defines the value computation mode. For example, it can be more 

efficient to perform a computation relating to a minimum value or to a maximum value.
Values: Default, Added to min, subtracted from max.

• Min value defines the gauge minimum value. By default this minimum value is 0. You 
can define a query that sets the gauge minimum value. 

Values: a query of the same source, or empty (in that case 0).
• Max value defines the maximum value of the gauge. By default this maximum value is 

the number of occurrences of the object type that represents the gauge. You can define 
a query that sets the gauge maximum value.

Values: a query of the same source, or empty (in that case the maximum 
number of occurrences concerned).

• Drill-down defines whether a drill-down is available on the gauge or not.

Values: yes, no
• Specific Drill-down defines the occurrences displayed in the drill-down. By default all 

the occurrences are displayed. This parameter enables to select another query (than the 
Data Source query) for the drill-down.

Value: a query of the same source, or empty (in that case the Data Source 
query is used).

• _Settings automatically fed (and updated) while setting the chart parameters. 
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Report Style Condition Properties
The condition is defined in text format. If the text is empty the style is applied with no condition.

The text syntax is as follows:
[Paragraph]
<Order number>=<condition type>,<test subject>,<operator>,<value>

A paragraph can include one or several conditions. Each condition is expressed in a distinct line.
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The set of conditions included in a paragraph is evaluated and if all of the conditions are TRUE, then
the style is applied.

With several paragraphs, if the set of conditions of one paragraph is TRUE, then the style is applied.

 For examples of condition styles, see:
How to Apply a Conditional Style to a Column section
Applying a conditional style to a node section
How to Apply a Conditional Style to a Pie Chart section
How to Apply a Conditional Style to a Treemap section.

Condition on value (Table/Matrix/Tree View element)
This condition is in the following form: 

<order number>=Value,<report element>,<Operator>,<Value>

Where:
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<report element> is expressed by one of the following:
• &Current

&Current is the report data view element linked to the condition.
It enables to test for example:
• the current value of a matrix cell, or 
• the current cell of a of a given column.

Example: for a Table each table cell, for a column each column cell 
value.

 For an example, see How to Apply a Conditional Style to a Column section.

• &ColumnHeader 
When the report data view element is a matrix cell, the &ColumnHeader enables to test
the column header value.

Example: for a Table each column header value.
• &RowHeader

When the report data view element is a matrix cell, the &RowHeader enables to test the
row header value.

• ~Column (~subtotal, ~cells, ~rows, ~columns)
~Column is a field that identifies the column, which enables to test the current cell value.
The field can also be ~subtotal, ~cells, ~rows, or ~columns. 

Use case: applying a style on an element but testing another element 
value.

• ~Paramtype
~Paramtype is a field that identifies a report parameter (or a DataSet parameter), which
enables to test its value.
Only multiplicity 1 parameters can be tested.

Example: a report parameter or a DataSet parameter. 
• &CurrentUser (&CurrentDate, etc.)

All of the conventional variables can be tested in this paragraph.

<OPERATOR> can be:
• <
• >
• =

<Value> is a character string.
Example: to add a condition style on values superior to 10,000 enter:
[1:ConditionGroup]
1=Value,&Current,>,10000

Condition on value (Report Graph View element)
In a graph, you can add conditions on Value on:

• node
• arc
• path

The conditional style applies to arcs or nodes.
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For a node, the Value can concern:
• the object associated with the node, 
• any field value of the node, 

 For an example, see Applying a conditional style to a node.

• any field property if the field is an object. 

For a path, the Value can concern:
• any field of nodes/arcs
• any node of the path

 The conditional style applies to each arc, which is part of the path.

For an arc, the Value can concern:
• (grouped arcs) the arc number
• (arc) any field of the arc

This condition is in the following form: 
<order number>=Value,<report element>,<Operator>,<Value>

Where:

<report element> is expressed by one of the following:
• &Current

&Current is the node/arc/path linked to the condition.
• ~Field

~Field is any field of the node/arc, whose value can be compared with the given value.
• &ArcsNumber

&Arcs Number is the number of occurrences behind the grouped arcs.

<OPERATOR> can be:
• <
• >
• =

<Value> is expressed by one of the following:
• any conventional variables &CurrentUser (&CurrentDate, etc.)
• ~MegaField

Any MegaObject.
• ~Field

Any other Field value of the node/arc.
• a character string

Example: to add a condition style on Application with cost values 
superior to 10,000 enter:
[1:ConditionGroup]
1=Value,&ApplicationCost,>,10000

Complex condition embedding a MetaTest
This condition is in the following form: 

Metatest,<report element>,<~MetaTest>,<test result>
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Where:
• <report element> is expressed in the same way as for a condition on a value.

 See Condition on value (Table/Matrix/Tree View element):

• <~MetaTest> is the field that identifies the MetatTest to be executed on the occurrence 
corresponding to the report element quoted.

• <test result>: can take the following values:
• TRUE
• FALSE

Condition on a report element regardless of its content
This condition is in the following form: 

id,<report element>,IS,<conventional value>

Where:
• <report element> can be either:

• &CurrentColumn to designate the current column, or
• &CurrentRow to designate the current row.

• <conventional value> can be:
• ODD
• EVEN
• LAST
• FIRST

Report Style Properties

Characteristics
A style is a set of renderer parameters and their values. They include all the parameters available
for report editing.

 See How to Create a Report Style section.

Definition
The Definition page enables to add render parameters that will be valued for this style. 
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Style Sharing: by default the style is "Private". "Public" value enables to make the style available
to all users when editing reports.
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REPORT TEMPLATE CREATION

The following point are details:
• Creating a Report Template
• Creating a Report Data View
• Adding a Report Chapter to a Report Template

Creating a Report Template
 For a big picture see Report Template Creation: The Big Picture.

You can create a Report Template from:
• a Report DataSet
• a GraphSet
• a TreeSet
• a query

Else you can create a Report Template using a Report Data View.

To answer specific needs, you can also implement a Report Template using macro.

Creating a Report Template from a Report DataSet
In HOPEX Report Studio (or HOPEX Studio), you can create a Report Template from a Report
DataSet.
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From the Data page of the Report DataSet, you can launch an Instant Report, then save it as:
• a Report Template
• a Report Data View, to use it in a Report Template

 Note: from the instant report, Save as Report generates a report as well as its 
corresponding private Report Template, which you can access from Report Templates 
> My Report Templates folder.

To create a Report Template from a Report DataSet:
1. Access the Report DataSet properties (from Report Definitions > Data Sources > 

Report DataSets).
 Else access a Report DataSet Definition properties (from Report Definitions > 
Data Source Definitions > Report DataSet Definition) and display its Preview page.

2. Display its Data page.
3. In the Report DataSet section, click Instant Report .
4. Select the required instant report type.

E.g.: Breakdown (pie chart, bar chart, set of gauges, word cloud), Matrix 
(bar chart, radar chart, Quantitative (bar chart, line chart, radar 
chart), Table. 

5. Click OK.
The instant report is displayed in full page, Report section.

6. In the Report section, click More  > Save As Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

7. In the Name field, enter your Report Template name.
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8. Click OK.
A public Report Template is created, with its public Report Table View. They both have
the same name.
You can access the Report Template:
• directly from your Home page, from Custom Report Templates tile, or
• from the Public Report Template folder (Report Studio > Report Template 

Definition >Report Templates)

Creating a graph-type Report Template from a GraphSet
In HOPEX Report Studio (or HOPEX Studio), you can create a Report Template from a GraphSet.

From the Preview page of the GraphSet Definition, you can save the graph as:
• a Report Template
• a Report Data View, to use it in a Report Template

 Note that Save as Report, generates a report as well as its corresponding private 
Report Template, which you can access from Report Templates > My Report 
Templates folder.

To create a graph-type Report Template from a GraphSet:
1. Access the GraphSet Definition properties.

 See Accessing the GraphSet Definitions/Accessing the Report Templates and their 
Constituents.

2. Display its Preview page.
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3. In the graph, click click More  > Save As Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

4. In the Name field, enter your Report Template name.
5. Click OK.

A public Report Template is created, with its public Report Graph View. They both have
the same name.
You can access the Report Template:
• directly from your Home page, from Custom Report Templates tile, or
• from the Public Report Template folder (Report Studio > Report Template 

Definition >Report Templates)

Creating a tree-type Report Template from a TreeSet
In HOPEX Report Studio (or HOPEX Studio), you can create a Report Template from a TreeSet.

From the Preview page of the TreeSet Definition, you can save the tree as:
• a Report Template
• a Report Data View, to use it in a Report Template

 Note that Save as Report, generates a report as well as its corresponding private 
Report Template, which you can access from Private Report Template > My Report 
Templates folder.
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You can save only one tree report at a time:
• a breakdown
• a dendrogram
• a TreeMap
• a TreeTabble

To create a Report Template from a tree report:
1. Access the TreeSet Definition properties.

 See Accessing the Report Templates and their Constituents.
2. Display its Preview page.
3. Click the renderer type you want to save.

E.g.: Breakdown, Dendrogram, TreeMap, or TreeTable.

4. In the graphic, click click More  > Save As Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

5. In the Name field, enter your Report Template name.
6. Click OK.

A public Report Template is created, with its public Report Tree View. They both have
the same name.
You can access the Report Template:
• directly from your Home page, from Custom Report Templates tile, or
• from the Public Report Template folder (Report Studio > Report Template 

Definition >Report Templates)
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Creating a gauge-type Report Template from a query
In HOPEX Report Studio (or HOPEX Studio), you can create a Report Template from a query (without
parameters). This Report Template enables to create gauge reports.

 See use cases in How to Create and Customize a Gauge Report Template section.

To create a gauge-type Report Template from a query:
1. Connect to HOPEX Report Studio desktop.

 See Connecting to HOPEX Report Studio Desktop.
2. Access the queries: click Report Definitions > DataSources > Queries navigation 

menu.
3. In the Queries without mandatory parameters list, right-click a query and select 

Documentation > New gauge report.
4. In the Name field, enter the report name. 
5. Click OK.

The gauge report and its corresponding private Report Template (with associated Report
Value View) are automatically created. They all have the same name.
You can access the Report Template:
• directly from your Home page, from Custom Report Templates tile, or
• from My Report Templates folder (Report Definitions > Report Templates)
• from the Private Report Template folder (Report Definitions > Report 

Templates)
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Creating a Report Template using a Report Data View
You can create a Report Template right away including a Report Chapter with a Report Data View
saved in the Public Report Data Views folder.

Prerequisite: your Report Data View is created.
 To create a Report Data View, see Creating a Report Data View.

To create a Report Template using a Report Data View:
1. Access the Report Templates folders.

 See Accessing the Report Templates and their Constituents.

2. Hover the cursor over My Report Templates folder, and click New > Report 
Template.

 Alternative: from your Homepage > My Scope, click My Report Templates, then 
click New.

Your Report Template Basic Properties window appears. 
 At creation this Report Template is "public" (see Report Template Properties), in case 
you create a Report Template from Private Report Template sub-folder, it is still saved 
in Public Report Template sub-folder.

3. In the Name field, enter your Report Template name.
 By default the Report Template name is: Report Template-x (x is a number).

4. In the drop-down list select the Report Data View you want to fill your first chapter with.
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5. Click OK.
The Report Template is created with a single chapter based on the Report Data view
selected. 
You can:
• add other chapters.

 See Adding a Report Chapter to a Report Template.

• customize the Report Template.
 See Customizing a Table Report Template, Customizing a Graph Report Template, 
Customizing a Gauge Report Template.

Creating a Report Template using a macro
To build your report chapters, you can use an existing macro on condition that parameters are
compatible.

To create a Report Template using a macro:
1. Access the Report Templates folders.

 See Accessing the Report Templates and their Constituents.
2. Hover the cursor over My Report Templates folder, and click New > Report 

Template.
 Alternative: from your Homepage > My Scope, click My Report Templates, then 
click New.

The Basic Properties page appears. 
 At creation this Report Template is "public" (see Report Template Properties), in case 
you create a Report Template from Private Report Template sub-folder, it is still saved 
in Public Report Template sub-folder.

3. In the Name field, enter your Report Template name.
 By default the Report DataSet Definition name is: Report Template-x (x is a 
number).

Example: Application
4. Click Next.

The Parameters definition wizard appears.
Parameter definition indicates the input data type the user must enter for the report
calculation (e.g.: Applications).

 Do not define any parameter if you want the report to be launched without requiring 
the user to select any input objects.

For each parameter define the available object type that can be instantiated for the report
(parameter with HOPEX objects or with simple types).

 See How to Define Parameters in a Report Template section.
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5. Click Next to continue the Report Template definition:
 Else click OK to terminate the Report Template definition later. You need to define at 
least one Report Template Chapter. See Adding a Report Chapter to a Report Template.

The Chapters definition wizard appears.

6. Click New . 
7. In the Name field, enter the Report Chapter name.
8. In the Based on field, select "Macro".
9. In the Macro field, click the right-oriented arrow and select Add Macro.

 If the macro is already created, select the macro in the drop-down list and click OK.
10. In the Name field, enter a name for the macro.
11. Click Next.
12. Select Create a Java Macro and click Next.
13. In the Setup JAVA Macro:

• In the Class Name field, enter the class defined in Eclipse when developing the Java 
macro.

• In the Package Name field, enter the macro path.

Example: "com.mega.modeling.analysis.reports" for those supplied by 
MEGA.

 To create the macro, see How to Define Parameters in a Report Template section.
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14. Click OK.
The macro name appears in the Macro field.

 For such a Report Template example, see Report Template with a Report Chapter 
Based on a Macro.

The macro appears in the Report Template tree, under the Report Chapter concerned. 
You can:
• add other chapters.

 See Adding a Report Chapter to a Report Template.

• customize the Report Template.
 See Report Template: How To.

Creating a Report Data View
You can create a Report Data View from:

• the Preview page of a Report DataSet Definition properties, a GraphSet Definition 
properties, or aTreeSet Definition properties.

• a query.

To create:
• a Report Table View or a Report Matrix View from a Report DataSet Definition, 

see Creating a Report Data View from the Report DataSet 
• a Report Graph View from a GraphSet Definition properties, see Creating a Report 

Graph View.
• a Report Tree View from a TreeSet Definition properties, see Creating a Report Tree 

View.
• a Report Value View from a Query, see Creating a gauge-type Report Template from a 

query.

Adding a Report Chapter to a Report Template
At any time you can add a Report Chapter to a Report Template.

Prerequisite: your Report Data View or your macro is created.
 To create a Report Data View, see Creating a Report Data View.

To add a Report Chapter to a Report Template:
1. Access the Report Templates.

 See Accessing the Report Templates and their Constituents.
2. Hover the cursor over the Report Template concerned and click New > Report Chapter.
3. Right-click the Report Template and select Add > Report Chapter.

 Else, in the Chapters page of the Report Template properties, click New.
4. In the Local Name field, enter the Report Chapter name.
5. In the Based on field, select on what is based the report Chapter:

• a Report Data View (by default)
• a Macro

6. In the Report Data view / Macro drop-down list select the Report Data view / Macro.
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7. Click OK.
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CUSTOMIZING A REPORT TEMPLATE

See:
• Managing a Report Snapshot
• Organizing the Report Chapters
• Customizing the Report Chapter Export Format
• Customizing Parameter Display
• Customizing the Report Container Group display

Managing a Report Snapshot
Report snapshot creation is available for reports based on macros as well as for reports based on
Report Data View(s). 

Report snapshot creation is useful for a fast Report Chapter display and is also used for export
operations.

When the report snapshot creation is not activated the report chapter display is fully recalculated
at each refresh, which can be time consuming.

For each Report Chapter, you can:
• activate or deactivate the report snapshot creation 
• define its type

To manage a report snapshot:
1. Access the Report Template Chapter properties: Characteristics.

 To access the Report Chapter properties, see Accessing the Report Templates and 
their Constituents.
 See Report Chapter Properties.

2. In the Snapshot section, from the Report Snapshots drop-down list select:
• "Yes" to activate the report snapshot creation.
• "By Format" to activate a report snapshot creation. In this case a report snapshot for 

each format is created (html, pdf, excel).
• "No" to deactivate the report snapshot creation.

 By default "No".
3. In the Snapshot section, from the Report Snapshot type drop-down list select:

• "Global Snapshot" to define a single snapshot for all the users.
• "Snapshot by profile" to define a single snapshot by profile. 
• "Snapshot by user" to define a single snapshot by user.

 By default "Snapshot by user".
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Organizing the Report Chapters
You can sort the Report Chapters of a Report Template:

• manually according to your needs, or 
• automatically in alphabetical order.

To organize the Report Chapters of a Report Template:
1. Access the Report Template properties: Chapters.

 See Accessing the Report Templates and their Constituents.

2. In Available Report Chapters list, click Reorganize .
3. To:

• customize the Report Chapter order: drag and drop the chapters to their required 
position.

• sort the Report Chapters in alphabetical order: click Alphabetical order.
4. Click OK.

Customizing the Report Chapter Export Format
You need to define the available report export formats according to the report specific purpose. For
reports intended to:

• produce documents that need to be printed entirely (more than one chapter) and should 
fit in a printable format (A4, letter), the RTF export format must be available. 

• produce dashboards or to be consulted online, the RTF export format should not be 
available.

Depending on the report purpose and use, you must define its Report Chapter export formats.

To define the available export format for a Report Chapter:
1. Access the Report Chapter properties: Characteristics.

 See Accessing the Report Templates and their Constituents.
2. According to the report specific purpose, modify the default export formats available for 

the Report Chapter:
• (selected by default) Is compatible with Excel
• (selected by default) Is compatible with RTF

3. Click OK.
According to the export format selected, the Excel  and  RTF corresponding buttons
are available in the report result.

 Note that the Print Report  button is always available on the reports and 
enables to print (or print in a PDF file) the report.

Customizing Parameter Display

You can define object display order in generated reports.
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Parameters without groups

For parameters not containing groups, display order depends on:
• MEGA order number: objects of a list have an order number taking value "9999" by 

default. You can modify this value for each object (from the object properties, General 
> Administration page).

• Multiplicity: for parameters with the same MEGA order number, display order depends 
on multiplicity:
• 1. Multiplicity 1
• 2. Multiplicity 0..1
• 3. Multiplicity 1..*
• 4. Multiplicity * and NONE (the two are equivalent)

• Alphabetical order: for the same multiplicity, it is alphabetical order that is taken into 
account.

Parameters with groups

The parameter group display order depends on group alphabetical order. 

In each group, parameters are displayed in MEGA order. 

If parameters of the group have the same order number, their display order depends on their
multiplicity: 

• 1. Multiplicity 1
• 2. Multiplicity 0..1
• 3. Multiplicity 1..*
• 4. Multiplicity * and NONE (both are equivalent)

For the same parameter multiplicity, it is alphabetical order that is taken into account.

Parameters with and without group

Parameters that are not in groups appear in first position. They are followed by groups.

Customizing the Report Container Group display
Customizing the Report Container group display includes modifying:

• the Report Data View display (by default they are displayed vertically).

For example, it is useful with a number of Report Data Views to modify 
the display for a tab view.

• the Report Data View display order.

To customize the Report Container Group display:
1. Access the Report Container Group properties.

 See Accessing the Report Templates and their Constituents.
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2. Select Characteristics.

3. To define the Report Data View display, in the HTML Layout field, select:
• "Horizontal" to display the Report Data Views on the same row.
• "Tab", to display the Report Data Views in tabs.
• "Vertical" to display the Report Data Views in a single column (by default).

4. To modify the Report Data View display order, in the Report Containers section, click 

Reorganize  and drag and drop the Report Containers to the required place.
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5. Click OK.
In the Report Chapter properties, its Definition page gives an overview.

E.g.: the Container Organization shows its "Tab" display.
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REPORT TEMPLATE EXAMPLES

Report Template with a Report Chapter Based on Report Data 
Views
For example, the "Application and Technolgies" Report Template is based on a single Report

Chapter  named "Applications (Rating and Costs)" with:

• a Container Group , which groups two containers on the same row, showing:
• a pie chart based on "application" and "Rating" elements of the "Application 

Technologies" Report DataSet
• a pie chart based on "Cost" and "Vendor" elements of the "Application Technologies" 

Report DataSet
 See How to Group Report Data Views in a Report Chapter.

• a Report Container  showing a table based on the "Application", "Cost", "Number of 
users", "Rating", "Technologies", and "Vendor" elements of the "Application 
Technologies" Report DataSet.
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Each Report DataSet column  is an element that can be used in a Report DataView.
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A report based on this "Application and technologies" Report Template shows the following two
rows:

• the first row displays two pie charts showing:
• application cost by vendor
• applications by rating

• the second row shows a table with "Application", "Rating", "Technologies", "Vendors", 
"Cost", and "Number of users" columns.

Report Template with a Report Chapter Based on a Macro
The Report Templates included in the HOPEX > MEGA folder are mostly based on macros.
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For example, the "LDC - Contextualized report on Business Lines" Report Template:
• includes one Report Chapter:

• "LDC - Contextualized report on Business Lines" , based on the "LDC - 
Contextualized report on Business Lines" macro 

• uses one Report Parameters:

• "Business Line" Report Parameters 
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A report based on the "LDC - Contextualized report on Business Lines" Report Template shows
several charts about the current business line regarding incidents: evaluation of incidents linked to
this business line.
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REPORT TEMPLATE: HOW TO

The following points are covered here:

 Report Template Creation: The Big Picture
 Managing Report Templates
 Customizing a Report Template Style
 Customizing a Table Report Template
 Customizing a Graph Report Template
 Customizing a Gauge Report Template
 Customizing a Tree Report Template
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REPORT TEMPLATE CREATION: THE BIG PICTURE

See:
• Displaying a Table, a Radar/Line/Bar/Pie Chart, a Set of Gauges, or a Word Cloud
• Displaying a Matrix-Bar Chart or a Matrix-Radar Chart
• Displaying a Graph
• Displaying a Gauge
• Displaying a Breakdown, a Dendrogram, a TreeMap, or a TreeTable

Displaying a Table, a Radar/Line/Bar/Pie Chart, a Set of Gauges, or 
a Word Cloud
You can create a Report Template showing a table, a radar chart, a line chart, a bar chart, a
pie chart, a set of gauges or a word cloud:

• from a Report DataSet, or
• using a Report Table View
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From a Report DataSet
To create a Report Template showing a table, a radar chart, a line chart, a bar chart, a pie
chart, or a word cloud:

1. Access a Report DataSet.
2. From the Report DataSet, generate the Instant Report type corresponding to the chart 

type you want to display in the report:
• Breakdown for a pie chart, a bar chart, a set of gauges, or a word cloud. 
• Quantitative for a bar chart, a line chart, or a radar chart. 
• Table for a table.

3. In the Report section, click More  > Save as Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

4. Enter a Name to the report and click OK.
A public Report Template displaying the chart (table, radar chart, line chart, bar
chart, pie chart, or word cloud) is created, with its public Report Table View. They
both have the same name.

 You can access the Report Template in your Home page, from the Custom Report 
Templates tile. It is also stored in the Public Report Template folder.
 Note that Save as Report, generates a report and also a private Report Template, 
which you can access in Private Report Template > My Report Templates folder.

From a Report Table View
You can customize an instant report generated from a Report DataSet as your needs, and save it
as a Report Table View so as to reuse it in a Report Template.

Once saved, you can still modify the Report Table View as needed.

To create a Report Template showing a table, a radar chart, a line chart, a bar chart, a pie
chart, or a word cloud:

1. Access a Report DataSet.
2. From the Report DataSet, generate the Instant Report type corresponding to the chart 

type you want to display in the report:
• Breakdown for a pie chart, a bar chart, a set of gauges, or a word cloud. 
• Quantitative for a bar chart, a line chart, or a radar chart. 
• Table for a table.

3. In the Report section,, click More  > Save As View .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Table View.

A Report Table View is created.
4. You can:

• Create a Report Template using the Report Table View.
• Add the Report Table View to an existing Report Template.

Displaying a Matrix-Bar Chart or a Matrix-Radar Chart
A Report Template can show a matrix associated with its corresponding bar chart or radar chart.
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You can create a Report Template showing a matrix-bar chart or a matrix-radar chart:
• from a Report DataSet
• using a Report Matrix View

From a Report DataSet
To create a Report Template showing a matrix-bar chart or a matrix-radar chart:

1. Access a Report DataSet.
2. From the Report DataSet, generate a Matrix type Instant Report .
3. Select the chart type: Bar chart or Radar chart.

4. In the Report section, click More  > Save as Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

5. Enter a Name and click OK.
A public Report Template displaying two tabs (the matrix and its associated bar/radar
chart) is created, with its public Report Matrix View. They both have the same name.

 You can access the Report Template in your Home page, from the Custom Report 
Templates tile. It is also stored in the Public Report Template folder.
 Note that Save as Report, generates a report and also a private Report Template, 
which you can access in Private Report Template > My Report Templates folder.
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From a Report Matrix View
You can customize an instant report generated from a Report DataSet as your needs, and save it
as a Report Matrix View so as to reuse it in a Report Template.

Once saved, you can still modify the Report Matrix View as needed.

To create a Report Template showing a matrix-bar chart or a matrix-radar chart:
1. Access a Report DataSet.
2. From the Report DataSet, generate a Matrix type Instant Report .
3. Select the chart type: Bar chart or Radar chart.

4. In the Report section, click More  > Save As View .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Matrix View.

A Report Matrix View is created.
5. You can:

• Create a Report Template using the Report Matrix View.
• Add the Report Matrix View to an existing Report Template.

Displaying a Graph
You can create a Report Template showing a graph:

• from a GraphSet Definition, or
• using a Report Graph View
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From a GraphSet Definition
To create a Report Template showing a graph:

1. Access a GraphSet Definition.

2. From the GraphSet Definition properties, Preview page, click More  > Save as 

Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

3. Enter a Name and click OK.
A public Report Template displaying the graph is created, with its public Report Graph
View. They both have the same name.

From a Report Graph View
You can preview a graph from a GraphSet Definition, and save it as a Report Matrix View so
as to reuse it in a Report Template.

To create a Report Template showing a graph:
1. Access a GraphSet Definition.

2. From the GraphSet Definition properties, Preview page, click More  > Save As 

View .
A Report Graph View is created.

3. You can:
• Create a Report Template using the Report Graph View.
• Add the Report Graph View to an existing Report Template.
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Displaying a Gauge
You can create a Report Template showing a gauge:

• from a Query, or
• using a Report Table View

From a Query
To create a Report Template showing a gauge:

1. Access the Queries without mandatory parameters list.
2. Right-click a query and select Documentation > New gauge report.

A report displaying the gauge is created.
A private Report Template is automatically created, with its private Report Value
View. 

 You can access the Report Template in your Home page, from the Custom Report 
Templates tile. It is also stored in the Private Report Template folder.

From a Report Value View
To create a Report Template showing a gauge:

1. Access the Queries without mandatory parameters list.
2. Right-click a query and select Documentation > New gauge report.

A Report Template is automatically created, with its Report Value View. 
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3. You can:
• Create a Report Template using the Report Value View.
• Add the Report Value View to an existing Report Template.

Displaying a Breakdown, a Dendrogram, a TreeMap, or a TreeTable
You can create a Report Template showing a Breakdown, a Dendrogram, a TreeMap or a
TreeTable:

• from a TreeSet Definition, or
• using a Report Tree View

From a TreeSet Definition
To create a Report Template showing a Breakdown, a Dendrogram, a TreeMap, or a
TreeTable:

1. Access a TreeSet Definition.
2. From the TreeSet Definition properties, Preview page, click Instant Report and 

select the renderer type:
E.g.: Breakdown, Dendrogram, TreeMap, or TreeTable.
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3. In the Instant Report, click More  > Save as Report Template .

 Note: if you customize the report display, this customization is not taken into account 
in the Report Template.

A public Report Template displaying the Breakdown map, Dendrogram, TreeMap, or
TreeTable is created, with its public Report Tree View. They both have the same name.

 You can access the Report Template in your Home page, from the Custom Report 
Templates tile. It is also stored in the Public Report Template folder.
 Note that Save as Report, generates a report and also a private Report Template, 
which you can access in Private Report Template > My Report Templates folder.

From a Report Tree View
To create a Report Template showing a Breakdown, a Dendrogram, a TreeMap, or a
TreeTable:

1. Access a TreeSet Definition.
2. From the TreeSet Definition properties, Preview page, click Instant Report and 

select the renderer type:
E.g.: Breakdown, Dendrogram, TreeMap, or TreeTable.

3. Click More > Save As View .
A Report Tree View is created.

4. You can:
• Create a Report Template using the Report Tree View.
• Add the Report Tree View to an existing Report Template.



314

4

MANAGING REPORT TEMPLATES

To create a Report Template, see:
• Report Template Creation: The Big Picture
• Creating a Report Template

To create a Report Data View:
• Report Table View, see:

• Displaying a Table, a Radar/Line/Bar/Pie Chart, a Set of Gauges, or a Word Cloud
• Creating a Report Data View from the Report DataSet

• Report Matrix View, see:
• Displaying a Matrix-Bar Chart or a Matrix-Radar Chart
• Creating a Report Data View from the Report DataSet

• Report Graph View, see:
• Displaying a Graph
• Creating a Report Graph View

• Report Tree View, see:
• Displaying a Breakdown, a Dendrogram, a TreeMap, or a TreeTable
• Creating a Report Tree View

• Report Value View, see:
• Displaying a Gauge
• Creating a gauge-type Report Template from a query

See:
• How to Define Parameters in a Report Template
• How to Group Report Data Views in a Report Chapter
• How to Modify a Report Data View
• How to Define the Filters Displayed in a Report
• How to Duplicate a Report Template
• How to Duplicate a Report Data View
• How to Add Reports to Object Property Pages
• How to Customize the Reporting Page of an Object
• How to Make a Report Creation Available to an Object List
• How to Customize a Report Icon and Name
• How to Manage Availability of Reports
• How to Make a Report Template Available at Report Creation
• How to Define the Report Template Renderer and Illustration
• How to Define the Filters: Categories and Subjects
• How to Find Information Regarding JAVA Macros

See also
• Managing a Report Snapshot
• Organizing the Report Chapters
• Customizing the Report Chapter Export Format
• Customizing Parameter Display
• Customizing the Report Container Group display
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Getting the Parameters available to Customize a Renderer Type
To help you with the parameters available to customize a report according to its renderer type, you
can use the Report Style Parameters report template.

This report details for each renderer type all its available parameters, and where they are used.
 See Report Renderer.

To create the report:
1. Click the Reports navigation menu, then click Create a report.
2. In the Objects filter, select "RendererType".

 Enter "renderer" in the search field.

3. Hover the cursor over the Report Style Parameters tile and click Create a report.
4. Use the filters according to your needs:

• RendererType: select the type(s) of renderer

E.g.: Tree Table and Table, Matrix.
• Apply to: select the item(s) you want to customize
• Parameter Type: select the type of parameter you want to apply

E.g.: Background Color.
• Report Parameter Group: select the group of parameter you want to apply
The report displays the parameters you can use to customize you report according to your
selection.
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How to Define Parameters in a Report Template
Report Template parameters enable to define required elements to build a report. 

Defining parameters in a Report Template based on a macro
For each parameter you must specify:

• the object type that can be instantiated for the report:
• Parameter with MEGA objects
• Parameter with simple types: a parameter with simple types defines the types that 

can take values in the report (e.g.: boolean, date, string). MEGA provides, by default, 
a set of simple types, represented by tagged values. 

 Tagged values play the same role as MetaAttributes but do not belong to the MEGA 
metamodel.

• its multiplicity.
The Multiplicity of a report parameter enables definition of the number of values that can
be associated with the parameter when creating a report. If multiplicity is 1 or 0..1, only
one parameter value can be connected.

To create a parameter in a Report Template based on a macro:
1. Access the Report Template (based on a macro).

 See Accessing the Report Templates and their Constituents.
2. In the Report Template properties, select Parameters.
3. In the Parameters section, click New  and for each parameter define its required 

Characteristics:
• In Local name field, enter the parameter name.
• In Multiplicity field, select the parameter multiplicity.
• (Optional) In the Description pane enter a description.



317

Report Template: How To
Managing Report Templates

4. Select the parameter type:
• Parameter with Mega objects enables connection of MetaClasses that can define 

the parameter. 
For example, for a parameter named "Application Architecture", you can 
connect an application folder, an application, a query returning 
applications.

• Parameter with simple types enables connection of "Tagged Values".
Parameter types correspond to report values. Assigned MetaClasses inherit the "System
report value" abstract MetaClass. 

 For details on abstract MetaClasses, see Abstract Metamodel.
5. Click Next.



318

4

6. If you selected: 
• Parameter with MEGA objects, in the Report Parameter Type pane, click 

Connect  and select the report parameter type(s).

Example: Application.

• Parameter with simple types, in the Tagged Value pane, click Connect  and 
connect the Tagged Value.
Example: to create a parameter that filters the display of certain 
objects in the report connect "Boolean Report Value" Tagged Value.
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7. Click OK.
The input data type the user must enter for the report calculation is defined.

8. If needed:
• configure the parameter to restrict the values the end-user can use

 See Configuring a Report Template parameter.

• customize the parameter display
 See Customizing Parameter Display.

Configuring a Report Template parameter
If needed, you can define the values the end-user can use at report creation. 

Values can be a closed or open list of values, which is defined by the Value definition field:
• Values are suggested (by default) 

The end-user can select values that are in the list, but can add other values if required.
• Values are proposed

The end-user can only select values that are included in the list.
• Values are fixed

The end-user cannot select or add any other values.
• Values are fixed and hidden

The end-user does not see the values.

Value proposition defines how the list of values is computed (through a macro or a query). This
list of values can be computed from another parameter value, which is defined by the Value
Proposition depends on field.

For example: 
The parameters of the List Of Objects Report Template are "Target 
MetaClass" and "MetaAttributes and LegAttribute". This Report Template 
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displays an object list and selected properties (attributes) of the 
analysis parameters, in a table format. 
The list of attributes proposed depends on the MetaClass selected by the 
end-user.

To configure a Report Template parameter:
1. Access the Report Template.

 See Accessing the Report Templates and their Constituents.
E.g.: The List Of Objects Report Template, whose parameters are "Target 
MetaClass" and "MetaAttributes and LegAttribute".

2. In the Report Template parameter properties, display its Default values page.
E.g.: The "MetaAttributes and LegAttribute" parameter.

3. (If needed) Modify the Value definition field.
E.g.: Values are suggested (default), Values are proposed, Values are 
fixed, Values are fixed and hidden.

4. (If the parameter value depends on another parameter) In the Candidates depend on 
field, select Connect Report Parameter and connect the Report Template parameter 
on which the values depend on.

E.g.: "Target MetaClass".



321

Report Template: How To
Managing Report Templates

5. In the Value Proposition, click connect and connect the required query or macro.
 You can connect several queries, in that case select "Favorite query" in the row of the 
query you want to be performed first.

For example: the query "Available MetaAttributes LegAttributes where 
MetaClass"

6. (If you want to display parameters ordered by group) In the Displayed in Group field, 
select the display.

Values are: Parameters, Heatmap, Presentation.

Defining parameters in a Report Template based on Data Views
If the Report Template includes more than one Data View and these Data Views are based on:

• the same Report Data Source Definition:

E.g.: the Application Technologies Report DataSet Definition
By default a single Report Data Source instance is created for the report and associated
parameters are valued at report creation.

• distinct Report Data Source Definitions:
By default as many Report Data Source instances as Report Data Source Definitions are
created for the report and associated parameters are valued at report creation.
In case parameters are of the same type, you can use a Parameter Usage so that the
user is asked to define the parameters only once. 

Example: the "App Tech Tech Vendor" Report Template, based on 
"Application - SI - UC" and "Application Technologies" Report DataSet 
Definitions, uses the "Application to extract" Parameter Usage.
In the Report Template properties > Parameters - Advanced page:

To create a Parameter Usage:
1. Access the Report Template properties.

 See Accessing the Report Templates and their Constituents.
2. Display its Parameters page.
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3. Create a Parameter Usage: double-click the Parameter Usage cell of one Data Source 
Parameter, then click its right oriented arrow and selet Create.

E.g.: "Applications to extract"
The Parameter Usage is created.
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4. Add the Parameter Usage to the other Data Source Parameter: double-click its 
Parameter Usage cell, and use the drop-down list to select the Parameter Usage just 
created.

The Usage Parameters section details the merged: the Parameter Usage created is
listed.

At Report creation only one list of objects is asked to he user.
Before: "Application list" and "Applications to extract" are asked to the 
user, and the charts displayed might not take the same data into account.
After: Only "Applications to extract" is asked to the user, and all the 
charts are based on the same data.
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How to Group Report Data Views in a Report Chapter
By default the Report Containers are displayed in a single column. 

 See Report Chapter and Report Data Views

To modify the display of the Report Containers (e.g.: on a same row, in separate tabs) you need to
create a Report Container Group so as to group Report Data Views in the Report Chapter.

Grouping Report Data Views of a Report Chapter
Prerequisite: the Report Data Views of the Report Chapter are created.

 To create a Report Data View, see Creating a Report Data View.

To group Report Data Views of a Report Chapter:
1. Access the Report Template (based on Data Views) concerned and display its Chapters 

page.
 See Accessing the Report Templates and their Constituents.
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2. Hover the cursor over the Report Chapter and select  New > Report Container 
Group.

3. In the Creation of Report Container Group, enter its Local name.
4. Click OK.

The Report Container Group is added to the report Chapter tree.
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5. Drag and drop into the Report Container group, each of the Report Containers you want 
to group.

Example 1: drag and drop two of the three Report Containers included into 
the Report Chapter.

6. To modify the default Report Container Group display, see Customizing the Report 
Container Group display.

With Report Container Group_1 Organization set to “Horizontal"), this 
Report Chapter display looks like:
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Example 2: drag and drop all of the Report Containers included into the 
Report Chapter.

This Report Chapter display looks like:
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7. To modify the default Report Container Group display, see Customizing the Report 
Container Group display.

Creating a Report Chapter with grouped Report Data Views
Prerequisite: the Report Data Views you want to group in the Report Chapter are created.

 To create a Report Data View, see Creating a Report Data View.

To create a Report Chapter with grouped Report Data Views: 
1. Access the Report Template.

 See Accessing the Report Templates and their Constituents.
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2. Display its Chapters page.
 To add a Report Chapter based on a Data View to the Report Template concerned, 
see Adding a Report Chapter to a Report Template.

3. Select the Report Chapter, and in the bottom pane, right-click the Report Chapter and 
select New > Report Container Group.

4. In the Creation of Report Container Group window, enter its Local name.
5. Click OK.

The Report Container Group is added in the report Chapter tree.
6. Right-Click the Report Container Group and select New > Report Container:

• In the Creation of Report Container window, enter its Local name.
• In Display Content filed, use the drop don arrow to select the report Data View.
• Click OK.
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7. Repeat the Report Container creation steps to add the other Report Data Views.
Example 2: drag and drop all of the Report Containers included in the 
Report Chapter.

By default, this Report Chapter display looks like:
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8. To modify the default Report Container Group display, see Customizing the Report 
Container Group display.

How to Modify a Report Data View
To modify a Report Data View:

1. Access the Report Data View properties
 See Accessing the Report Templates and their Constituents.
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2. Modify the Report Data View properties according to your needs.
 See Report Data View Properties: Matrix and Table.

 See Report Data View Properties: Graph.

 See Report Data View Properties: Tree.

 See Report Data View Properties: Value.
3. For example depending on the Report Data View, in:

• Table, you can modify the table column sort order and/or display order.
• Table, you can delete a table column.
• Table, you can add subtotals on breaks.
• Matrix, you can modify the row or column sort order.
• Matrix, you can modify the Cell value computation.
• Graph, you can add/modify fields on nodes or arcs.
• Tree, you can add/modify fields on nodes.
• Filters, you can delete a filter.
• Characteristics, you can modify its Display.

For a Report Table/Matrix View: table, graphic, or table and graphic.
For a Report Tree View: Breakdown, Dendrogram, TreeTable, TreeMap.

• Characteristics, you can modify its Sharing (private or public, public by default).
• Characteristics, you can define its General Style.

How to Define the Filters Displayed in a Report
You can define filters on Report Table Views, Report Matrix Views, and report Graph Views.

 See Report Data View Properties: Matrix and Table and Report Data View Properties: 
Graph.

To define the filters displayed in a report:
1. Access the Report Data View properties for which you want to define filters.

 See Accessing the Report Templates and their Constituents.
2. In the Filter page, click Add filter. 

The list of available Data Source Elements is displayed.
For example, a column for a Report Table View or a Report Matrix View, a 
node or a field for a Report Graph View.

3. Select the Data Source Element for which you want to add a filter.
4. In the right pane define the filter characteristics:

• _GUIName
• Input type
• Behavior as required.
• Filter Choice
• Shows

 See Characteristics.
5. (Optional) In the filter properties, define the Object Edition Mode.
6. (optional) In the filter properties, select Texts > _Settings to define an initial value or 

a candidate value.
 See Text.
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How to Duplicate a Report Template
The recommended way to create a new Report Template similar to an existing one is to duplicate a
Report Template.

To duplicate a Report Template: 
1. Access the Report Template you want to duplicate.

 See Accessing the Report Templates and their Constituents.
2. Right-click the Report Template and select Manage > Duplicate.
3. Define the Report Template name.
4. Select the duplication name format for your Report Template (Prefix or Suffix).
5. Click OK.

How to Duplicate a Report Data View
To duplicate a Report Data View: 

1. Access the Report Data View you want to duplicate.
 See Accessing the Report Templates and their Constituents.

2. Right-click the Report Data View and select Manage > Duplicate.
3. Define the Report Data View name.
4. Select the duplication name format for your Report Data View (Prefix or Suffix).
5. Click OK.

How to Add Reports to Object Property Pages
You can add object-based reports to the object property pages (Reporting page). 

 To organize the Reports in the Reporting page, see How to Customize the Reporting 
Page of an Object.

Adding a report to the Reporting page of objects is performed from the corresponding Report
Template properties, from its Parameters page.

Adding an object-based Report Template to the object Reporting page
To add a report in an object property pages:

1. Access the Report Template corresponding to the report you want to add to the object 
property pages.

 See Accessing the Report Templates and their Constituents.
Example: "Application - Business Capabilities" Report Template.

2. Display its Parameters page.
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3. In the Data Source Parameters section, for the Meta Collection Parameter concerned 
create its Parameter Usage: click the right-oriented arrow and select Create .
The parameter Usage is automatically created.

E.g.: Application
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4. In the Usage Parameters section, in the concerned parameter row, select Add to 
Objects Property Page.

The report is available in the Reporting property page of the objects concerned (in the
Custom Reports section for custom reports).
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Adding a macro-based Report Template to the object Reporting page
Example: you can add the "Application costs" report in the Reporting 
property pages of all the Portfolios.

To add a macro-based report in an object property pages:
1. Access the Report Template (based on a macro) corresponding to the report you want to 

add to the object property pages.
 See Accessing the Report Templates and their Constituents.

Example: "Application costs" Report Template.
2. Display its Parameters page.
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3. In the concerned parameter row, select Add to Objects Property Page.
A Reporting page including the corresponding report is added to all the object property
pages.

Example: select Add to Objects Property Page for "Portfolio" Report 
Parameter.
In the Property pages of all the portfolios, the Reporting property page 
displays the "Application costs" report.
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4. You can add as many reports as available to the object Reporting property page.
E.g.: "Airport IT Rationalization Evaluation" portfolio Reporting 
property page.

How to Customize the Reporting Page of an Object
In an object property pages, its Reporting page gives access to the reports of the products
accessible by the profile. These reports are sorted in topic folders. 

Example: in the Reporting page of the "Accounts" application, from the 
Repository consistency folder you can launch three reports ("Content 
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Consistency (Scenario)", Content Consistency (Structure), and "Exchange 
Consistency (Structure Scenario)").
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This Reporting page configuration is performed through the Report Display Context
corresponding to a duo "MetaClass - Profile".

E.g.: Application MetaClass - EA Functional Administrator Profile.

In the Reporting page of an object, you can:
• add folders
• add reports to a folder
• organize the reports of a folder

To configure the Reporting page you can:
• create a Report Display Context for the corresponding MetaClass and define for which 

profile(s)
 See Creating a Report Display Context.

• configure the Report Display Context:
• create folders to sort the Report Templates

 See Adding a folder to the Reporting page of an object.

• add Report Templates to a folder
 See Adding a report to a folder of the Reporting page of an object.

• organize the Report Templates of a folder
 See Organizing the reports in a folder (Reporting page).

• add a MetaTest to a Report Template
 See Adding a condition to report availabity (MetaTest on Report Template).
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Creating a Report Display Context
A report display context is MetaClass specific and can apply to one or several profiles.

To create a Report Display Context:
1. In the navigation menus, click Report Definitions > Report Templates > Report 

Display Contexts.
2. Click New. 
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3. Configure the Report Display Context:
• Name: enter its name
• MetaClass: select the corresponding MetaClass
• Profile: connect the corresponding profile

 You can connect several profiles.
E.g.: "Enterprise Architecture - Application" Report Display Context 
dedicated to the Application MetaClass for EA Contributor and EA 
Functional Administrator profiles.

The Report Display Context is added to the Report Display Contexts page. You can
access it:
• By Metaclass folder

e.g.: under Application MetaClass
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• By profiles folder, for each connected profile

E.g.: under EA Contibutor and EA Functional Administrator profiles.

Adding a folder to the Reporting page of an object
In the Reporting page of an object, reports are organized in topic folders.

 A folder including only one Report Template is not displayed, i.e. the report is 
available at Report Folders section root, below the folders.

The folder can be displayed or hidden.

To add a folder to the Reporting page of an object:
1. Access the Report Display Context.

 See Accessing Report Display Contexts.

2. Hover the cursor hover the Report Display Context, and click Open in new tab .
3. In Local Name, enter the name of the folder you want to add. 
4. Click OK.

The folder is created.
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5. To display the folder in the Reporting page of the corresponding objects, in the 
corresponding Display Folder cell select "Yes".

If the folder is empty it is not displayed in the Reporting page.
If the folder includes only one report, it is not displayed in the Reporting page, the report
is available at Report Folders section root, below the folders.

6. To:
• add reports in the folder, see Adding a report to a folder of the Reporting page of an 

object.
• organize the reports in the folder, see Organizing the reports in a folder (Reporting 

page).

Adding a report to a folder of the Reporting page of an object
Once a report is available in the Reporting page of an object you can add it to a folder of the
Reporting page of the object.

 You can also remove a report from a folder.
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Notes:
• A folder including only one report is not displayed, i.e. the report is available at the 

Report Folders section root.
• A report is available only once in the Reporting page: if a Report Template is added to 

several folders, it is available in only one of them (in the last created Report Display 
Context, or in the last created folder).

 A Report Display Context folder may include Report Templates that are not related to 
the MetaClass concerned, to see the MetaClass related Report Template, see Viewing the 
Report Display Context configuration result.

Prerequisite: the report is available in the Reporting page of an object, see How to Add Reports
to Object Property Pages

To add a report to a folder of the Reporting page of an object:
1. Access the Report Display Context.

 See Accessing Report Display Contexts.
2. In its Characteristics page, Reporting Page Content section, hover the cursor hover 

the folder concerned, and click Open in new tab .
3. Display its Items page.
4. Click Connect and select the report(s).

E.g.: "Application - Technologies" and "Application - Business 
Capabilities" custom Report Templates.

Reports are available in the Reporting page of objects concerned, in the folder selected.
E.g.: the Reporting page of the AirportMega.com Application, shows "My 
best reports" folder with "Application - Technologies" and "Application - 
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Business Capabilities" Reports. They are no longer in the Custom reports 
section.
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Note: if you remove "Application - Technologies" Report Template from My best Reports folder and
add it to Impact & Lineage folder, "Application - Business Capabilities" report is at the root of report
Folders and its folder is not displayed.

Organizing the reports in a folder (Reporting page)
To organize the reports displayed in the Reporting page of an object:

1. Access the Report Display Context.
 See Accessing Report Display Contexts.

2. In its Characteristics page, Reporting Page Content section, hover the cursor hover 

the folder concerned, and click Open in new tab .
3. Display its Items page.

4. Click Reorganize  and drag and drop the reports as required
5. Click OK.
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Adding a condition to report availabity (MetaTest on Report Template)
On top of the duo MetaClass-Profile, you may need to a add a condition to the report availability.

E.g.: the report may depend on a portfolio.
This condition is defined through a MetaTest added to the Report Template.

The availability of a report in the Reporting page is based on this MetaTest, which accepts the
current occurrence as input.

If the result of the corresponding test is false, the report is not displayed.

Prerequisite: the required MetaTest is already created, in HOPEX Studio with HOPEX Customizer
profile, the only profile allowed to create macros.

To add a condition to report availability:
1. Access the Report Template properties.

 See Accessing the Report Templates and their Constituents.
2. Display its Complement page.
3. Right-click MetaTest folder and select Connect.
4. Find the required MetaTest and click Connect.

 If you are in HOPEX Studio with HOPEX Customizer profile, you can click 
Create to create the MetaTest.

E.g.: with this MetaTest, the report is only available for an application 
with "In house" Application type.

To create a MetaTest:
1. Connect to HOPEX Studio (with HOPEX Customizer profile).
2. Access the Styles page: click Report Definitions > Teport templates > Styles.
3. Expand MetaTest folder.
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4. Hover the cursor over All MetaTests folder and click  > New >MetaTest.
5. Create the MetaTest:

• Name: enter a name
• Tested MetaClass: click the right oriented arrow and select the concerned MetaClass
• click OK

6. Display the MetaTest properties: expand the folder corresponding to your tested 
MetaClass, and click your MetaTest.

7. In Texts > test Expression, enter the test code.

Viewing the Report Display Context configuration result
Notes:

• A folder including only one Report Template is not display, i.e. the report is available at 
the Report Folders section root.

• A report is available only once in the Reporting page: if a Report Template is added to 
several folders, it is available in only one of them (in the last created Report Display 
Context, or in the last created folder).

 A Report Display Context folder may include Report Templates that are not related to 
the MetaClass concerned, to see the MetaClass related Report Template, see Viewing the 
Report Display Context configuration result.

To view the Report Display Context configuration result:
1. Access the Report Display Context.

 See Accessing Report Display Contexts.
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2. Display its Reporting page.
E.g.: The Enterprise Architecture - Application Report Display Context 
includes "My best Reports" folder with three reports.

 Although "Application Impact Graph" Report Template is included in "My best 
reports" folder of "Enterprise Architecture - Application" Report Display Context it is not 
available in this folder as already included in the "Impact & Lineage" folder.

3. If needed, use the filters to filter the display.

How to Make a Report Creation Available to an Object List
From an object list you can create Instant Reports. 

You can customize the list of Instant Reports available by adding specific reports, which are
available on this object list. 

Example: together with the Instant Reports available for a list of 
Business Capabilities, Business Processes, or Organizational Processes, 
you can add the "Execution and Performance HeatMaps" report.
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To make a report creation available at Instant Report creation from an object list:
1. Access the Report Template (based on a macro) corresponding to the report you want to 

provide at Instant Report creation.
 See Accessing the Report Templates and their Constituents.

Example: "Project Management" Report Template.
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2. In its Parameters page, Parameters section, in the required Report Parameter row 
double-clic its Add to Instant Reports field and select "Always" or "Only Multiple 
Objects" according to your needs.

Example: "Project Scope" Report Parameter, which is connected to the EA 
Project and Folder of EA Projects MetaClasses.

The selection of the report creation corresponding to the Report Template concerned is
available at Instant Report creation from the object list.
You can add as many reports as available on the object list.

Example: when you click Instant Report from a an object in a list of EA 
projects the "Project Management" report is also available.
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You can customize the report icon: modify the report icon image and name.
 See How to Customize a Report Icon and Name.

How to Customize a Report Icon and Name
You can customize the report icon and name displayed:

• modify the default report icon image 
• modify its name (_GUIName)

 At report creation, using the Search by name filter to find the Report Template, the 
search is performed on both names (name and _GUIName).

To customize the report icon and/or name:
1. Access the Report Template properties.

 See Accessing the Report Templates and their Constituents.
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2. In the Characterictics page:
• In the Identification section, _GUIName field, enter a name.
• Click Update Image and select the image (format: ico, bmp, gig, png, or jpg).

3. Click OK.
For example, you can customize the "Project Management" Report Template 
icon and define its _GUIName as "PM".
The report appears as follows in the Instant Report list.

 See How to Make a Report Creation Available to an Object List.

How to Manage Availability of Reports
You can use a Report parameter to:

• add reports to an object property pages (Reporting page).
 See How to Add Reports to Object Property Pages.

• make the creation of reports available at Instant Report creation from an object list.
 For an example, see How to Make a Report Creation Available to an Object List

How to Make a Report Template Available at Report Creation
Only public Report Templates are available at report creation.
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Saving an instant report as:
• a Report Template, by default the Report Template created is "public".
• a report, by default a Report Template is also automatically generated, but is "private".

To make a Report Template available at report creation:
1. Access the Report Template properties.

 See Accessing the Report Templates and their Constituents.
2. In its Characteristics page, set its Report Template Sharing to "Yes".

The Report Template is available at report creation.

How to Define the Report Template Renderer and Illustration
The renderer type and its illustration are automatically defined for HOPEX Studio reports, but have
to be defined manually for Java reports.

Also if your Report Template includes several renderers (for example with several chapters), you
might want to change its multi-renderer illustration for one of its renderers. 

If can also update the illustration for another one.

To define the Report Template renderer and illustration:
1. Access the Report Template properties.

 See Accessing the Report Templates and their Constituents.
2. In the Characterictics page, Illustration section:
3. In the Renderer table, click Connect and select the renderer displayed in the report.

The illustration is also automatically added.
By default the renderer is selected as Main renderer.

 You can connect several renderers.
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4. (If several renderers) By default each render is selected as Main renderer, and the 
illustration is a multi-renderer one. 

If you want to favor one renderer, clear the other ones.

5. To change an Illustration, click Update illustration and select the MetaPicture.
The default Metapicture name format is:
rt_<renderer type>
e.g.: rt_bowtie
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How to Define the Filters: Categories and Subjects 
The Subjects and Categories filters available to the end-user to filter the Reports and Report
Templates (in the report access and creation pages) are defined in the Report Template properties:

 See PLATFORM - Common Features > Documentation > Generating Documentation 
> Generating Reports documentation.
 See Report Template properties: Characteristics.

• The Categories field has to be filled in manually.
• The Subjects field is automatically defined for HOPEX Studio reports, but has to be filled 

in manually for Java reports.

To define the Categories and Subjects fields:
1. Access the Report Template properties.

 See Accessing the Report Templates and their Constituents.
2. In the Characterictics page, expand the Subjects & Categories section.
3. Add values to the corresponding fields:

• Categories are domains considered in the report
• Subjects are MetaClasses that are displayed in the report.

e.g.: ITPM - Application Environment Graph Report Template.

How to Find Information Regarding JAVA Macros
You can create macros either in VB Script or Java format.

To create a Java macro, see the following HOPEX Studio Technical Articles:
• Writing Java Report Chapters
• All about starting with APIs
• API - JavaDoc

 The Java API help is also supplied with HOPEX in JavaDoc format.
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To read the Java API help in HOPEX Windows Front-End:
1. In <HOPEX Installation>\java, expand doc file.

E.g. <HAS instance>\shadowFiles\hopex.core\17.2.0+xxxx\java
2. Unzip "mj-api.doc.zip" and "mj_anls.doc.zip in the HAS instance Shared repository.
3. Open "index.html" page.
4. Click Ok.
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CUSTOMIZING A REPORT TEMPLATE STYLE

See:
• How to Customize a Report Template Style
• How to Create a Report Style
• How to Apply a General Style
• How to Customize a Report Color Palette

How to Customize a Report Template Style
You can customize a Report Template style using a report used as a style template. This
customization is available for reports based on macros as well as for reports based on Report Data
View(s). 

Prerequisite: create a test report and customize its style. This test report will be associated with
the Report Template so as to define the style parameters that are applied to all the reports
generated from this Report Template.

 To customize the test report, see Common Features: Customizing your Reports (Web 
Front-End) documentation.

To customize a Report Template style:
1. Access the Report Template properties.

 See Accessing the Report Templates and their Constituents.
2. Display the Report Template Style page.
3. In Report field click the arrow and select Connect.
4. Select the test report you created.
5. Click OK.

 To cancel the customization, in the Report field, click the arrow and select Reset to 
delete the test report association with the Report Template.

How to Create a Report Style
You might need, for example, to create a general Report Style to apply it at Report View level. This
general style applies to a single Report Renderer type.

 See Report Renderer.

If you need to create a specific style or a conditional style to apply it at Report Data View element
level (Report table/Matrix Column level or Report Graph Node/Arc level), see How to Define the
Filters Displayed in a Report or How to apply a Conditional Style to a Graph dedicated sections.

To create a report style to be applied at Report View level:: 
1. Access the Report Styles.

 See Accessing the Report Templates and their Constituents.

2. Hover the cursor over the Public Report Styles folder and click  New > Report 
Style.
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3. In the Name field enter a name that describes the style, so that it can be easily reused.
E.g.: Graph_ArcColor_LabelColor_NodeFillColor to create a general style, 
applying to a graph renderer, and defining arc, label, and node fill 
colors.

4. Click Connect.
5. In the first drop-down menu select the Renderer Type Parameter.

E.g.: "Renderer GraphChart" Parameters if you want to create a general 
style that applies to a graph renderer.

The list of parameters is filtered according to the renderer type selected.
E.g.: graph parameters.

6. (If needed) Click the Type or Applies to column header to sort the parameters.
E.g.: click the Type column header to get the set of "Graphic Element 
Color" type parameters.

7. Select the parameter you want to add to the style.
 You can select several parameters.

E.g.: select Node Fill Color, Label Color and Arc Color style parameters.
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8. Click Connect.
The selected parameters are connected to the style.

9. Click OK.
The style is available in the Public Report Styles folder.
Any user can add it as a general style to a Report Data View of the same renderer type.

10. Access the Report Style properties to configure its parameters.
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11. In its Characteristics page define the parameters.
E.g.: define a color for the nodes, the labels, and the arcs.

12. You can apply the style at Report Data View level.
 See How to Apply a General Style section.

For example, when you apply this style to a Report Graph View, the 
changes in the graph display are as follows. 

If you want to apply a specific label color according to the node type, 
you need to apply a style at Report Graph View Node level, see How to 
apply a Conditional Style to a Graph section.
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How to Apply a General Style
You can apply a general style at Report Data View level for Matrix, Table, Graph and Tree type
Views. 

 For details on Properties of these Report Data Views, see Report Data View 
Properties: Matrix and Table, Report Data View Properties: Graph, Report Data View 
Properties: Tree.

Particularly for a graph renderer, you can apply a general style at Report Graph View level. In that
case the style applies to all of the graph layers of the View. 

 If you want to add a more specific style that you can apply (on condition or not) at 
Report Data View element level (Report table/Matrix Column level or Report Graph Node/
Arc level), see How to Define the Filters Displayed in a Report or How to apply a 
Conditional Style to a Graph dedicated sections.

Prerequisite: the Report Style is created, you can either select one of the available public Report
Styles, or create a public Report Style, see How to Define the Filters Displayed in a Report section. 

To apply a general style to a graph:

1. Access the Report Graph View  properties.
 See Accessing the Report Templates and their Constituents.

2. In its Characteristics page > General Style field, use the drop-down list to select the 
style you want to apply to the graph.

E.g.: "Graph - Arc Green" style for green arcs.
All the graphs belonging to the View display green arcs.
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How to Customize a Report Color Palette
You can create your own report color palette. For this purpose you have to duplicate an existing
palette and modify it. 

You can create a new palette for another library.

To create a color palette:
1. Connect to HOPEX (Windows Front-End) with HOPEX Customizer profile.
2. From HOPEX menu bar, select View > Navigation Windows > Utilities.
3. Expand HOPEX Palette folder.
4. Right-click the palette that will provide the basis for your palette and select Manage > 

Duplicate.
5. (If needed) In the Library pane, select the option for duplicating the palette in another 

library and from the drop-down list select the target library.
6. Select the duplication name format for your palette (Prefix or Suffix).
7. Click OK.

The color palette is duplicated. You can customize it.
8. Access the color palette properties.
9. From the Characteristics tab, in the Palette Type, select "Report Palette".
10. From the Color set tab, modify each HOPEX Palette Color as needed.
11. Click OK.
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CUSTOMIZING A TABLE REPORT TEMPLATE

See:
• How to Apply a Conditional Style to a Column
• How to Add Sub-totals in a Table Break
• How to Add a Grand Total Break (Use case)
• How to Apply a Conditional Style to a Pie Chart
• How to Customize the Empty Label in a Pie Chart

See also Customizing a Report Template Style.

How to Apply a Conditional Style to a Column
Conditional styles on columns apply to Report Table Views and Report Matrix Views.

This enables to apply a conditional style on a column.

To apply a conditional style to a column:

1. Access the Report Table Column  (or Report Matrix Column ) properties.

 Access and expand the Report Table View  or Report Matrix View  concerned, 
see Accessing the Report Templates and their Constituents.

2. Display its Style page.
 See Report Table Column Properties.

3. Click Add .
4. Enter a Name to your conditional style.
5. In the Style Parameters list, select the style you want to add on condition.

 Only the style parameters applying to the Report Data View renderer are listed. You 
can sort them according to a specific column (for example, according to the Applies to 
column) or use the list filtering tool to filter the styles.
 You can select several styles.

6. Click Next.
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7. In the Style Parameters list, select the style parameter and configure it in the right 
part.

Example: for a Cell Background Color or a Series Color, in Value keep 
"Fixed" and select a color.

8. Click OK.
9. In the Style page, select your style row.
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10. In This style applies on the following condition:
• in the Name field enter a name describing the condition
• in the pane enter the code for your condition.

 For code syntax, see Report Style Condition Properties.
Example: 
For a column with numerical values, to add a condition style on values 
greater than 80000 enter:
[1:ConditionGroup]
1=value,&Current,>,80000
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How to Add Sub-totals in a Table Break
In Table type Report Data Views, where a grouping is defined, you can add break rows in tables
when the value of a given column changes. 

 See Table (Report Table View).

In the Break rows, you can display computation results performed on each column including
numerical values. 

To add sub-totals in a table:
1. Access the Report Table View properties: Table.

 See Accessing the Report Templates and their Constituents.
2. Click Add subtotals to add a break.

The break is created.
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3. Select the break row, and define its characteristics:
• (optional) in Title field, enter the title to be displayed in the break.
• in Total by, select the grouping column.
• in Operation Title, select the subtitle display (values are: Automatic/Given/No 

subtitle).
• in Break Type, select the break types you want to add (sub-total only or sub-total 

and grand-total).
 See Table (Report Table View).

The break row is defined with a Title.
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4. Hover the cursor over the break and click Add computation :
• in the Column Concerned field, select the column concerned by the computation
• In the Function field, select the computation to be applied to the column.

For example, you can group the table rows according to Vendor. 
You can add two break rows after each group (Vendor), and for each 
vendor, you can display the number of Technologies and the sum of costs.

You get the following report:
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How to Add a Grand Total Break (Use case)
In a Table-type Instant Report generated from a Report DataSet, the end-user can add breaks to
the table columns. This break type is "Subtotal only".

 See Defining the columns in a table-type instant report.

In HOPEX Studio, you can modify the break type as "Subtotal and Grand total", which adds subtotal
breaks and a grand total break.

This customization is performed in the Report Table View properties.

To add a break with grand total to a table:
1. Generate a table-type Instant Report from a Report DataSet.

For example use the "Application Technonologies" Report DataSet 
Definition to generate a Table-type Instant Report from its Report 
DataSet.

2. In the Report section, click More  > Save as Report Template .
3. In the Name field, enter your Report Template name.

A public Report Template is created, with its public Report Table View. They both have
the same name.

4. Access the Report Table View properties.
 The Report Table View is accessible from the Report Data Views > Public Data 
Views > Report DataSet Definition folder (Report Definitions > Report 
Templates).
 The Report Template is accessible from My Report Template folder (Report 
Definitions > Report Templates).

5. Display its Table page.
6. Click Add subtotals to add a break.
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7. Select the break row, and define its characteristics:
• (optional) in the Title field, enter the title to be displayed in the break.
• in the Total by field, select the grouping column.

Example: select Application to add a break on applications.
• (optional) in the Operation Title field, select the subtitle display (values are: 

Automatic/Given/No subtitle).
• in the Break Type field, select the "Sub-total and Grand total" break type.

 See Table (Report Table View).
The break row is defined.

8. Hover the cursor over the break and click Add computation .
9. In the Function field, select the computation to be applied to the column.

 If you add a Title (and you selected Operation Title: "Given subtitle"), this title is 
added right above the computation number.
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10. Test the report: in the Report Template tree, right-click the Report Template and select 
Test:
All total breaks and grand total row are displayed.

How to Apply a Conditional Style to a Pie Chart
To add a conditional to a pie chart, you need to apply a conditional style to the Report Table Column
property of the Report Table View. 

To apply a conditional style to a pie chart:

1. Access the Report Table Column  properties.

 Access and expand the Report Table View  concerned, see Accessing the Report 
Templates and their Constituents.

2. In the Report Table Column properties, display its Style page.
 See Report Table Column Properties.

3. Click Add .
4. Enter a Name to your conditional style.
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5. In the Style Parameters list, select the style you want to add on condition.
 Only the style parameters applying to the Report Data View renderer are listed. You 
Redcan sort them according to a specific column (for example, according to the Applies 
to column) or use the list filtering tool to filter the styles.
 You can select several styles.

6. Click Next.
7. In the Style Parameters list, select the style parameter and configure it in the right 

part.
Example: for a Cell Background Color or a Series Color, in Value keep 
"Fixed" and select a color.

8. Click OK.
9. In the Style page, select your conditional style row.
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10. In This style applies on the following condition:
• in the Name field enter a name describing the condition
• in the pane enter the code for your condition.

 For code syntax, see Report Style Condition Properties.
Example: for a column with ranking, to add a conditional style on "0 
Star" ranking
[1:ConditionGroup]
1=value,&Current,=,0
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How to Customize the Empty Label in a Pie Chart
Pie chart reports may include an empty series.

E.g.: the pie chart showing the breakdown of applications according to 
technologies, displays an [Empty] series corresponding to the 
Applications with no Technology.

You can customize this [Empty] label.

This customization is performed, in HOPEX Studio, in the Report Table View properties.

To customize the label [Empty]:
1. Generate a Breakdown-type Instant Report from a Report DataSet.

For example use the "Application Technonologies" Report DataSet 
Definition to generate a Breakdown-type Instant Report from its Report 
DataSet.

2. In the Report section, click More  > Save as Report Template .
3. In the Name field, enter your Report Template name.

A public Report Template is created, with its public Report Table View. They both have
the same name.

4. Access the Report Table View properties.
 The Report Template is accessible from My Report Template folder (Report 
Definitions > Report Templates).

5. In its Text page, display _Settings tab.
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6. Enter the following code:
Emptylabel=EmptyMessageContent

Where "EmptyMessageContent" is a _Code Template, whose Translatable _Code
Template value replaces the [Empty] label.

For example, the report shows "No Technology" instead of "Empty" for 
applications that are not linked to any technology.
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CUSTOMIZING A GRAPH REPORT TEMPLATE

See:
• How to apply a Conditional Style to a Graph
• How to Modify the Arc Display in a Graph
• How to Replace Node Names by Property Values in a Graph
• How to Group Arcs in a Graph
• How to Hide the Path Intermediate Nodes

See also Customizing a Report Template Style.

How to apply a Conditional Style to a Graph
You can apply a style to a graph:

• at Report Graph View level, so that the style applies to all of the arcs and nodes in the 
graph.

 In that case, see How to Apply a General Style section.

• at each Report Graph View element level, i.e. at each Arc level and each Node level.
At View element level you can add a condition to the style, else the style is always applied.

The condition can apply to:
• node value

The condition can concern:
• the object associated with the node 
• any field value of the node
• any property of the object field value. 

• path value
The condition can concern:
• any field value of node 
• any field value of arc of the path
• any node of the path.

• grouped arcs
The condition is available on arc.

Configuring the Report Graph Layer
To customize the arc style and/or the node style, you must configure the Report Graph Layer to
which they belong beforehand.

To configure the Report Graph Layer:

1. Access the Report Graph View  properties.
 See Accessing the Report Templates and their Constituents.

2. Display the Graph page.
3. In the Report Graph Layer list, select the Report Graph Layer you want to configure.
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4. In the Nodes of the Graph Layer list, click New  and configure each node as 
follows:
• In the Local name field, enter its name.

 E.g.: Appli, Techno.

• With the GraphSet Node Description drop-down list, select its associated 
GraphSet Node.

 E.g.: Application, Technology.
You can apply a conditional style to the node.

 See Applying a conditional style to a node.

5. In the Arcs of the Graph Layer list, click New  and configure the arc as follows:
• In the Local name field, enter its name.

 E.g.: Appli-Techo

• Keep the Arrow Direction and Visibility default values (you may modify them later 
if needed).

 To modify the arc display, see How to Modify the Arc Display in a Graph

• In the GraphSet Arc drop-down list, select its associated GraphSet Arc.
 E.g.: Appli-Techno.

You can apply a conditional style to the arc.
 See Applying a style to an arc.

Applying a style to an arc
To apply a style to an arc, you need to create a style and define it with as many style parameters
as needed:

• arc color
• arc thickness
• arc line curvature

E.g.: curved, straight.
• arc line style

E.g.: dotted, dashed, line.
• arc start and/or arc end

E.g.: dot, empty arrow, filled diamond, half arrow.
Each style parameter value can be:

• fixed
• dependent on a field, or
• dependent on the number of grouped arcs 

If needed, you can apply the style on a condition based on a field of the arc, else the style always
applies.

Prerequisite: The Report Graph Arc is available, see Configuring the Report Graph Layer.
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To apply a style to an arc:

1. Access the Report Graph Arc  properties.

 Access and expand the Report Graph View  concerned, see Accessing the Report 
Templates and their Constituents.

E.g.: "App-Techno" arc, representing the arc between Application and 
Technologie.

2. In the Report Graph Arc properties, display its Style page.
3. Click Add .

 Click Connect if the style you want to add already exists.
4. Enter a Name to the style.

E.g.: "Dashed arc".
5. In the Style Parameters list select a style.

 Only the style parameters applying to a graph (renderer of a Report Graph View) are 
listed. You can sort them according to a specific column (for example, according to the 
Applies to column) or use the list filtering tool to filter the styles.

E.g.: select Arc Line Style.
 You can select several styles.

6. Click Next.
7. In the Style Parameters list select a style to configure it, and either:

• in the Value field select "Fixed, and in the field that appears select the value.

E.g.: for Arc Line Style, select "Dashed".
or
• in the Value field select "Field, and in the Field field select the field on which is based 

the style.
or
• in the Value field select "Number of grouped arc". 
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8. Click OK.
The style is applied to the arc.

The graph displays dashed lines for all of its arcs.

There is no field on arcs between Applications and Technologies (i.e. no MetaAttribute
available on the MetaAssociation Application-Technology), so that in this example, a
conditional style cannot be applied.

Applying a conditional style to a node
To apply a style to a node, you need to create a style and define it with as many style parameters
as needed: 

• node size
• node border color
• node fill color

Each style parameter value can be:
• fixed, or
• dependent on a field

If needed, you can apply the style on a condition based on a field of the node, else the style always
applies.

Prerequisite: The Report Graph Node is available, see Configuring the Report Graph Layer.

To apply a conditional style to a node:

1. Access the Report Graph Node  properties.

E.g.: "App" node, representing Applications.
 Access and expand the Report Graph View  concerned, see Accessing the Report 
Templates and their Constituents.

2. In the Report Graph Node properties, display its Style page.
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3. Click Add .
4. Enter a Name to the style.

E.g.: "Red filled node" to create a style showing a red filled node when 
a condition is satisfied.

5. In the Style Parameters list select a style.
 Only the style parameters applying to a graph (renderer of a Report Graph View) are 
listed. You can sort them according to a specific column (for example, according to the 
Applies to column) or use the list filtering tool to filter the styles.

E.g.: select "Node Fill Color".
 You can select several styles.

6. Click Next.
7. In the Style Parameters list select a style to configure it, and either:

• in the Value field select "Fixed, and in the field that appears select the value.

E.g.: for Node Fill Color, select a red color.
or
• in the Value field select "Field, and in the Field field select the field on which is based 

the style.
8. Click OK.

The style is applied to the corresponding nodes.
All the "App" nodes of the graph are filled with red color.

9. To apply the style (e.g.: "red filled node") to the node on condition: in the Report Graph 
Node properties > Style page, select the style row.
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10. In the bottom page, in the Name field, enter a name for the condition.
E.g.: "SLA critical" to apply a condition when SLA level value is 
"Critical".
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11. In the pane enter the code for the condition:
 For code syntax, see Condition on value (Report Graph View element).

For example, to emphasize "App" nodes with a red fill color when the "SLA 
level" of the corresponding Application is "Critical", enter:
[1:ConditionGroup]
1=Value,<SLA level field>,=,C

 To enter the "SLA level" field, use the Intellisense tool (press [Ctrl]+[Space] keys) 
and select Insert a report Data Source Filterable Element and click OK. In the Find 
Objet field, enter "SLA" and select the "SLA level" GraphSet Field Definition.

 In that case "SLA level " Application attribute is a field of the Graph node in 
the "Applications and Technologies" GraphSet Definition.

The conditional style is defined:

The conditional style is applied.
In the graph, only the "App" nodes of the graph, representing 
Applications that have their "SLA Level" to value "Critical" are filled 
with red color: here "Account Management" Application.



386

4

How to Modify the Arc Display in a Graph
A path is a kind or arc and is managed as an arc. The following procedures apply to arcs or path-
based arcs.

You can modify the arc display as follows:
• arc direction

• reverse the arc direction 

Arc Direction value: Reverse
• do not display the direction

Arc Direction value: No Arrow
• arc visibility

Visibility value: No (to hide the arc)
Prerequisite: The Report Graph Arc is available, see Configuring the Report Graph Layer.

To modify the arc display in a graph:

1. Access the Report Graph Arc  properties.

 Access the Report Graph View  and expand its Report Graph Layer  concerned, 
see Accessing the Report Templates and their Constituents.
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2. In its Characteristics page, modify the arc as required:
• In the Arc Direction field, use the drop-down list to select the new value.
• In the Visibility field, use the drop-down list to select the new value.

How to Replace Node Names by Property Values in a Graph
In the graph, you might want to identify the nodes through one of their properties instead of their
names.

For example instead of displaying the application names, you can display 
their codes.

To display a property value instead of the node name:
1. Access the Report Graph View.

 Access the Report Graph View  concerned, see Accessing the Report Templates 
and their Constituents.

2. In its Graph page, select the Report Graph Layer concerned.
3. In the Nodes of the Graph Layer, add the node concerned (if not already added).

E.g.: App
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4. In the Fields of the node list, add the field concerned if not already added, and in the 
row of the field concerned, use the drop-down list to set Replace Name to "yes".

In the graph, applications are identified through their codes.
E.g.: MEGA BANK Mobile app code is CO-234

How to Group Arcs in a Graph
You can group arcs (or path) of the same type or arcs carrying the same field value or the same
object value. 
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The Grouping on values are:
• (by default) "All arcs"

Groups together all of the arcs matching the GraphSet Arc Definition between two node
instances.

• "By field"
Groups together all of the arcs carrying the same field value. The grouping field must be
displayed either on the graph or in a tooltip.

 If the field is a multivalued attribute, its picture is shown in the tooltip.

 Restricted to one object type.

• (path-based arc only) "By object"
Groups together all of the arcs carrying the same objects. 

To group arcs of the same type:

1. Access the Report Graph Arc  properties.

 Access the Report Graph View  and expand its Report Graph Layer  concerned, 
see Accessing the Report Templates and their Constituents.

2. In its Characteristics page.
3. In the Grouping specifications section, in the Grouping on field, use the drop-down 

list to select the grouping criteria.
4. If you selected a grouping:

• By field: in the Object or Field field, use the drop-down list to select one of the 
available fields of the nodes.

• By object: in the Object or Field field, use the drop-down list to select the object.

 You can set a display on details of your arc grouping

Setting a display on details of an arc grouping
From an arc grouping tooltip, you can display its detailed list of objects, either:

• (path-based arc only) the list of objects of one of its intermediate nodes (Nodes), or
• the list of the objects represented by one of the fields of the arc (Object field of a 

node)
 Note: in a path, you can only add fields on its intermediate nodes (not its 
intermediate arcs).

When the end-user clicks Click to see details  (displayed in the arc grouping tooltip), the list
of objects is displayed in the Search and Result window.
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To set a display on details on an arc grouping:

1. Access the Report Graph Arc  properties. The arc is a path.

 Access the Report Graph View  and expand its Report Graph Layer  concerned, 
see Accessing the Report Templates and their Constituents.

2. Display its Characteristics page.
3. In the Grouping specifications section, in the Details on field, use the drop-down list 

to specify the object you want to display.
4. In the Object field, use the drop-down list to select the object.

How to Hide the Path Intermediate Nodes
By default the path intermediate nodes are displayed. 

If needed, you can change this default behavior and not display the path intermediate nodes. In this
case the path appears as an arc.

Hiding the path intermediate nodes is useful when you are only interested in the fields of these
nodes. That way, intermediate nodes are not displayed but you can display their fields on the path
(arc).

You can modify the Display value to:
• "Always detailed" (default value)
• "Never detailed": details are never displayed

To modify the path display:

1. Access the Report Graph Arc  properties. The arc is a path.

 Access the Report Graph View  and expand its Report Graph Layer  concerned, 
see Accessing the Report Templates and their Constituents.

2. Display its Characteristics page.
3. In the Path specifications section, in the Display field, use the drop-down list to select 

the display type.
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CUSTOMIZING A GAUGE REPORT TEMPLATE

 See also Customizing a Report Template Style.

How to Create and Customize a Gauge Report Template
You can create a gauge Report Template, where the gauge displays:

• an occurrence count
In this case occurrences are retrieved through a query, and the Report Template is based
on a Report Value View.

 See Creating a gauge-type Report Template from a query.

 Using queries to create gauge Report Templates does not imply time consuming 
computation as with Report DataSets.

• a computed numeric value
In this case the computed numeric value is retrieved from a Report DataSet, and the
Report Template is based on a Report Table View.

 See Creating a Report Data View from the Report DataSet, then access the Report 
Table View properties:
- in its Characteristics page, set Display: "Graphic" and Chart Type: "Gauge Chart".
- in its Chart page configure the gauge, see Report Data View Properties: Value.
 Note that, from a Report DataSet, end-users can create Instant Reports showing a 
set of gauges.

You can customize the gauge Report Template via its Report Data View properties.

Example: applications in deployment

You can create a gauge showing the number of applications in deployment. At creation the gauge
range is 0-<number of applications in the repository>.

You can still display the number of applications in deployment and customize the gauge, i.e.
modifying its minimum and maximum values, for example: 

• In the minimum value you can display the number of applications in production. 
So that you can see the number of applications that you can shortly put in deployment.

• In the maximum value you can display the number of applications with a cost line. 
So that you can check if you have applications costing money (i.e. applications with cost
line but not in production).

To create and customize a gauge Report Template displaying applications in deployment:
1. In HOPEX Report Studio navigation menus, click Report Definitions and in Data 

Sources, select Queries.
 See Logging in to HOPEX Report Studio Desktop.

2. In the Queries without mandatory parameters list, right-click the "ITPM - Get 
Applications with Deployment" query and select Documentation > New gauge 
report.
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3. In the Name field, enter a name for your report.
E.g.: Use case 1.

4. Click OK.
The gauge report is displayed.
Its Report Template and associated Report Value View are also automatically created.

In this example, 58 applications (out of 200) are in deployment.

5. Access the Report Value View properties to customize the gauge: from its Report 
Template: Report Definitions: Report Templates > My report Templates folder.
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6. In its Chart page, customize the gauge as follows:
• in the Min value field, select the "Application in production" query.
• in the Max value field, select the "ITPM - Application with cost Line" query.
• in the Drill-down field, select "Yes".
• in the Specific Drill-down, select the "ITPM - Application with cost Line" query.
The _Settings pane automatically displays the customization.
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7. Refresh the report to see your modifications.
For example:
- the minimum is now 50 and represents the number of applications in 
production, which means that 8 applications are on their way to 
deployment.
- the maximum is now 129 and represents the number of applications with a 
cost line, which means that 71 applications are costing money.
In that case, when you click the gauge, the list of the 53 applications 
with cost line is detailed in the Results window.
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CUSTOMIZING A TREE REPORT TEMPLATE

How to Replace Node Names by Property Values in a Dendrogram
 See also How to Replace Node Icons by Property Values in a Dendrogram

In a dendrogram, you might want to identify the nodes through one of their properties instead of
their names.

For example, instead of displaying the Technology names, you can display 
their codes.

To display a property value instead of the node name:
1. Access the Report Tree View.

 Access the Report Tree View  concerned, see Accessing the Report Templates and 
their Constituents.

2. In its Tree page, select the row of the Report Tree Node concerned.
Example: Technologies used.
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3. In the Report Tree Properties list, in the row of the property concerned, use the drop-
down list to set Replace Name to "Yes".

In the dendrogram, the technologies are identified through their codes.
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How to Replace Node Icons by Property Values in a Dendrogram
 See also How to Replace Node Names by Property Values in a Dendrogram

In a dendrogram, you might want to highlight a property of a node and replace its icons by the
property values. 

For example, for a Technology, instead of displaying the Technology icon, 
you can display its "Company Standard" value (represented by a color).

To display a property value instead of the node icon:
1. Access the Report Tree View.

 Access the Report Tree View  concerned, see Accessing the Report Templates and 
their Constituents.

2. In its Tree page, select the row of the Report Tree Node concerned.
Example: Technologies used.
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3. In the Report Tree Properties list, in the row of the property concerned, use the drop-
down list to set Display Picture to "Replace Node Picture".

Example: "Standard" property (which stands for "Company Standard" 
MetaAttribute of "Software Technology" MetaClass).

In the dendrogram, colored squares corresponding to the values of the "Standard"
property replace the Technology icons. 



399

Report Template: How To
Customizing a Tree Report Template

How to Apply a Conditional Style to a Treemap
To apply a conditional style to a treemap, you need to apply a conditional style to the Report Tree
Property associated with the Tree Report Column of a Report Tree View. 

To apply a conditional style to a treemap:

1. Access the Tree Report Column  properties.

 Access the Report Tree View  concerned, see Accessing the Report Templates and 
their Constituents.m
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2. Access the Report Tree Property associated with the Tree Report Column 
concerned:
• Display the Tree Report Column Characteristics page.
• In the Cell Content list, select the Report Tree Property.
• Display its Properties.

3. Display its Style page.
 For details regarding TreeSet properties, see Adding TreeSet Properties to a TreeSet 
Collection.

4. Click Add .
5. Enter a Name to your conditional style.
6. In the Style Parameters list, select the style you want to add on condition.

 Only the style parameters applying to the Report Tree View renderer are listed.

 You can select several styles.
7. Click Next.
8. In the Style Parameters list, select the style parameter and configure it in the right 

part.
Example: for a Box Color, in Value keep "Fixed" and select a color.

9. Click OK.
10. In the Style page, select your conditional style row.
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11. In This style applies on the following condition:
• in the Name field enter a name describing the condition
• in the pane enter the code for your condition.

 For code syntax, see Report Style Condition Properties.
Example: 
To apply a conditional style to "Cost" property with no value.
[1:ConditionGroup]
1=value,&Current,=,0

In the treemap report, borders of boxes matching the condition are colored.
For example, the applications with no cost value.
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This article explains how to write report chapters in Java, the new architecture and the 

differences with VBS analyses. 
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INTRODUCTION TO JAVA REPORT CHAPTERS 

Generalities 

A report chapter can be written in Java. 

It is highly recommended to write new reports in this language in order to benefit from the 

platform improvements and also to better handle PDF/RTF document generation. The old 

report platform will not be improved whereas the Java platform will be. 

Compared to VB Script reports, Java reports are written differently as described in this article. 

Both use the same metamodel described in the product documentation. 

Data and view separation 

VB Script report chapter macros generate HTML. 

Java report chapter macros generate an object structure describing datasets (report data) and 

the type of view to apply to these datasets. 

For more details on this structure, see the “Java Report Data Structure”. technical article. 

Conversion from this object structure to a report output (HTML or PDF for example) is handled 

by the report engine using specific renderers. For more details on renderers see the “Writing 

Java report renderers” technical article. 

This new architecture allows for better management of different output formats and more flexibility 

and modularity. It is therefore highly recommended to write new report chapter macros in Java, 

using the method described hereafter. 
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PREREQUISITES 

Report modeling 

This technical article does not cover modeling of reports, report templates, report parameters 

and report chapters. 

Modeling is the same as for VB Script reports. You should refer to product documentation on 

this subject. 

Setup a Java development environment 

A Java report chapter macro is a Java Plug-in which uses Mega APIs. 

You should first refer to the “Create a Java component” chapter (All about starting with APIs 

Technical Article) to set up a Java development environment adapted to HOPEX. 

Referencing jars and javadoc 

Following the method described in “Create a Java component” you should reference the 

following jars in your development environment: 

• mj_toolkit.jar 

• mj_api.jar 

• mj_anls.jar 

To allow for contextual help in Eclipse, you should also reference the corresponding javadocs: 

• mj_api.doc.zip 

• mj_anls.doc.zip 
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WRITING THE MACRO IMPLEMENTATION 

Interfaces to implement 

Report chapters 

A Java report chapter must implement one of the following interfaces: 

• com.mega.modeling.analysis.AnalysisReport 

• com.mega.modeling.analysis.AnalysisReportWithContext 

The getReportContent method is the only method required to implement these interfaces. Its 

parameters are: 

• a Mega Root,  

• a Map of parameter Lists referenced by the HexaIdAbs of the “Analysis Parameter” 

repository object,  

• an optional userData object, 

• and in the case of AnalysisReportWithContext an extra Analysis object which 

provides contextual information. 

It produces the report content in the form of a ReportContent object. This is an instance of the 

ReportContent Java class, to which all data and view information is given in order to pass it to 

the analysis engine and its renderers. 

More information on ReportContent objects is available in the “Java analysis data structure” 

technical article and in the engine Javadoc. 

This typically results in either of the following structures: 

public class MyReport implements AnalysisReport { 

  @Override 

  public ReportContent getReportContent(final MegaRoot root, final Map<String, 

List<AnalysisParameter>> parameters, final Object userData) { 

    … 

  } 

} 

 

public class MyReport implements AnalysisReportWithContext { 

  @Override 
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  public ReportContent getReportContent(final MegaRoot root, final Map<String, 

List<AnalysisParameter>> parameters, final Analysis analysis, final Object 

userData) { 

    … 

  } 

} 

Callbacks 

Callback calls allow for user interactivity in tables and trees, by allowing the execution of a 

Callback function when the user clicks on a cell. The callback function subsequently updates 

the cell content. 

The Java implementation of the macro that handles callback calls must implement the 

com.mega.modeling.analysis.AnalysisCallback interface.  

This can be the same macro and Java class as the report chapter itself or a different macro. 

The Callback method is the only method required to implement the AnalysisCallback interface. 

Its parameters are: 

• a Mega Root,  

• the HTML content of the cell that was clicked,  

• MegaCollections of the line and column objects of the cell, 

• an optional userData. 

It produces the new content to be rendered in the clicked cell, in the form of an HTML string. 

For example: 

public class MyReportCallback implements AnalysisCallback { 

  @Override 

  public String Callback(final MegaRoot root, final String HTMLCellContent, 

final MegaCollection ColumnMegaObjects, final MegaCollection LineMegaObjects, 

final Object userData) { 

    … 

  } 

} 
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Implementing the macro 

General steps 

The implementation of the getReportContent function follows the following general steps: 

• Create a new ReportContent object that will contain all report data and views: 

final ReportContent reportContent = new ReportContent(""); 

• Create one or more Datasets (Java objects that contain all the data to be rendered) and 

add them to the ReportContent, getting the ID of the dataset for future use: 

final Dataset d = new Dataset(""); 

final int datasetID = reportContent.addDataset(d); 

• Create one or more Dimensions (the equivalent of x, y, etc. axis in a diagram) and add 

them to the Dataset(s): 

final Dimension dim = new Dimension(""); 

d.addDimension(dim); 

• Create one or more items and add them to the Dimension(s). This is the equivalent of 

row or column headers in a table. 

dim.addItem(new Text("Some text…", false)); 

• Create one or more items and add them to the Dataset(s): 

d.addItem(new Value((double) n), "1"); 

• Create one or more Views (or Texts or MegaObjectProperties), using the ID of the 

dataset they should represent, and add them to the ReportContent. A view links a 

dataset to a renderer in order to define where and how the dataset should be rendered. 

final View v = new View(datasetID); 

reportContent.addView(v); 

• Add one or more renderers to the View(s) to specify how the view dataset should be 

shown (here, as a table): 

v.addRenderer(AnalysisReportToolbox.rTable); 

• Return the now complete ReportContent: 

return reportContent; 

More information on the data structure of ReportContent, Dataset, Dimension, View, Item, 

etc. is available in the “Java report data structure” technical article and in the Javadoc 

engine (HOPEX Customization (Windows) > Using APIs > JavaDoc). 
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Example 

A basic working example is as follows: 

import java.util.List; 

import java.util.Map; 

 

import com.mega.modeling.analysis.AnalysisParameter; 

import com.mega.modeling.analysis.AnalysisReport; 

import com.mega.modeling.analysis.AnalysisReportToolbox; 

import com.mega.modeling.analysis.content.Dataset; 

import com.mega.modeling.analysis.content.Dimension; 

import com.mega.modeling.analysis.content.ReportContent; 

import com.mega.modeling.analysis.content.Text; 

import com.mega.modeling.analysis.content.Value; 

import com.mega.modeling.analysis.content.View; 

import com.mega.modeling.api.MegaRoot; 

 

/** 

 * This is a basic demonstration report. 

 * @author NLE 

 */ 

 

public class MyReport implements AnalysisReport { 

  public ReportContent getReportContent(final MegaRoot root, final Map<String, 

List<AnalysisParameter>> parameters, final Object userData) { 

    final ReportContent reportContent = new ReportContent(""); 

 

    // Creating a 2D Dataset and its dimensions 

    final Dataset d2 = new Dataset(""); 

    final Dimension dim21 = new Dimension(""); 

    final Dimension dim22 = new Dimension(""); 

    // Set the dimension sizes  

    // (compulsory only when no Items are added to the dimension) 

    dim21.setSize(4); 

    dim22.setSize(5); 

    // Add the dimensions to the Dataset 

    d2.addDimension(dim21); 

    d2.addDimension(dim22); 

 

    // Filling in the dataset and its dimensions 

    // Arbitrary data is used here 

    for (int i = 1; i <= 4; i++) { 

      dim21.addItem(new Text("Title " + i + "/4", false)); 
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      for (int j = 1; j <= 5; j++) { 

        d2.addItem(new Value((double) i * j), i + "," + j); 

      } 

    } 

    for (int j = 1; j <= 5; j++) { 

      dim22.addItem(new Text("Title " + j + "/5", false)); 

    } 

 

    // Add the dataset to the report 

    final int datasetID = reportContent.addDataset(d2); 

 

    // Add a table and list view of the dataset 

    // List will only be used if table cannot be used 

    final View v1 = new View(datasetID); 

    v1.addRenderer(AnalysisReportToolbox.rTable); 

    v1.addRenderer(AnalysisReportToolbox.rList); 

    reportContent.addView(v1); 

 

    // Add an area chart view, with the same dataset (not duplicated) 

    final View v2 = new View(datasetID); 

    v2.addRenderer(AnalysisReportToolbox.rAreaChart); 

    reportContent.addView(v2); 

 

    return reportContent; 

  } 

} 

This code typically results in the following rendering: 
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Going further 

You should refer to the Javadoc for all possible options and possibilities.  

The Javadoc is accessible: 

• in HOPEX online documentation (HOPEX Customization (Windows) > Using APIs > 

JavaDoc): 

o Report API 

o MEGA API 

o Toolkit API 

o Workflow Engine API 

• contextually in Eclipse if you configured it as suggested in the Prerequisites section 

• in your HOPEX installation directory ("java\doc"), in HTML format in a zip file 

“mj_anls.doc.zip". 

You can make use of all MEGA Java APIs (also available in the corresponding “mj_api.doc.zip" 

javadoc) to handle MegaObjects and MegaCollections.  

A more complex example is provided at the end of this document. 
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USING YOUR IMPLEMENTATION FROM THE MEGA REPORT 

MACRO 

Compile 

In order to use your Java report chapter, it must be exported in a .jar in the java/lib directory 

of your HOPEX installation.  

Compilation of the Java component in the form of a JAR file is via the "Export" menu of the 

Java project: 

 

A JAR can contain as many Java report chapter implementing classes as you want. 
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"JAR File" export in the Java directory should be selected: 

 

Indicate the location of the JAR file to be generated and click Finish:  

The JAR file must be generated (or copied after generation) in the "java\lib" directory of the HOPEX 

installation site. 
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The name of the JAR file itself is not significant; you should use a name that makes sense in your 

project. 

Configure the Macro 

Once you have added the JAR file to the “java\lib” directory, restart HOPEX and edit the 

properties of your report macro in order to reference your Java class.  

In the macro properties dialog box: 

1. Assign the "Dispatch" value to the "SystemComponent" attribute 

2. Specify the _ObjectFactory attribute using the report Java class.  

For example: the value "java:com/mega/tutorial/MegaPlugin" identifies the 

"MegaPlugin" class of the "com.mega.tutorial" package. 

 

The VB Script of the macro should be left empty. 
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CODE EXAMPLE 

import java.util.Date; 

import java.util.List; 

import java.util.Map; 

 

import com.mega.modeling.analysis.AnalysisCallback; 

import com.mega.modeling.analysis.AnalysisParameter; 

import com.mega.modeling.analysis.AnalysisReport; 

import com.mega.modeling.analysis.AnalysisReportToolbox; 

import com.mega.modeling.analysis.content.Dataset; 

import com.mega.modeling.analysis.content.Dimension; 

import com.mega.modeling.analysis.content.Item; 

import com.mega.modeling.analysis.content.MegaObjectProperty; 

import com.mega.modeling.analysis.content.ReportContent; 

import com.mega.modeling.analysis.content.Text; 

import com.mega.modeling.analysis.content.Value; 

import com.mega.modeling.analysis.content.View; 

import com.mega.modeling.api.MegaCollection; 

import com.mega.modeling.api.MegaObject; 

import com.mega.modeling.api.MegaRoot; 

import com.mega.modeling.api.MegaAttribute.OutputFormat; 

import com.mega.toolkit.errmngt.ErrorLogFormater; 

 

/** 

 * This is a demonstration report. 

 * @author NLE 

 */ 

 

public class MyReport implements AnalysisReport, AnalysisCallback { 

  @Override 

  public ReportContent getReportContent(final MegaRoot root, final Map<String, 

List<AnalysisParameter>> parameters, final Object userData) { 

    // Error Management exemple 

    final ErrorLogFormater err = new ErrorLogFormater(); 

    err.openSession(root); 

    // Do not forget to update this line 

    err.addSessionInfo("Component", "(Java) New Analysis Engine: TestReport: 

getReportContent"); 

 

    // Initialize the report content 

    final ReportContent reportContent = new ReportContent(""); 
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    try { 

 

Demo 1: Charts using 2D datasets 

 

      final Dataset d2 = new Dataset("~LshNx7Mw6zE0[No Data To Display]"); 

      final Dimension dim21 = new Dimension("~LshNx7Mw6zE0[No Data To Display]"); 

      final Dimension dim22 = new Dimension("~LshNx7Mw6zE0[No Data To Display]"); 

      dim21.setSize(4); 

      dim22.setSize(5); 

      d2.addDimension(dim21); 

      d2.addDimension(dim22); 

 

      // Filling in the dataset (here with arbitrary data) 

      for (int i = 1; i <= 4; i++) { 

        dim21.addItem(new Text("Title " + i + "/4", false)); 

        for (int j = 1; j <= 5; j++) { 

          d2.addItem(new Value((double) i * j), i + "," + j); 

        } 

      } 

      for (int j = 1; j <= 5; j++) { 

        dim22.addItem(new Text("Title " + j + "/5", false)); 

      } 

 

      // Add the Dataset to the report 

      final int datasetID = reportContent.addDataset(d2); 

 

      // Add the Dataset to many different views 

      final View v21 = new View(datasetID, true, false); 

      v21.addRenderer(AnalysisReportToolbox.rAreaChart); 

      reportContent.addView(v21); 

 

      final View v22 = new View(datasetID); 

      v22.addRenderer(AnalysisReportToolbox.rLineChart); 

      reportContent.addView(v22); 

 

      final View v23 = new View(datasetID); 

      v23.addRenderer(AnalysisReportToolbox.rBarChart); 

      reportContent.addView(v23); 

 

      final View v24 = new View(datasetID); 
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      v24.addRenderer(AnalysisReportToolbox.rRadarChart); 

      reportContent.addView(v24); 
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Demo 2: Parameters in tables with vertical headers 

 

      // Going through parameters 

      for (final String paramType : parameters.keySet()) { 

        reportContent.addText(new Text("" + 

root.getObjectFromID(paramType).getAttribute("~Z20000000D60[Short 

Name]").getFormated(OutputFormat.html, ""), false, 3)); 

 

        // Going through its values 

        for (final AnalysisParameter paramValue : parameters.get(paramType)) { 

          reportContent.addText(new 

Text(paramValue.getParameterObject().getAttribute("~Z20000000D60[Short 

Name]").getFormated(OutputFormat.html, ""), false, 4)); 

 

          // and the actual individual values 

          final Dataset paramDataset = new Dataset(""); 

          final Dimension dim1 = new Dimension(""); 

          final Dimension dim2 = new Dimension(""); 

          dim2.setSize(1); 

          final Item title = new Text("Column Title", false); 

          // Set the title column header to allow ordering of column 
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          title.setOrderable(true); 

          dim2.addItem(title); 

          int i = 1; 

          for (final MegaObject value : paramValue.getValues()) { 

            paramDataset.addItem(new MegaObjectProperty(value.megaField(), 

"~Z20000000D60[Short Name]"), i + ",1"); 

            i++; 

          } 

          dim1.setSize(i - 1); 

          paramDataset.addDimension(dim1); 

          paramDataset.addDimension(dim2); 

 

          final int paramDatasetID = reportContent.addDataset(paramDataset); 

 

          final View paramView1 = new View(paramDatasetID, true, false); 

          paramView1.addRenderer(AnalysisReportToolbox.rVerticalTextTable); 

          reportContent.addView(paramView1); 

 

        } 

      } 
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Demo 3: Pie chart 

 

      final Dataset d1 = new Dataset(""); 

      final Dimension dim11 = new Dimension(""); 
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      dim11.setSize(5); 

      d1.addDimension(dim11); 

      for (int i = 1; i <= 5; i++) { 

        d1.addItem(new Value((double) i), i + ""); 

      } 

      final View v1 = new View(reportContent.addDataset(d1)); 

      v1.addRenderer(AnalysisReportToolbox.rPieChart); 

      reportContent.addView(v1); 

 

 

Demo 4: Bubble chart 

 

      final Dataset d3 = new Dataset(""); 

      final Dimension dim31 = new Dimension(""); 

      final Dimension dim32 = new Dimension(""); 

      final Dimension dim33 = new Dimension(""); 

      dim31.setSize(5); 

      dim32.setSize(4); 

      dim33.setSize(3); 

      d3.addDimension(dim31); 

      d3.addDimension(dim32); 

      d3.addDimension(dim33); 

      for (int i = 1; i <= 5; i++) { 
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        for (int j = 1; j <= 4; j++) { 

          for (int k = 1; k <= 3; k++) { 

            d3.addItem(new Value((double) i * j * k), i + "," + j + "," + k); 

          } 

        } 

      } 

      final View v3 = new View(reportContent.addDataset(d3)); 

      v3.addRenderer(AnalysisReportToolbox.rBubbleChart); 

      reportContent.addView(v3); 

 

 

Demo 5: Simple Gantt chart 

 

      final Dataset dGantt = new Dataset(""); 

      final Dimension dimGantt = new Dimension(""); 

      dimGantt.setSize(5); 

      dGantt.addDimension(dimGantt); 

      for (int i = 1; i <= 5; i++) { 

        dGantt.addItem(new Value(new Date(2010 - 1900, i, i), new Date(2010 - 1900, i 

+ 1, i)), i + ""); 

      } 

      final View vGantt = new View(reportContent.addDataset(dGantt)); 
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      vGantt.addRenderer(AnalysisReportToolbox.rGanttChart); 

      reportContent.addView(vGantt); 

 

 

Demo 6: Tree of parameters 

 

      final Dataset paramDataset = new Dataset(""); 

      // Callback: set the Macro to be called back, in this exemple you should  

      // reference the macro referencing this Java class 

      paramDataset.setCallback("~Jq(Ipv4W4P50[Analysis - Set of Parameters]"); 

      final Dimension dim1 = new Dimension(""); 

      final Dimension dim2 = new Dimension(""); 

      dim2.setSize(1); 

      int i = 0; 

      for (final String paramType : parameters.keySet()) { 

        dim1.addItem(new 

MegaObjectProperty(root.getObjectFromID(paramType).megaField(), "~Z20000000D60[Short 

Name]"), 1); 

        i++; 

        paramDataset.addItem(new 

MegaObjectProperty(root.getObjectFromID(paramType).megaField(), 

"~210000000900[Name]"), i + ",1"); 

        // Going through its values 

        for (final AnalysisParameter paramValue : parameters.get(paramType)) { 

          dim1.addItem(new 

MegaObjectProperty(paramValue.getParameterObject().megaField(), "~Z20000000D60[Short 

Name]"), 2); 

          i++; 

          paramDataset.addItem(new 

MegaObjectProperty(paramValue.getParameterObject().megaField(), 

"~210000000900[Name]"), i + ",1"); 

          // and the actual individual values!! 
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          for (final MegaObject value : paramValue.getValues()) { 

            dim1.addItem(new MegaObjectProperty(value.megaField(), "~Z20000000D60[Short 

Name]"), 3); 

            i++; 

            paramDataset.addItem(new MegaObjectProperty(value.megaField(), 

"~210000000900[Name]"), i + ",1"); 

          } 

 

        } 

      } 

      paramDataset.addDimension(dim1); 

      paramDataset.addDimension(dim2); 

      final View treeView = new View(reportContent.addDataset(paramDataset)); 

      treeView.addRenderer(AnalysisReportToolbox.rTree); 

      treeView.addRenderer(AnalysisReportToolbox.rTable); 

      reportContent.addView(treeView); 

 

Demo 7: Clickable diagrams 

 

      final Dataset dDiags = new Dataset("~LshNx7Mw6zE0[No Data To Display]"); 

      final Dimension dimD1 = new Dimension(""); 

      dDiags.addDimension(dimD1); 

 

      // filling in the dataset 
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      dimD1.addItem(new MegaObjectProperty("~uGEJcPMZ4fM0[Account Payable - Cause-and-

Effect Diagram]", "")); 

      dimD1.addItem(new MegaObjectProperty("~B9QnnNye9940[Add 1 Product to Cart - DM - 

Data Diagram]", "")); 

      dimD1.addItem(new MegaObjectProperty("~vU3v8M(a9L50[New APPCO.com - Project 

Objective and Requirement Diagram]", "")); 

      final int datasetDiagID = reportContent.addDataset(dDiags); 

 

      final View vDiag = new View(datasetDiagID); 

      vDiag.addRenderer(AnalysisReportToolbox.rDiagrams); 

      reportContent.addView(vDiag); 

 

 

Demo 8: Clickable illustrating diagrams 
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      final Dataset diDiags = new Dataset(""); 

      final Dimension dimiD1 = new Dimension(""); 

      diDiags.addDimension(dimiD1); 

 

      // filling in the dataset with the objects we want to find in the diagram  

      // and the color to apply to them 

      dimiD1.addItem(new MegaObjectProperty("~4YRLwW5V49o0[Creation of an imaginary 

supplier]", "")); 

      final int datasetiDiagID = reportContent.addDataset(diDiags); 

      diDiags.addItem(new Value((short) 200, (short) 0, (short) 0), "1"); 

 

      final View viDiag = new View(datasetiDiagID); 

      viDiag.addRenderer(AnalysisReportToolbox.rIllustratingDiagrams); 

      reportContent.addView(viDiag); 

 

      // End of error management 

    } catch (final Exception e) { 

      err.logMessage("Report generation failed:"); 

      err.logError(e); 

      err.closeSession(); 

    } 

    return reportContent; 

  } 

 

  @Override 

  public String Callback(final MegaRoot root, final String HTMLCellContent, final 

MegaCollection ColumnMegaObjects, final MegaCollection LineMegaObjects, final Object 

UserData) { 

    // Exemple of callback in a table or tree 

    return "[TEST] Was called back successfully, was[" + HTMLCellContent + "]"; 

  } 

} 
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Writing Java report renderers 

Java report renderers allow the extension of the report engine, offering more rendering 

possibilities to Java report chapters. This technical article presents how such renderers are 

modeled and written. 
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INTRODUCTION AND PREREQUISITES 

This technical article presents how renderers are modeled and implemented in Java. 

It requires a configured Java development environment and that you be familiar with Java 

report chapter implementation and the data structure which reports generate. 

If not, please refer to the following technical articles: 

• MEGA Plug-ins with Java 

• Writing Java report chapters 

• Java report data structure 

For each rendering format which should be handled (HTML, PDF, etc.), there is one renderer 

implementation.  

In Mega 2009 SP5, HTML and PDF renderers are taken into account. However, RTF is generated from 

HTML. 

In Mega 2009 SP4, only HTML renderers are taken into account. 
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RENDERER MODELING 

Renderers are modelled in HOPEX and called through an object identifier. 

They are available in the Renderers Folder of the Utilities navigation window: 

 

Each renderer is specific to a format and type e.g. HTML areachart renderer. 

This is specified in renderer properties: 

 

• Output Format: format handled by this renderer. 
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• Renderer Type: type of rendering produced. The renderer type is used in the analysis 

report to specify which rendering to apply to the dataset. 

• Implemented by: the implementation macro, in Java (see next chapter for its 

implementation). 

The call of the renderer is handled by the analysis engine depending on generation format 

(HTML, PDF, etc.). 
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RENDERER IMPLEMENTATION 

Interface to implement 

Renderers must implement the com.mega.modeling.analysis.ViewRenderer interface. This 

requires the implementation of a single Generate function. 

This results in the following structure: 

public class MyHTMLRenderer implements ViewRenderer { 

  @Override 

  public boolean Generate(final Object document, final ReportContent reportContent, 

final Item i, final MegaCOMObject megaContext, final Object userData, final MegaRoot 

root) { 

 … 

  } 

} 

The aim of the function is to append the document object with the rendering of Item i, using 

the data contained in the ReportContent object.  

In this situation, the Item is usually the View object created by the analysis report to link a 

dataset to this renderer. 

In the case of HTML, the document object is a StringBuffer. 

In the case of PDF, the document object is an aspose.pdf.Pdf. 

A Mega Context object, Mega Root and an optional userData are also made available. 

This function produces a boolean that indicates: 

• True: capable of rendering in this context with the data supplied, and has done so by 

appending the document object. 

• False: not capable of rendering and has not appended the document object. The 

analysis engine should try to find another suitable renderer. 

Implementation example 

This example uses ChartDirector 4.1, a graph library provided with Mega capable of rendering 

many different types of charts. 
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Further documentation on ChartDirector can be obtained from ASE at: 

http://download2.advsofteng.com/v4/cdjavadoc_html_v4.zip 

HTML Renderer Code 

import ChartDirector.BarLayer; 

import ChartDirector.Chart; 

import ChartDirector.LegendBox; 

import ChartDirector.XYChart; 

import com.mega.modeling.analysis.AnalysisRenderingToolbox; 

import com.mega.modeling.analysis.ViewRenderer; 

import com.mega.modeling.analysis.content.Dataset; 

import com.mega.modeling.analysis.content.Dimension; 

import com.mega.modeling.analysis.content.Item; 

import com.mega.modeling.analysis.content.ReportContent; 

import com.mega.modeling.analysis.content.Value; 

import com.mega.modeling.analysis.content.View; 

import com.mega.modeling.api.MegaCOMObject; 

import com.mega.modeling.api.MegaRoot; 

 

/** 

 * Renderer for bar chart in HTML 

 * Accepted dimensionalities: 2 

 * @author NLE 

 */ 

public class barchartHTMLRenderer implements ViewRenderer { 

  @Override 

  public boolean Generate(final Object document, final ReportContent reportContent, 

final Item i, final MegaCOMObject megaContext, final Object userData, final MegaRoot 

root) { 

    if (i instanceof View) { 

      final Dataset d = reportContent.getDataset(((View) i).getDatasetId()); 

      if (d.getDimensionCount() == 2) { 

        AnalysisRenderingToolbox.setChartDirectorLicense(root); 

 

        // The data for the chart 

        final Dimension dim1 = d.getDimension(0); 

        final Dimension dim2 = d.getDimension(1); 

 

        // The labels & data for the chart 

        final int labelCount = dim1.getItemCount(); 

        final int areaCount = dim2.getItemCount(); 

 

        final String[] labels = new String[labelCount]; 

http://download2.advsofteng.com/v4/cdjavadoc_html_v4.zip
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        for (int ii = 0; ii < labelCount; ii++) { 

          labels[ii] = AnalysisRenderingToolbox.getItemText(dim1.getItem(ii), root); 

        } 

 

        // Create a XYChart object of size 400 x 240 pixels 

        final XYChart c = new XYChart(600, 260); 

 

        // Add a title to the y-axis 

        

c.yAxis().setTitle(AnalysisRenderingToolbox.getCodeTemplate(dim2.getCodeTemplateID(), 

root)); 

 

        // Add a title to the x-axis 

        

c.xAxis().setTitle(AnalysisRenderingToolbox.getCodeTemplate(dim1.getCodeTemplateID(), 

root)); 

 

        // Set the x axis labels 

        c.xAxis().setLabels(labels); 

 

        // Set the plot area and size.  

        c.setPlotArea(40, 30, 340, 190); 

 

        // Add a legend box at top right corner using 10 pts Arial Bold 

        // font. Set the background to silver, with 1 pixel 3D border effect. 

        final LegendBox b = c.addLegend(570, 30, true, "Arial Bold", 10); 

        b.setAlignment(Chart.TopRight); 

        b.setBackground(Chart.silverColor(), Chart.Transparent, 1); 

 

        //colors 

        String sColors = ((View) i).getParameter("colors"); 

        String[] tColors = null; 

        if ((sColors != null) && (sColors.length() > 1)) { 

          tColors = sColors.split(","); 

        } 

 

        // Add a multi-bar layer with data sets and 3 pixels 3D depth 

        final BarLayer layer = c.addBarLayer2(Chart.Side, 3); 

        for (int j = 0; j < areaCount; j++) { 

          final double[] data = new double[labelCount]; 

          for (int ii = 0; ii < labelCount; ii++) { 

            final Item curItem = d.getItem((ii + 1) + "," + (j + 1)); 

            if (curItem instanceof Value) { 

              data[ii] = (Double) ((Value) curItem).getValue(); 

            } else { 
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              data[ii] = 0.0; 

            } 

          } 

          if (tColors != null) { 

            layer.addDataSet(data, (int) Long.parseLong(tColors[j], 16), 

AnalysisRenderingToolbox.getItemText(dim2.getItem(j), root)); 

          } else { 

            layer.addDataSet(data, AnalysisRenderingToolbox.getHexaColor(j), 

AnalysisRenderingToolbox.getItemText(dim2.getItem(j), root)); 

          } 

        } 

 

        // Get filename 

        final String imgurl = 

root.currentEnvironment().toolkit().getStringFromID(root.currentEnvironment().toolkit

().generateID()) + ".jpg"; 

        // Generate chart 

        c.makeChart(AnalysisRenderingToolbox.getGenerationFolderWrite(megaContext, 

root) + imgurl); 

        // append html 

        AnalysisRenderingToolbox.getShowHideStart(root, (StringBuffer) document, 

(View) i, d, megaContext); 

        ((StringBuffer) document).append("<p><img src=\"" + 

AnalysisRenderingToolbox.getGenerationFolderRead(megaContext, root, imgurl) + 

"\"/></p>"); 

        AnalysisRenderingToolbox.getShowHideEnd((StringBuffer) document, (View) i); 

        return true; 

      } 

      return false; 

    } 

    return false; 

  } 

} 

PDF Renderer Code 

import java.io.File; 

import ChartDirector.BarLayer; 

import ChartDirector.Chart; 

import ChartDirector.LegendBox; 

import ChartDirector.XYChart; 

import aspose.pdf.Image; 

import aspose.pdf.Pdf; 

import aspose.pdf.Section; 

import com.mega.modeling.analysis.AnalysisRenderingToolbox; 

import com.mega.modeling.analysis.ViewRenderer; 

import com.mega.modeling.analysis.content.Dataset; 
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import com.mega.modeling.analysis.content.Dimension; 

import com.mega.modeling.analysis.content.Item; 

import com.mega.modeling.analysis.content.ReportContent; 

import com.mega.modeling.analysis.content.Value; 

import com.mega.modeling.analysis.content.View; 

import com.mega.modeling.api.MegaCOMObject; 

import com.mega.modeling.api.MegaRoot; 

 

/** 

 * Renderer for bar chart in PDF 

 * Accepted dimensionalities: 2 

 * @author NLE 

 */ 

public class barchartPDFRenderer implements ViewRenderer { 

  @Override 

  public boolean Generate(final Object document, final ReportContent reportContent, 

final Item i, final MegaCOMObject megaContext, final Object userData, final MegaRoot 

root) { 

    if (i instanceof View) { 

      final Dataset d = reportContent.getDataset(((View) i).getDatasetId()); 

      if (d.getDimensionCount() == 2) { 

        AnalysisRenderingToolbox.setChartDirectorLicense(root); 

 

        // The data for the chart 

        final Dimension dim1 = d.getDimension(0); 

        final Dimension dim2 = d.getDimension(1); 

 

        // The labels & data for the chart 

        final int labelCount = dim1.getItemCount(); 

        final int areaCount = dim2.getItemCount(); 

 

        final String[] labels = new String[labelCount]; 

        for (int ii = 0; ii < labelCount; ii++) { 

          labels[ii] = AnalysisRenderingToolbox.getItemText(dim1.getItem(ii), root); 

        } 

 

        // Create a XYChart object of size 400 x 240 pixels 

        final XYChart c = new XYChart(600, 260); 

 

        // Add a title to the y-axis 

        

c.yAxis().setTitle(AnalysisRenderingToolbox.getCodeTemplate(dim2.getCodeTemplateID(), 

root)); 

 

        // Add a title to the x-axis 
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c.xAxis().setTitle(AnalysisRenderingToolbox.getCodeTemplate(dim1.getCodeTemplateID(), 

root)); 

 

        // Set the x axis labels 

        c.xAxis().setLabels(labels); 

 

        // Set the plot area and size.  

        c.setPlotArea(40, 30, 340, 190); 

 

        // Add a legend box at top right corner using 10 pts Arial Bold 

        // font. Set the background to silver, with 1 pixel 3D border effect. 

        final LegendBox b = c.addLegend(570, 30, true, "Arial Bold", 10); 

        b.setAlignment(Chart.TopRight); 

        b.setBackground(Chart.silverColor(), Chart.Transparent, 1); 

 

        //colors 

        String sColors = ((View) i).getParameter("colors"); 

        String[] tColors = null; 

        if ((sColors != null) && (sColors.length() > 1)) { 

          tColors = sColors.split(","); 

        } 

 

        // Add a multi-bar layer with data sets and 3 pixels 3D depth 

        final BarLayer layer = c.addBarLayer2(Chart.Side, 3); 

        for (int j = 0; j < areaCount; j++) { 

          final double[] data = new double[labelCount]; 

          for (int ii = 0; ii < labelCount; ii++) { 

            final Item curItem = d.getItem((ii + 1) + "," + (j + 1)); 

            if (curItem instanceof Value) { 

              data[ii] = (Double) ((Value) curItem).getValue(); 

            } else { 

              data[ii] = 0.0; 

            } 

          } 

          if (tColors != null) { 

            layer.addDataSet(data, (int) Long.parseLong(tColors[j], 16), 

AnalysisRenderingToolbox.getItemText(dim2.getItem(j), root)); 

          } else { 

            layer.addDataSet(data, AnalysisRenderingToolbox.getHexaColor(j), 

AnalysisRenderingToolbox.getItemText(dim2.getItem(j), root)); 

          } 

        } 

 

        // Get filename 
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        final String imgurl = 

root.currentEnvironment().toolkit().getStringFromID(root.currentEnvironment().toolkit

().generateID()) + ".jpg"; 

        // Generate chart 

        File f = new 

File(AnalysisRenderingToolbox.getGenerationFolderWrite(megaContext, root) + imgurl); 

        f.deleteOnExit(); 

        c.makeChart(f.getAbsolutePath()); 

        // append PDF 

        Section sec1 = ((Pdf) document).getSections().add(); 

        sec1.setIsNewPage(false); 

        //Create an image object in the section 

        Image img1 = new Image(sec1); 

        

img1.getImageInfo().setTitle(AnalysisRenderingToolbox.getCodeTemplate(d.getCodeTempla

teID(), root)); 

        img1.getImageInfo().setFixWidth(400.0f); 

        //Add image object into the Paragraphs collection of the section 

        sec1.getParagraphs().add(img1); 

        //Set the path of image file 

        img1.getImageInfo().setFile(f.getAbsolutePath()); 

        return true; 

      } 

      return false; 

    } 

    return false; 

  } 

} 

Example result 
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USING YOUR IMPLEMENTATION FROM THE MEGA RENDERER 

MACRO 

Compile 

In order to use your Java Report Renderer it must be exported in a .jar in the java/lib directory 

of your MEGA installation.  

Compilation of the Java component in the form of a JAR file is via the "Export" menu of the 

Java project: 

 

 

A JAR can contain as many Java Renderer implementing classes as you wish. 
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"JAR File" export in the Java directory should be selected: 

 

Indicate the location of the JAR file to be generated and click "Finish":  

The JAR file must be generated (or copied after generation) in the "java\lib" directory of the MEGA 

installation site. 
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The name of the JAR file itself is not significant; you should use a name that makes sense in your project. 

Configuring the macro 

Once you have added the JAR file to the “java\lib” directory, restart Mega and edit the 

properties of your renderer macro in order to reference your Java class.  

In the macro properties dialog box, assign the "Dispatch" value to the "SystemComponent" 

attribute, then specify the "_ObjectFactory" attribute using the renderer Java class. For 

exemple, the value "java:com/mega/tutorial/MegaPlugin" identifies the "MegaPlugin" class of 

the "com.mega.tutorial" package. 

 

 

 

The VB Script of the macro should be kept empty. 

 


	HOPEX Studio
	HOPEX Report Studio Introduction
	Introduction
	Prerequisite for any Customization
	HOPEX Studio vs Java report

	Accessing HOPEX Report Studio Desktop
	Customization Dedicated Profiles
	Logging in to HOPEX Report Studio Desktop

	HOPEX Report Studio Desktop
	HOPEX Report Studio Navigation Menus
	Report Definitions Menus
	HOPEX Report Studio Homepage


	Report DataSet Definition
	Introduction to Report DataSet Definition
	Report DataSet Definition and Report DataSet Principles
	Report DataSet Definition
	Report DataSet

	Creating and Defining a Report DataSet Definition: the Big Picture
	Report DataSet Definition Best Practices
	Defining the Report DataSet Definition
	Optimizing the Report DataSet Definition for better performance
	Checking the Report DataSet row count
	Supervising Report DataSet events


	Report DataSet Definition Creation
	Accessing the Report DataSet Definitions
	Accessing all the Report DataSet Definitions
	Accessing the custom Report DataSet Definitions

	Creating a Report DataSet Definition
	Defining a Report DataSet populated by occurrences
	Defining a Report DataSet populated by a query

	Adding Parameters to Filter Data Extraction
	Adding Property parameters
	Adding Collection parameters

	Defining the Data that Feeds the Report DataSet
	Adding a Report DataSet Collection
	Adding a value-type Property to the Report DataSet structure
	Adding a parameter-type Property to the Report DataSet structure
	Adding a computed-type Property to the Report DataSet structure
	Adding a collection count-type Property to the Report DataSet structure

	Previewing the Report DataSet

	Customizing the Report DataSet
	Modifying the Display Order of the Report DataSet Columns
	Hiding a Column of the Report DataSet
	Removing a Column from a Report DataSet
	Modifying the Name of a Report DataSet Column Header
	Speeding up the Report DataSet Display

	How To
	How to Add a Column to a Report DataSet
	How to Remove a Column from a Report DataSet
	How to Hide a Column in a Report DataSet
	How to Modify a Report DataSet Definition Provided with HOPEX
	How to Duplicate a Report DataSet Definition
	How to Add a Report DataSet in an Object Property Pages

	Use Cases
	Collecting a Set of Objects, Linked Objects and some of their Properties
	Description
	Creating the Report DataSet Definition

	Collecting a Set of Objects Using a Query and Adding a Computed Property
	Description of the Report DataSet Definition
	Creating the Report DataSet Definition


	Report DataSet Creation
	Accessing Report DataSets
	Creating a Report DataSet
	Handling the Report DataSet
	Creating a Report Template from the Report DataSet
	Creating a Report Data View from the Report DataSet


	GraphSet Definition
	Introduction to GraphSet Definition
	GraphSet Definition and GraphSet Principle
	GraphSet Definition
	GraphSet entry point
	GraphSubSet
	GraphSet
	Node
	Arc
	Path
	Intermediate node

	Creating and Defining a GraphSet Definition: the Big Picture
	GraphSet Definition Best Practices
	Supervising GraphSet Events

	GraphSet Definition Creation
	Accessing the GraphSet Definitions
	Accessing all the GraphSet Definitions
	Accessing the custom GraphSet Definitions
	Displaying the GraphSet Definition properties
	Displaying the GraphSubSet properties
	Displaying the GraphSet arc/node properties

	Creating a GraphSet Definition
	Creating an object collection-based GraphSet Definition
	Creating a query-based GraphSet Definition

	Adding GraphSet Definition Entry Points
	Adding an entry point collection to the GraphSet Definition
	Adding an entry point query to the GraphSet Definition
	Defining query parameters

	Adding a GraphSubSet to a GraphSet Definition
	Reusing a GraphSubSet in a GraphSet Definition
	Adding a new GraphSubSet to a GraphSet Definition
	Removing a GraphSubSet from a GraphSet Definition

	Defining the Data that Feeds the GraphSubSet
	Defining the nodes of the GraphSubSet
	Defining the arcs of a node
	Defining the paths
	Modifying a path definition

	Adding Fields to Nodes/Arcs
	Adding value-based fields to a node
	Adding macro-based fields to a node
	Adding object-based fields to a node

	Adding Fields to Intermediate Nodes
	Adding value-based fields to an intermediate node
	Adding macro-based fields to an intermediate node

	Previewing the GraphSet
	Saving the Graph Report
	Creating a graph-type Report Template
	Creating a Report Graph View



	TreeSet Definition
	Introduction to TreeSet Definition
	TreeSet Definition and TreeSet Principle
	TreeSet Definition
	TreeSet Definition structure
	Root node
	TreeSet Collection
	TreeSet
	Instant Reports

	Creating and Defining a TreeSet Definition: the Big Picture
	TreeSet Definition Best Practices
	Supervising TreeSet Events

	TreeSet Definition Creation
	Accessing the TreeSet Definitions
	Accessing all the TreeSet Definitions
	Accessing the custom TreeSet Definitions
	Displaying the TreeSet Definition properties

	Creating a TreeSet Definition
	Creating a Collection Parameter - based TreeSet Definition
	Creating a query-based TreeSet Definition
	Creating property parameters


	Defining the Data that Feeds the TreeSet Definition
	Introduction to TreeSet Definition Properties
	Characteristics page
	Definition page

	Adding a TreeSet Collection to a TreeSet Definition
	Adding a TreeSet Collection populated by a MetaAssociationEnd
	Adding a TreeSet Collection populated by a query
	Adding a TreeSet Collection populated by a parameter
	Adding a TreeSet Collection reusing part of the definition

	Removing a TreeSet Collection from a TreeSet Definition
	Defining a TreeSet Collection
	Hiding a TreeSet Collection
	Hiding nodes with no child
	Adding automatic folders to a TreeSet Collection
	Adding folders to a TreeSet Collection
	Adding a loop to a TreeSet Collection

	Adding TreeSet Properties to a TreeSet Collection
	Adding a value-based property to a TreeSet Collection
	Adding a count-based property to a TreeSet Collection
	Adding a macro-based property to a TreeSet Collection
	Adding an object-based property to a TreeSet Collection


	Handling a TreeSet
	Previewing the TreeSet
	Generating Instant Reports from a TreeSet
	Breakdown
	Dendrogram
	TreeMap
	TreeTable

	Saving the Tree Report
	Creating a tree-type Report Template
	Creating a Report Tree View


	How to
	How to Hide a TreeSet Collection
	How to Automatically Add Folders to a TreeSet Definition (grouping)
	How to Add a Folder to a TreeSet Definition
	How to Reorganize Folders or Collections in a TreeSet Definition
	How to Define a Loop in a TreeSet Definition
	How to Define a Loop in a TreeSet Definition without Duplicating the Collection Declaration
	How to Add Several Objects to the Root Collection


	Report Template Definition
	Report Template Introduction
	Report Template and Report Chapters
	Report Chapter and Macro or Report Data Views
	Report Chapter and macro
	Report Chapter and Report Data Views
	Report Data View types
	Report Style
	Report Renderer


	Report Template Definition
	Accessing the Report Templates and their Constituents
	Accessing Report Templates and their constituents
	Displaying properties of a Report Template and its contituents
	Directly accessing custom Report Templates and their properties
	Accessing Report Display Contexts
	Accessing Report Styles

	Report Template Properties
	Characteristics
	Parameters
	Chapters
	Report Template Style
	Permissions

	Report Chapter Properties
	Characteristics
	Definitions (Report Data Views-based Report Chapters)
	Filters Binding (Report Data Views-based Report Chapters)

	Report Container Properties
	Characteristics

	Report Data View Properties: Matrix and Table
	Characteristics
	Chart
	Filter
	Matrix (Report Matrix View)
	Table (Report Table View)
	Report Table Column Properties

	Report Data View Properties: Graph
	Characteristics
	Graph
	Filter
	Report Graph Node properties
	Report Graph Arc properties
	Style

	Report Data View Properties: Tree
	Characteristics
	Filter

	Report Data View Properties: Value
	Characteristics
	Chart

	Report Style Condition Properties
	Condition on value (Table/Matrix/Tree View element)
	Condition on value (Report Graph View element)
	Complex condition embedding a MetaTest
	Condition on a report element regardless of its content

	Report Style Properties
	Characteristics
	Definition


	Report Template Creation
	Creating a Report Template
	Creating a Report Template from a Report DataSet
	Creating a graph-type Report Template from a GraphSet
	Creating a tree-type Report Template from a TreeSet
	Creating a gauge-type Report Template from a query
	Creating a Report Template using a Report Data View
	Creating a Report Template using a macro

	Creating a Report Data View
	Adding a Report Chapter to a Report Template

	Customizing a Report Template
	Managing a Report Snapshot
	Organizing the Report Chapters
	Customizing the Report Chapter Export Format
	Customizing Parameter Display
	Customizing the Report Container Group display

	Report Template Examples
	Report Template with a Report Chapter Based on Report Data Views
	Report Template with a Report Chapter Based on a Macro


	Report Template: How To
	Report Template Creation: The Big Picture
	Displaying a Table, a Radar/Line/Bar/Pie Chart, a Set of Gauges, or a Word Cloud
	From a Report DataSet
	From a Report Table View

	Displaying a Matrix-Bar Chart or a Matrix-Radar Chart
	From a Report DataSet
	From a Report Matrix View

	Displaying a Graph
	From a GraphSet Definition
	From a Report Graph View

	Displaying a Gauge
	From a Query
	From a Report Value View

	Displaying a Breakdown, a Dendrogram, a TreeMap, or a TreeTable
	From a TreeSet Definition
	From a Report Tree View


	Managing Report Templates
	Getting the Parameters available to Customize a Renderer Type
	How to Define Parameters in a Report Template
	Defining parameters in a Report Template based on a macro
	Configuring a Report Template parameter
	Defining parameters in a Report Template based on Data Views

	How to Group Report Data Views in a Report Chapter
	Grouping Report Data Views of a Report Chapter
	Creating a Report Chapter with grouped Report Data Views

	How to Modify a Report Data View
	How to Define the Filters Displayed in a Report
	How to Duplicate a Report Template
	How to Duplicate a Report Data View
	How to Add Reports to Object Property Pages
	Adding an object-based Report Template to the object Reporting page
	Adding a macro-based Report Template to the object Reporting page

	How to Customize the Reporting Page of an Object
	Creating a Report Display Context
	Adding a folder to the Reporting page of an object
	Adding a report to a folder of the Reporting page of an object
	Organizing the reports in a folder (Reporting page)
	Adding a condition to report availabity (MetaTest on Report Template)
	Viewing the Report Display Context configuration result

	How to Make a Report Creation Available to an Object List
	How to Customize a Report Icon and Name
	How to Manage Availability of Reports
	How to Make a Report Template Available at Report Creation
	How to Define the Report Template Renderer and Illustration
	How to Define the Filters: Categories and Subjects
	How to Find Information Regarding JAVA Macros

	Customizing a Report Template Style
	How to Customize a Report Template Style
	How to Create a Report Style
	How to Apply a General Style
	How to Customize a Report Color Palette

	Customizing a Table Report Template
	How to Apply a Conditional Style to a Column
	How to Add Sub-totals in a Table Break
	How to Add a Grand Total Break (Use case)
	How to Apply a Conditional Style to a Pie Chart
	How to Customize the Empty Label in a Pie Chart

	Customizing a Graph Report Template
	How to apply a Conditional Style to a Graph
	Configuring the Report Graph Layer
	Applying a style to an arc
	Applying a conditional style to a node

	How to Modify the Arc Display in a Graph
	How to Replace Node Names by Property Values in a Graph
	How to Group Arcs in a Graph
	Setting a display on details of an arc grouping

	How to Hide the Path Intermediate Nodes

	Customizing a Gauge Report Template
	How to Create and Customize a Gauge Report Template

	Customizing a Tree Report Template
	How to Replace Node Names by Property Values in a Dendrogram
	How to Replace Node Icons by Property Values in a Dendrogram
	How to Apply a Conditional Style to a Treemap


	Writing Java report chapters
	Introduction to Java report chapters
	Generalities
	Data and view separation

	Prerequisites
	Report modeling
	Setup a Java development environment
	Referencing jars and javadoc

	Writing the macro implementation
	Interfaces to implement
	Report chapters
	Callbacks

	Implementing the macro
	General steps
	Example
	Going further


	Using your implementation from the MEGA Report Macro
	Compile
	Configure the Macro

	Code Example
	Demo 1: Charts using 2D datasets
	Demo 2: Parameters in tables with vertical headers
	Demo 3: Pie chart
	Demo 4: Bubble chart
	Demo 5: Simple Gantt chart
	Demo 6: Tree of parameters
	Demo 7: Clickable diagrams
	Demo 8: Clickable illustrating diagrams


	Writing Java report renderers
	Introduction and prerequisites
	Renderer modeling
	Renderer implementation
	Interface to implement
	Implementation example
	HTML Renderer Code
	PDF Renderer Code
	Example result


	Using your implementation from the MEGA Renderer Macro
	Compile
	Configuring the macro




